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About Medicare Remit Easy Print

About Medicare Remit Easy Print

Medicare Remit Easy Print enables you to print Medicare Part B and DME MAC HIPAA
835v4010A1 and 835v5010 files to a format that is similar to the Standard Paper
Remittances (SPRs).

You can use Medicare Remit Easy Print to

» view MREP Remittance Advices (see page 53)

» search MREP Remittance Advices (see page 72)

e print MREP Remittance Advices (see page 71)

» print reports about MREP Remittance Advices (see page 147).
You can install Medicare Remit Easy Print on a PC or on a network.

For general information about remittances, see the guide for Medicare providers:
http://www.cms.hhs.gov/MLNProducts/downloads/RA_Guide Full_03-22-06.pdf

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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What's New

Provider level adjustments documented in the PLB segment(s) are listed on the Provider
Payment Summary report found on the Remit Summary tab. The labels on the PLB
Reason Codes are no longer numbered labels such as “PROV ADJ CODEL:”, “PROV
ADJ CODEZ2:”, and so on. These fields are now simply labeled “PROV ADJ CODE:".

Mapping of the PLB adjustment details has changed. Previously, when the PLB reason
code (PLB03-1) was “WO?”, indicating a recoupment/offset, the value of positions 3-19
of the provider adjustment identifier (PLB03-2) was interpreted as a DCN and appeared
under the “FCN/Other Identifier” heading on the Entire Remittance report and with the
“FCN/Other Identifier” label on the Provider Payment Summary report. Now, when
present, a provider adjustment in the X12835V4010A1 format with the PLB reason code
of “FB” or “WQO” communicates the CCN in positions 3-19, and the HICN in positions
20-30 of the provider adjustment identifier (PLB03-2). Also, when present, a provider
adjustment in the X12 835Vv5010 format with a PLB reason code of “FB” or “WQO”
communicates the CCN in positions 1-17, and the HICN in positions 18-28 of the
provider adjustment identifier (PLB03-2). The CCNs replace the DCN under the
FCN/Other Identifier heading and label. A new “HIC” heading has been added to the
Entire Remittance report, and a new “HIC:” label has been added to the Provder Payment
Summarty report.

The Other Adjustment report displays subtotals for provider adjustments by PLB reason
code. This report has been enhanced to display values for more adjustment types and
provide more explanatory detail

Withholding/Capitation (PLB=E3): 12.91

Withholding/Accel. Pmt (PLB=AP): 23.45

Withholding/IRS (PLB=IR): 30.82

Overpayment Recovery (PLB=WO): 474 .66

Forwarding Balance (PLB=FB): 537.39
Informational

MREP accepts remittances in the X12 835V4010A1 and X12 835V5010A1 formats.
MREP no longer accepts remittances in the X12 8355010 format. However, since the
X12 835Vv5010 format was only used during the transition period from X12
835V40101A1 and was never implemented for use in production, the User Guide refers
to the X12 835V5010A1 format as X12 835V5010.

MREP v3.1 includes the CARC/RARC list published 3/08/2011. Future lists will be
made available individually and can be imported into MREP to keep the codes current.
See pg. 65 for instructions.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Differences between MREP Remittance Advices and Shared System SPRs

Differences between MREP Remittance Advices and
Shared System SPRs

It is important to understand that the Medicare Remit Easy Print Remittance Advice is a representation of
the HIPAA 835v4010A1 transaction data. Although CMS has attempted to make the Medicare Remit
Easy Print generated Remittance Advice very similar to the Shared System Maintainer generated SPR
(received via mail), the printed information and data content at times may differ. So, the two can be
compared as long as there is an understanding of why they differ.

For example, the HIPAA 835v4010A1 transaction data contains reversal (mother) claim information and,
in turn, the Medicare Remit Easy Print Remittance Advice displays this information and uses it in the
calculation of the entire remittance “totals”. The CMS systems that create the file for the SPR received via
mail have the ability to “net” the claim information for adjustments prior to generating the SPR. The
HIPAA 835v4010A1 transaction has no facility to convey the information to allow MREP to “net” the
claim information for adjustments prior to generating the Medicare Remit Easy Print Remittance Advice
and, therefore, must do a complete back-out of the original claim and “build” a new “adjusted” claim with
the modified information.

Iltem

Adjustments

Medicare Remit Easy Print

You must calculate the net.

Claim Example #1

Original Claim 000000000001000
Provider Paid -$100.00
Adjustment Claim 000000000001001
Provider Paid $80.00

Provider Paid -$20.00 (overpayment)

Claim Example #2

Original Claim 000000000002000
Provider Paid -$100.00
Adjustment Claim  000000000002001
Provider Paid $150.00

Provider Paid $50.00 (underpayment)

Shared System

The net was calculated for you.

Claim Example #1
Adjustment Claim  000000000001001
Provider Paid -$20.00

Claim Example #2
Adjustment Claim 000000000002001
Provider Paid $50.00

PREV PD

Always blank

Is calculated for you

General Messages
for Suppliers/
Providers (Provider
Bulletin Board)

Not displayed

Is displayed

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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About This Guide

About This Guide

All personal health information has been replaced with fictitious information.
To use this guide, you need to have a working knowledge of Microsoft Windows.
For example, you need to know how to:

* access your desktop,

* use the Start menu, and

» use Microsoft Windows Explorer.

You also need to know common Microsoft Windows terminology. For example, Start >
Programs refers to the Programs option on the Start menu.

Need Assistance?
If you need assistance, please contact:

Email Your Medicare contractor

Phone Your Medicare contractor

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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PC Requirements

PC Requirements

Recommended
speed:

2.0 GHz or faster

Operating System Requirements

Recommended:

Others:

.NET Framework:

Windows XP

Windows 2000
Windows NT

1.1.4322 (On the Microsoft web site this is referenced as 1.1)

This application uses Visual Basic.Net, a Microsoft compatible language, and
like many applications that require a MS Windows platform, a .NET framework
is required. More than likely you already have a version of the .NET framework
on your PC. In order to use this application, you must have .NET framework
version 1.1.4322 or a later version installed on each PC that is using this
application. If you do not have this framework installed, you may receive a
message stating that this version of the framework is required during the
installation process and prompting you to install it.

i Medicare Remit EasyPrint X

Thiz setup requires the MET Framewark verzsion 1.1.4322. Pleaze install the MET
Framewaork. and run this setup again. The MET Framework can be obtained fram the
web. Swauld you like ta da this now'?

Tes Mo

By clicking yes—and if you have access to the internet—you are redirected to
the Microsoft web site to download the .NET framework 1.1 (same as the
1.1.4322 version referenced in the message). It is not recommended that you
download a beta version of the .NET framework if you are presented with this
option on the Microsoft web site.

Outside of the application installation process, you may also use the following
link to transport directly to the location on the Microsoft web site to download
the 1.1 .NET framework version:
http://www.microsoft.com/downloads/details.aspx?Familyld=262D25E3-F589-
4842-8157-034D1E7CF3A3&displaylang=en

If you want to learn more about the 1.1 .NET Framework version and/or
determine if you need to install this version, you may use the following link:

http://msdn.microsoft.com/en-us/netframework/default.aspx

Please follow the directions within the web site when using this link.

If you do not have access to the internet and you receive a message to update
your .NET framework, you have to obtain a copy of the .NET framework from
Microsoft. The Medicare Remit Easy Print application does not work without

the appropriate .NET framework installed on each machine accessing the
application.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Medicare Remit Easy Print

Operating System Requirements

Decompression To download the Medicare Remit Easy Print program from your Medicare
Application: contractor’s web site, you must have the following:

* Access to the internet.

« WinZip or a compatible decompression application to extract files. If you do
not have a decompression application then you can go to a number of web
sites to acquire one (For example: http://www.winzip.com/downwzeval.htm.)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How Does Medicare Remit Easy Print Get Medicare Remittance Info?

How Does Medicare Remit Easy Print Get Medicare
Remittance Info?

You have to import Medicare remittance information into Medicare Remit Easy Print.
For more information about importing, see How to Import the HIPAA 835 File on page
47.

The files that you import are the ANSI files. For more information about the format of
these files, see Appendix A: RA/HIPAA 835v4010A1 Segment Field Crosswalk on page
155 or Appendix B: RA/HIPAA 835v5010 Segment Field Crosswalk on page 162.

When Medicare Remit Easy Print reformats and saves a copy of an HIPAA 835 file, it is
called the Import file. For information about how EasyPrint names the Import files, see
Import File Name Format on page 46.

Medicare Remit Easy Print keeps all of the Import files in the Import folder in the
Medicare Remit EasyPrint directory.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Information for Administrators

Information for Administrators

Network

The Network Installations and PC Installations sections are for administrators.

Medicare Remit Easy Print can be installed on a PC or network.

Installations

Medicare Remit Easy Print Directory
There must be sufficient space on the network to save the Import file(s).
The Medicare Remit Easy Print software takes about 3000 KB.

Users must have Read/Write access to the directory where the software is installed
because the software creates files and saves them using the user’s security privileges to
the directory.

Medicare Remit Easy Print Access

If you need to make Medicare Remit Easy Print available to all users who log on, you
need to indicate this during the installation procedure.

Group Code MSI file

When installing the application on a network, each PC that accesses the application must
have installed the Group Code MSI file.

Pre-Installation Checklist for Installation on a Network

Before you install Medicare Remit Easy Print, you need to complete these steps:

Completed
Step Description v

1 Check that the network, all PCs, and printers meet all requirements.

2 Check that you are using one of the supported operating systems.

Find out where the Medicare Remit Easy Print installation software is located.

Write the location here:

The file name is: Medicare Remit Easy Print.msi

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Network Installations

Completed
Step Description v

Find out where the Medicare Remit Easy Print Group Code .msi file is:
The file name is: GroupCode.msi

Write the location here:

Note: The GroupCode.msi must be installed on all PCs executing EasyPrint
from a network location or any PCs that access network locations
from within the application.

When installed on a network drive, only the EasyPrint shortcut and
4 the GroupCode.msi package need to be installed on PCs executing
the application. There is no need to install the application on each
individual PC.
In order for each client PC to access the application: From the client
PC, navigate to the network location where Medicare Remit Easy
Print is installed, right click on the EasyPrint.exe file, and select
“create shortcut”. This shortcut can then be copied to the desktop of
the client PC. This step is necessary in the event the network drive
mapping is different on the client PC.
5 Create a folder called HIPAA 835 files and make sure that all users know the
location.

This folder must have adequate security for PHI.

Write the location for the HIPAA 835 files here:

6 Create a directory on the server for the Medicare Remit Easy Print
installation.

This directory must have adequate security for PHI.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Installing Medicare Remit Easy Print on a Network
When you install Medicare Remit Easy Print on a network:
» install Medicare Remit Easy Print on the network

» install the Medicare Remit Easy Print Group Code on every PC accessing the
application.

Before You Install Medicare Remit Easy Print on a Network
Before you install Medicare Remit Easy Print:

» complete the Pre-Installation Checklist for installation on a network.

How to Install Medicare Remit Easy Print on the Network
Download Instructions
On your contractor’s website, select:

Important! 1. Medicare Remit Easy Print link
If this download
cannot get past

}/i?:vrv;ﬁtgzgse 2. Click the Medicare Remit Easy Print zip file. The File Download window opens.

contact your _
! »
Medicare F"E Download i

contractor. . - .
Some files can harm your computer. [F the file information belaw
looks suzpicious, or you do not fully trust the source, do not open ar
zave this file.

File name: ...MedicareR emite azyPrint. zip
File type:  “winZip File

Framm: OEMO. YIPE. COm

Wwhould pou like to open the file or zave it ko pour computer?

Open |

IV Alwaps azk before opening this type of file

Cancel | More Info

3. Click the Open button. The WinZip window opens.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Network Installations

- B B Nl i y R N ‘4
q ﬁnﬁ 1 e e B | @ I3 ‘ :
! ! \j o T A -t J pizls
Mew Open Favorites Add Extract Tl Encrypt iew Checkout ‘Wizard Wigw Skyle

L Mame Type IModified Size  Ratio Packed  Path
ﬁ!GroupCode.msi wiindows Ins...  7J5/2011 11:27 AM 54,272 BS% 19,097
ﬁ!l‘ﬂedicare Remit ... Windows Ins... 752011 11:29 AM 2,161,152 12% 1,906,...
Selected O files, 0 bytes Total 2 files, 2,164KB a0
—

4. To extract the file to the network, highlight GroupCode.msi and click the Extract
button. The Extract window opens.

2=

Extract to:
IM:H j 3' gl Cancel |
Files Eolders/drives:
= Selected|files &-_] CAST -] Help |
= Al files -] CLASSBD —
-] COE |

" Files: I

[ Ovenwrite exizting files
[ Skip older files
¥ Usze folder names

[ Open Explorer window

{:l COMMan

{:l Common Developme
-] Contractidmin
&[] Contracts

{:l Corporate Securty
&[] CREW

4 ol

A

5. Select the directory on your network where you want the GroupCode.msi file to be
stored. Click the Extract button. You return to the WinZip window.

6. On the following line, write the name of the folder where you saved the

GroupCode.msi file:

7. Highlight the MedicareRemitEasyPrint.msi file and click Extract.
8. Select the same location on your network where you saved the GroupCode.msi file.

Click the Extract button.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Installation Instructions

1. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 3
of the Pre-Installation Checklist — page 13).

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file.
3. Double-click the Medicare Remit Easy Print.msi file:

ﬁ'_:jﬁMedicare Femit Easy Prink,msi

The Medicare Remit Easy Print Setup Wizard opens.

Welcome to the Medicare Remit Easy Print Setup
Wizard

The inztaller will quide you through the steps required to inztall Medicare Remit E azy Print an pour
cormputer,

WARMIMG: Thiz computer program i protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civi
or ciminal penaliies, and will be prosecuted to the maximum extent possible under the law.

Cancel 4 Back

4. Click the Next button.
The Select Installation Folder window opens.

ii,? Medicare Remit Easy Print

Select Installation Folder

The ingtallzr will install Medicare Remit E asp Print to the following falder.

Ta install in thiz folder, click "Next". Ta install to a different folder, enter it below or click "Browse".

Folder:

T:\Easy Print Files\ Browse... |
Dizk Cost... |

Install Medicare Remit Easy Print for yoursel, ar for anpone who uses this computer:

fo Ewerone

" Just me

Cancel < Back

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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5. Browse for the network location for the install. This is where the application and all
the associated files are stored.

6. On the following line, write the location where you are saving the application and
where all of the associated folders and files are to be saved:

7. Select Everyone and click the Next button.
The Confirm Installation window opens.

ii§—~' Medicare Remit Easy Print

Confirm Installation

The installer iz ready to install Medicare Remit Easy Print on pour computer.

Click "Nest" ta start the installation.

Cancel | < Back

8. Click the Next button
When the installation is finished, the Installation Complete window opens.

i;,{.j— Medicare Remit Easy Prink

Installation Complete

Medicare Remit Easy Print has been successfully installed.

Click. "Clage" to exit.

Best Practice:
Make the shortcut
to the Medicare
Remit Easy Print Flease uze *Windows Lpdate to check for any critical updates ta the MET Framework.
executable
available to all
users. Cancel

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Network Installations

Important!
You must install

the Medi

Remit Easy Print
Group Code on

each PC.

9. Click the Close button.

The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy

care

Print directory. Copy this shortcut to your desktop.
10. Complete the Medicare Remit Easy Print Group Code installation on each PC.

What Happens During the Installation Process?

The following items are created and placed in the directory you designated under the
Medicare Remit Easy Print folder in Step 8 of the Installation Instructions:

EasyPrint.exe
Easy Print icon - shortcut
Import folder - where all active converted HIPAA 835 files are stored

Archive folder - where all inactive converted HIPAA 835 files are stored.
(Inactive files are files not currently viewed in the application.)

Report Export folder - where all exported Report files are stored
Resource folder - internal folder to application

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Installing the Medicare Remit Easy Print Group Code on the
PC

After you install the Medicare Remit Easy Print application on the network, you must
install the GroupCode.msi file on every PC that needs to access the application.

How to Install the Medicare Remit Easy Print Group Code

1. Make sure you know the location of the Medicare Remit Easy Print Group Code file
(Step 4 of the Pre-Installation Checklist — page 13).

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print Group
Code.msi file.

3. Double-click the Medicare Remit Easy Print Group Code.msi file.

ﬁ%’ GroupCode. mzi

The installation completes without opening any windows or displaying any messages.

How to Know that the Medicare Remit Easy Print Group Code Install Completed
Successfully
If the installation DID complete successfully, the PC user can open Medicare Remit Easy
Print.

If the installation DID NOT complete successfully, the PC user cannot open Medicare
Remit Easy Print is presented with an unhandled exception dialog.

) EasyPrint.exe - C 5'
Hint:

If you see this fpplication has generated an exception that could not be handled,
error message on 4 5

the PC, you need
to install the
Medicare Remit
Easy Print Group

Process id=0xG28 (2068), Thread id=0x7b4 (19727,

Click QK to kerminate the application,
Click CARCEL to debug the application,

Code.

You need a K Cancel

minimum screen

resolution of 1024 . . . . . .
X 768. Have the user click OK and install the Medicare Remit Easy Print Group Code again.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Best Practice:

Create a folder
called HIPAA
835 files to
store your 835
files, and make
sure that all
users know the
location.

PC Installations

Medicare Remit Easy Print Setup Software

For users to load the software on their PCs, they must know the location of the Medicare
Remit Easy Print Setup file.

The file name is:
Medicare Remit Easy Print.msi
HIPAA 835 File Location

Users must know the location from which to download the HIPAA 835 file they receive
from their Medicare contractor.

Medicare Remit Easy Print Directory

There must be sufficient space on the PC for Medicare Remit Easy Print to save the
Import file(s).

The Medicare Remit Easy Print software takes about 3000 KB. The size of the Import
file(s) is dependent upon the number of claims found in the HIPAA 835 file.

Medicare Remit Easy Print Access

The default for installing Medicare Remit Easy Print is to have it be accessible only to a
single user on a PC.

Getting Started
To get started:

1. Complete the Pre-Installation Checklist (page 22).
2. Install Medicare Remit Easy Print on your PC (page 22).

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Pre-Installation Checklist for Installation on a PC

Before you install Medicare Remit Easy Print, you need to complete these steps:

Completed
Step Description v

1 Check to be sure that your PC and printer meet all requirements.

2 Check to be sure that you are using one of the supported operating systems.

Find out where the Medicare Remit Easy Print install file is located.
3 The file name is: Medicare Remit Easy Print.msi
Write the location here:

4 Find out where the HIPAA 835 files are located.
Write the location here:

Installing Medicare Remit Easy Print

Before You Install Medicare Remit Easy Print
Before you install Medicare Remit Easy Print:

e Complete the Pre-Installation Checklist.

How to Install Medicare Remit Easy Print on Your PC
Download Instructions
On your contractor’s website:
Important! 1. Select the Medicare Remit Easy Print link.

If this download . . . o . ]
cannot get past 2. Click the Medicare Remit Easy Print zip file. The File Download window opens.

your PC security .
settings, please File Download x|

contact your
Medicare carrier. Some files can harm your computer. [F the file information belaw
@ looks suzpicious, or you do not fully trust the source, do not open ar
zave this file.

File name: ...MedicareR emite azyPrint. zip
File type:  “winZip File

Framm: OEMO. YIPE. COm

Wwhould pou like to open the file or zave it ko pour computer?

Open |

IV Alwaps azk before opening this type of file

Cancel More Info

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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3. Click the Open button. The WinZip window opens.

NinZip - MedicareRemitEasyPrin p O
" = P o - = = =
R ] Y | i 1 L EIN
] v:ﬁhﬁ |@ e |8 | ﬁ '31 |*-g w’ V=R
R 5 % By By & |8 i
Mew Qpen Favorites Add Extrack IMail Encrypk Wigw CheckOut ‘Wizard Wiew Skvle
o Mame Type Modified Size  Ratio Packed Path
ﬁlGroupCDde.msi Windows Ins,..  7/5/2011 11:27 &M 54,272 65% 19,097
ﬁ-‘Medicare Remit Easy Print.msi  Windows Ins...  7/5f2011 11:29 AM 2,161,152 12% 1,906,...
< | b
Selected 1 file, 2,111KB Total 2 files. 2,164KE 00
=

4. To extract the file to the network, highlight MedicareRemitEasyPrint.msi and click
the Extract button. The Extract window opens.

Extract to:
IM:I& j &l gl Cancel |
File=z Folders/drives:
" Selected|files #-] CAST -] Help |
= Al files -] CLASSED =
. #-{] COB 1
CoRies [
= {:l COMAMnomN

[ Owenwrite existing files
[ Skip older files
¥ Usze folder names

[ Open Explorer window

2

& Contractidmin
& Contracts

{:l Corporate S ecurity
&[] CREW

< e

-1 Comman Developrme

A

Best Practice: 5.

Create a folder
called HIPAA
835 files to
store your 835
files, and make
sure that all
users know the
location.

Select the directory on your network where you want the
MedicareRemitEasyPrint.msi file to be stored. Click the Extract button. You return to
the WinZip window.

6. On the following line, write the name of the folder where you saved the
MedicareRemitEasyPrint.msi file:

Because you are not installing the software on a network to be shared by other users, you
do not need to copy the GroupCode.msi file.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Installation Instructions

7. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 3
of the Pre-Installation Checklist — page 22).

8. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file.
9. Double-click the Medicare Remit Easy Print.msi file:

ﬁ'_:jﬁMedicare Femit Easy Prink,msi

The Medicare Remit Easy Print Setup Wizard opens.

Welcome to the Medicare Remit Easy Print Setup
Wizard

The inztaller will quide you through the steps required to inztall Medicare Remit E azy Print an pour
cormputer,

WARMIMG: Thiz computer program i protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civi
or ciminal penaliies, and will be prosecuted to the maximum extent possible under the law.

Cancel 4 Back

10. Click the Next button.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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The Select Installation Folder window opens.

iit'.j— Medicare Remit Easy Print

Select Installation Folder

The inzstaller will install Medicare Remit Eagy Print ta the following falder.

Taoinstall in this folder, click "Nest". Tainstall to a different folder. enter it below or click "Browse".

Folder:
T:\Easy Print Files\

Diisk Cost.. |

Install Medicare Remit Easy Print for yourself, or for apbne who uses this computer:

/ Cancel | < Back |

11. Browse for the PC location for the install. This is where the application and all the
associated files are stored.

fo Everyone

" Just me

12. On the following line, write the location where you are saving the application and
where all of the associated folders and files are to be saved:

13. Select Everyone and click the Next button.
The Confirm Installation window opens.

iiaj- Medicare Remit Easy Print

Confirm Installation

The inztaller iz ready to install Medicare Rermit Eazy Print on your cormputer,

Click "Mext" ta start the installation.

Cancel < Back

14. Click the Next button

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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When the installation is finished, the Installation Complete window opens.

Installation Complete

Medicare Remit Easy Print has been successfully installed.

Click. "Clage" to exit.

Flease uze *Windows Lpdate to check for any critical updates ta the MET Framework.

Cancel

15. Click the Close button.
The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy
Print directory. Copy this shortcut to your desktop.

What Happens During the Installation Process?

The following items are created and placed in the directory you designated under the
Medicare Remit Easy Print folder in Step 8 of the Installation Instructions:

» EasyPrint.exe
» Easy Print icon (shortcut)
» Import folder (where all active converted x835 files are stored)

» Archive folder (where all inactive converted x835 files are stored. Inactive files
are files not currently viewed in the application)

» Report Export folder (where all exported Report files are stored)

» Resource folder (internal folder to application)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Starting Medicare Remit Easy Print

Hint:

You can find
the Medicare
Remit Easy
Print shortcut

m on the

desktop and on
the Start
menu.

You can find shortcuts to the Medicare Remit Easy Print program in 2 places:

» your PC desktop:

i R q q
« the Start > Programs menu: 5 Medicare Remit Easy Print

Before You Start Medicare Remit Easy Print

Before you start Medicare Remit Easy Print, you must:
» load Medicare Remit Easy Print (page 22).

» know the location of the HIPAA 835 folder or where your HIPAA 835 files are
stored (Step 4 of the Pre-Installation Checklist — page 22)

How to Start Medicare Remit Easy Print

1. To start Medicare Remit Easy Print, double-click the Medicare Remit Easy Print
shortcut.

The first time that you start Medicare Remit Easy Print, or when you don’t have any
Remittance files in the Import folder you see the “No Remittance Files Found”
dialog. Click or select the OK button to close the dialog.

NO REMIT FILES FOUND: x|
@ MO REMITTANCE FILES FOUND
Click Ok then select the IMPORT option to

import an electronic remittance.

Click the OK button./

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Medicare Remit Easy Print opens with the Import button ready:

B8 Medicare Remit EasyPrint v2.40
Fle Teh Yiew Report Search Tools Hel

Segment courk »>855 917/2008

Click the Import button.
A file dialog window opens permitting you to select the HIPAA 835 file

to import.
Import ANSI x12 835 ERA K B3
Laak in: Im Desktop j k] £ FE-
5 ¢
& A d @
My Network. Acrobat Adobe [WwWS53270 Snaglt B

Places Digtiler 6.0 Reader 7.0 PLUS

2 O B B

Shaglt Studio  Documents EazyFrint  Framehaker Track T-Rex

B
L
WwebEx Player  Windows
Media Plaper

File: name: I j Open I
Files of type: I j Cancel |

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Select the HIPAA 835 file that you want to import by double-clicking it.

Medicare Remit Easy Print starts the import and lets you know that it is
importing:

Importing electronic remittance(s}

After the import is finished, the Remittance Advice List window appears.

.Medicare Remit EasyPrint ¥2.40

Menus PR File Tab Wew Report Search Tools Help
'Import P Repart - A Archive _ Restare x Delete q search | Print Lisk
Toolbar =
— | Payver Mame | Payee Mame | Payee ID | Check Date | Check/EFT ... | CheckfEFT ... | Claims | Check/EFT Mumber | \ersion | Filename |
L|st Of AREA TMSURANCE  ACME PHYSICIANS TMC. 12345675 04)23f05 4231.69 EFT 51 12345 00401009141 AREA INSLIRAN. ..
Remittance =~ ——
Advices
Claim List tab Claim List | Clairn Detail | Remit Summary | Diaka Yiew | Search | Glossary I
is active _ [ame ACNT ICH Billed Amount Paid Amount From Date To Dake -
Oooe, saly FREEFET 119932404007501 56,72 36.08 3f16/2005 3i16/2005
Ooce, saly FRE23FT 119932404007501 26,50 9,66 4{7/2005 4/7/2005
right, Samuel 7722337 119932404007801 397,50 184,77 3{14/2005 3{14/2005
Oright, Samuel 7722337 119932404007801 397,50 184,77 3{24/2005 3j24/2005
Ooae, saly FFZZIIT 119932404007801 32.64 18.90 B21/2004 /212004
Oright, samuel FTZZIAT 119932404007501 397.50 184.77 2/18/2005 z/18/z005
List of claims — Oright, samuel FREEFET 119932404007501 397.50 184,77 3f18/2005 3f18/2005
for the Ooce, saly FRE23FT 119932404007501 46,78 3122 3f21/2005 3f21fz005
highlighted Oooe, Saly 7722337 119932404007801 57,74 36,35 12)42004 12)4/2004
Remi Orae, saly Friceeerd 1199324 04007501 26,50 12,89 144/2005 1742005
emittance Ooae, saly FFZZIIT 119932404007801 26.50 12.89 2042005 2/4/2005 -
Ooce, saly FTZZIAT 119932404007501 26.50 9.66 3042005 3l4/2005
Oooe, saly FREEFET 119932404007501 26,50 9,66 442005 4/4/2005
Ooce, saly FRE23FT 119932404007501 20,60 45,69 2/19/2005 2{19/2005
Oooe, saly 7722337 119932404007801 238,77 160,20 3(18/2005 3/18/2005
Ooae, saly FFZZIIT 119932404007801 26.50 9,66 472005 47/2005
Ooce, saly FTZZIAT 119932404007501 397.50 191.54 12}15{z004 12}15/2004
Oright, samuel FREEFET 119932404007501 57,74 33,66 1/8/2005 1/6/2005
Oright, samuel FRE23FT 119932404007501 26,50 12,89 2fBi2005 2f6/2005
right, Samuel 7722337 119932404007801 26,50 12,89 306/2005 362005
Oright, samuel FrZII 1199This i a list of claims contained within the selected remittance]  4/6/2005 4i6/2005
Ooae, saly FFZZIIT 119932404007501 397.50 184.77 3(15/2005 3/15/2005
— | Ooce, saly FTZZIAT 119932404007501 397.50 184.77 3(23/2005 3}73/2005
Oooe, saly FREEFET 119932404007501 55,38 27,66 4712005 4/7/2005 -
T ¢ 1 + 1‘ —
- Print I EA check al ] unCheck al | @ { Elata | I I I
geamentconn Ftss Internal Internal control  Total billed  Total Earliest Latest To  si7/2008
Hint: Bene name(s) account number(s) amountfor  provider ~FromDate  Date of
Click on a number(s)  (Claim Number)  the claim paid  ofservice  service on
| amount for  onthe the claim
column : i
. the claim claim
heading to
change the
sort order.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Locating MREP and MREP File Locations on Your
PC/Network

Locating the MREP Application on Your PC/Network — Icon
Available

1. With your mouse, right click on the icon on your desktop.
LN

2 L
EasyPrint

h Open

Send To 3

Cuk
Copy

Create Shortout
Delete
F.enarme

Properties

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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2. Go to Properties, Shortcut, Start in and you see the directory where the Medicare
Remit Easy Print directory is located.

EasyPrint Properties 7] x|

General  Shortcut |Securit_l,l| %

A

]
=T E azyPrint
27

T arget type: Application

T arget location:

T arget; IMedicare Fermit EazuPrint

Start in; "C:5Program Files'Medicare Bemit E azyPrinth

Shortcut key: IN ane

Rur: INDrmaI window j
Comment; IMedicare Femit Eazy Print
Find Target... | Ehange [zon.. Advanced... |

(] % I Cancel Apply

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Locating the MREP Application on Your PC/Network — Icon not
Available

1. Click the Start menu.

2. Select the “Search’ function.

3. Select ‘For Files or Folgers’.

m Prograns k

' Favorit

1. Favorites
E & Docurents J
=
A Elf' Settings b
Nﬂ;}
C 8 .. . | For Files or Folders. .
= & e -

k &, Onthe Internet...

o
>¢ t}.) Help and Support 2] Find Printers. ..
W
E =] Run.. '@ Lsirg Microsoft Sutlook, .
= € For People. ..
B @ Shut Dowr, .,

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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4. Select ‘All files and folders’.

B search Results

J File Edit “iew Favorites Toolfd Help |J J[Xk.} ¥ ”ﬁi!_'::' | & @ X 9 | [~ | ;ﬁ
J.ﬁ.ddress Id Seatch Resuls / j

Search Companion P Mame I In Folder I Size | Type I [

To start wour search, Follow the instructions in the left pane,

What do you want to
search for?

Fictures, music, or vjdeo

Documents (word
processing, spregh
etc.)

Al files and Folders

Frinters, computers, ar
people

@) Information in Help and
Support Center

¥ou may also want ko,

Q Seatch the Inkernet
Change preferences

1| | i

0 objects o

5. Type ‘Medicare Remit Easy Print’ or the name you saved your MREP software under
in “‘All files and folders’.

6. Select ‘My Computer’ from the ‘Look In’ drop-down box.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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BEE
J File Edit ‘iew Favorites Tools  Help |J “} rEd T ?’ Hﬁ-? | |2 (3 )( K’ | v | #
| Address | ) Search Results =
Search Companion X || Name | In Folder | Size | Type | [

Ta start ym’; search, Follow the instructions in the left pane.

Search by any or all of
the criteria below.

all or part: of the flle name:
| Medicare Remit Easy Print

A word ar phrase in the file:

Loak.in:

I :i My Computer j
When was it modified? b
What size is it? 4

More advanced »
options

Back | Seqrch I

T
N

0 chjects \

7. Click the Search button.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Identifying Easy Print File Locations

This tool contains the current path to folders containing the files that Medicare Remit Easy
Print uses. In most cases, these paths never need updating. But, in certain situations, the user
may want to override the default locations of these folders.

1. Toidentify the necessary files/resources that Medicare Remit Easy Print is using,
select Path Name Editor from the Tools menu.

OMedicare Remit EasyPrint ¥2.40
File Tab Yew Report Search | Tools Help

'Imnort P Report -

Archive
Delete

£ Delete | Q Search | EF‘rlnl:\_lst

Payer Mame Payee Hame Restore rheckDate | CheckfEFT ... | CheckfEFT ... [ Claims | CheckiEFT Number [ wersion | Filename |
AREA INSURANCE  ACME PHYSICL:  Code Descriptfns 04/23/05 423169 EFT 51 12345 004010x091AL  AREA INSURAN. ..

Impart CodpBrescriptions

Claim List I Claim Detai | Remit Summary I Data View I Search | Glossary I
Name ACHT I Billed Amount Paid Amount From Date To Date E
y 7 11 04007801
Do, Sally FTZZIIT 119932404 007301 56,72 3806 3162005 3/16/2005
oo, sally FTZZIIT 119932404 007301 26.50 966 472005 47 }2005
O right, samusl 7722337 119932404007501 397.50 184,77 3f14/2005 3i14)2005
Oright, samuel Fr22337 119932404007801 397.50 184,77 3f24/2005 3iz4j2005
Ooee, sally Fr22337 119932404007801 32,64 18,90 6212004 Bi21)2004
Oright, Samuel F72233T 119932404007801 397.50 184.77 2{18/2005 2{18/2005
right, Samuel FTZ2IIT 119932404007801 397.50 184.77 3/18/2005 3/18/2005
Do, Sally FTZ2IIT 119932404 007301 48.78 31.22 3j21/2005 3/21/2005
O ooe, sally 7722337 119932404007501 57.74 36,35 12}4f2004 12/4j2004
O ooe, sally 7722337 119932404007501 26,50 12,59 1f4f2005 142005
Ooee, sally Fr22337 119932404007801 26,50 12,89 2/4/2005 2f4jz00s 1
ODee, Sally FTE23IT 119932404007501 26,50 9.66 342005 3f4/2005
O Dee, Sally F72233T 119932404007801 26.50 9.66 442005 44412005
Do, Sally FTZ2IIT 119932404 007301 0,80 45.69 2/19/2005 3/19/2005
Do, Sally FTZ2ZIIT 119932404 007301 238,77 160,20 3/18/2005 3/18/2005
O ooe, sally 7722337 119932404007501 26,50 966 47/2005 417/2005
Ooee, sally 722337 119932404007801 397.50 191.54 12/15/2004 12/15/2004
Oright, samuel Fr22337 119932404007801 57.74 33.86 1f&/2005 1j&/2005
Oright, Samuel F72233T 119932404007801 26.50 12.89 2i6{2005 2j62005
Oright, Samuel 7722337 119932404007801 26.50 12.89 3i6{2005 3i62005
right, Samuel FTZ2IIT 119932404 007301 26.50 9.66 4{6{2005 462005
oo, sally FTZZIIT 119932404 007301 397.50 184.77 3{15/2005 3{15/2005
O ooe, sally 7722337 119932404007501 397.50 184,77 3232005 3iz3jz005
Ooee, sally Fr22337 119932404007801 55.36 27.86 472005 4f7/z005 -
e — povrn m—rn S ;IJ
___ Print EAcheckal | [JunCheckal @ Data
=i g
Segment count >>855 917 /2008
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2. The folder locations window displays showing the current folder location settings.

Medicare Remit Easy Print Folder Locations

This dialog contains the current paths ko the Folders Easy Prink uses ko locate the resources as indicated. In
most cases, the walues here will never need updating, In cerkain situations, wou may wank ko override the
defaulk locations of these folders,

Imported files : _:'\Program FilesiMedicare Remit EasyPrink! Importh | | Browse |

Archive files : |C:'|,F‘ru:ugram Files\Medicare Remit EasyPrint)archivel | | Browse |

Exported reports : |C:'|,F‘ru:ugram Filesi\Medicare Remit EasyPrint|ReportExport), | | Browse |

X835 native files : |C:'|,F‘ru:ugram FilesiMedicare Remit EasyPrintiMatived3s) | | Erowse |

Resource files : |C:'|,F‘ru:ugram Files\Medicare Remit EasyPrintiResource! | | Browse |
Save Defaulk Zancel

The Imported files: folder contains those files once the native 835 files have been
imported into Medicare Remit Easy Print.

The Archive files: folder contains those files that have been archived from Medicare
Remit Easy Print.

The Exported reports: folder contains those report files where the user chose to
export the reports rather than printing them.

The X835 native files: folder contains the native 835 files that are imported into
Medicare Remit Easy Print.

Note: When an issue is reported and the ViPS MREP Team requests that the file be
sent for further investigation, this is the type of file that needs to be sent. The
file has a “.txt” extension.

Identify the file/remittance advice that is in question or causing an issue.

For the provider/supplier community, send a copy of this file to your
contractor and your contractor should send the same file to the ViPS MREP
Team.

The Resource files: folder contains the necessary internal files
(004010X091A1.FLD or 005010x221A1.FLD and loop.str) for Medicare Remit Easy
Print to run. The Codes.ini file is also in this folder, but it is not required for
Medicare Remit Easy Print to run. (Note: The Codes.ini file contains the descriptions
of the Reason and Remark codes. If it is not present, the user receives a generic
default message for each Reason and Remark code.)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Buttons
Save changes made to the folders
Save

Default Reset the values for the files back to what they were when the
Medicare Remit Easy Print application was initially installed
Exit the Medicare Remit Easy Print Folder Locations display box

Zancel . .
without saving changes

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Uninstalling Medicare Remit EasyPrint

1. Navigate to the Windows Control Panel Add/Remove Programs.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

From the taskbar, click Start > Control Panel.

The control panel window opens.

¥ Cortral Panel
File Edit Wiew Favorites Took Help o
€] 5] ¥ | S ¥ @ X ¥) [~ | Address @ control Panel v
g P 4 A1 ~
Sadminisfrativi  Folder Fants Ahail Accessibility  Addar EBroadcom  Eroadeom
i eTools | Options Options Remov..  ASFConfi.. Control Sui..
r . N s N sl
_’i}’t g -f; &) & 1 Install or remave pragrams and Windaws con
Display Add Internet Mouse keyboard  Mefwork  Portable  Prinfers and
Hardware  Options Connections  Ahedia. Faes
. . - A @ s B
- = 2
Regionaland  Game  Sconmersond  Scheduled  Soundsond  Toskbarand  User Power
Language .. Controllers  Cameras Tosks  Audiobe.. Startdenu  Accounts  Options
QuickTime  System  Phoneand  bafeand  Security  Speech  Symantec  Windows
Mhodem Time: Center LiveUpdate  Media
)]
L 0 e 0 « 2
Tava Automatic  Windows  Infel(R) GMA  Wireless Corel
Updates Firewall briver Hetwo Wersions a
38 chjects ' My Computer

Windows 2000/XP control panel
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2. Remove the Medicare Remit Easy Print Application.
» Double click the Add/Remove Programs icon in the Control Panel.

» Select Medicare Remit Easy Print from the resulting list.

Lo} ] Shewcpgates sority | pime -
Change ar T ——— e
Femave
srogrome 18 Mo reerin Shockwi Paayer
%
Ack] b
Prigrem
T change his program o remav [t from your compissr, lick Changs ar Remsr
§ L e —— Sive (E™
Add'Remave B wicrantt Otice 2000 5P-1 Bretesional e 329 00ME
Windowr
comperents A Microsoft Otfice 37, Professional Edition Siz BRO4ME
A Wicrosoft O fice HTML Filier 20 sl 0sME
e ¥ Micrasatt Offica Sounds Sim 036ME
Set brogeam
dcoastand I Micrasatt PVK Dmport (Ramv only)
DUfE g Micrusoft Visle Wieb Compument Tochnolgy Jofice S msaem
thy Microsert vimaal Baste 6.0 FrofergedlEdition Sise 1267 DOME
W i mnantt Vinml T4 MET it Bk 11 - aranup ™

» Click Remove, then click Yes on the confirmation dialog.

The Uninstall process is complete!
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Online Help System

The Medicare Remit Easy Print (MREP) Help online system allows you to look up
information about MREP from MREP itself instead of referring to the Medicare Remit
Easy Print User Guide. The online Help system is geared to the day-to-day tasks in
MREP. It does not include information regarding the technical aspects of installing or
running MREP on a PC or network.

How to Access the Online Help System

1.

2.

Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon m

The Medicare Remit Easy Print Claim List tab opens.

OMEdi(are Remit EasyPrint ¥2.40
Fle Tab Yiew Report Search Tools Help

'Import

P Report -

Archi [T Rest Delet; | S h| PYinE Lisk
A rcl\*  Restore 3 Delete Q eard| oy PN Lis

Check/EFT Number Wersion

12345

Claim List Claim Defail Remit Summary | Data View | Search | Glossary |
Mame: 1 ACNT 1ch | Giled Amount | Paid amount | From Date | ToDats -
Oooe, sally 7722337 119932404007801 239.83 0.10 41312005 4/3(2005
Opoe, sally 7722337 119932404007801 56,72 3806 3f16/2005 3f16/2005
Oooe, saly 7722337 119932404007501 26.50 966 4{7/2005 472005
ORight, sarmuel 7722337 119932404007801 397.50 18477 3f14/2005 3f14/2005
Orignt, samuel 7722337 119932404007501 397.50 18477 3j24/2005 3f24/2005
Opoe, sally 7722337 119932404007501 32,64 1890 6f21/z004 6/z1/z004
Oright, samuel 7722337 119932404007501 397.50 18477 2f18/2005 zf18(z005
Oright, samuel 7722337 119932404007801 397.50 18477 3{18/2005 3/18/2005
Oooe, sally 7722337 115932404007601 49.78 3lzz 3fzlfzoos 3fz1fza05
Opoe, sally 7722337 119932404007801 57.74 36.35 12/4j2004 1214}2004
Oooe, sally 7722337 115932404007601 26.50 12859 1j4fz005 142005
Opoe, sally 7722337 119932404007801 26.50 12.89 2472005 2/4/2005 |
Oooe, sally 7722337 115932404007601 26.50 966 34fz005 342005
Opoe, sally 7722337 119932404007801 26.50 956 4472005 4/4/2005
Oooe, sally 7722337 113932404007801 90.80 4569 2{19/2005 z/19/2005
Oboe, sally 7722337 119932404007801 238.77 160,20 3{18/2005 3/18/2005
Opoe, sally 7722337 119932404007801 26,50 9,66 4{7/2005 472005
Oooe, saly 7722337 119932404007801 397.50 19154 1215/2004 12[1542004
ORight, sarmuel 7722337 119932404007801 57.74 33.86 1/6{2005 1/6/2005
Orignt, samuel 7722337 119932404007501 26.50 12.89 2{6/2005 262005
Oright, samuel 7722337 119932404007501 26,50 12,59 3{6/2005 3/6(z005
Orignt, samuel 7722337 119932404007501 26.50 966 4{6/2005 462005
Opoe, sally 7722337 119932404007501 397.50 18477 3{15/2008 3/15/z005
Oooe, sally 7722337 119932404007501 397.50 18477 3f23/2005 3fz3(z005
Oooe, sally 7722337 119932404007801 55.36 27.86 4712005 472005 -
e — —— P, v T e _’I_I
L, Print checkal | [JUncheck sl | pata
Segment count 5] 9j17/z006

Click Help.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

40



Medicare Remit Easy Print

Online Help System

Medicare Remit Easy Print opens the Medicare Remit Easy Print Help window and
displays the introduction.

alzix)

TA] Se.zich Dinplay taol for
Windaws 7000, Windews XP.

= MREF altsws haaltheats providers ta view, seaich, and
Trean

o payment infssmation rece b
Madicars hectionically,

How to Use the Contents Tab

1. To see what’s inside a book, click the + sign.

A

What is Medicare Remit Easy Print?

= Madicars Bomit Easy Print (MREF) b an Elacuonic
i Adddcs

alzix)

Mamittancs Advice [FIA Seanch Display taol fay
dows XP.

= MELP allows healihcare providers 1 vow, seanch, and

uparnt clalem paymant infsamation recebved frem
Madicare sbeconicalty.

A

What is Medicare Remit Easy Print?

= Madicars Ramit Easy Print (MREP) is an Elactanic
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2. Click a topic to display the topic.

-loix
- -

Hide Back Frint  Options

a
Contents 5 5 n - —
= | ndex | Search] Medicare Remit Easy Print Main
Introduction - What is Medicare Remit £ indow
=] t@ Making sense of ..
Medicare Femit E asy Print window
] Claim List Tab ; co : .
=] Claim Detail Tab The main application window:
@ Remit Summary Tab
@ Data View Tab "
@ Search Tab Al
@ Glogzary Tab Taalbar
g How to.. AREABSLRANE | AC
Wwiorking with Reports o | ’}_ﬁ:;éﬁfg x
@ Maintainence R EHIEISh AREATWSLRANE | G
AREA INGURANCE AC
@ Uninztall ARIA DESRANTE | ¢
AREA INGURANCE AC
Claim List tab
iz active
< T | - |

At this point, you can:

Print the topic

Click Prirt

View Options

Click = Jptians

o

Return to the previous view

Click Back

Hide the tab =
=]

Click =~ Hide

3. To close the book, click the — sign.
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How to Use the Index Tab
1. Click the Index tab.

BLIES
& o= o
Hde Bk Do
Coniern 1ot | Somch| What is Madicare Remit Easy Print? |
Tyme i the baypsnd o it
& Madicara ftamit Eawy Print (MREP) b an Elsctranic
Famittance Advics [ERA} Search Tsplay teal fst
T - | Windows 2000, Windows XP.
aduthrank
gl = MREP allsws healthcare providers 1o view, search, and
achive Toport claii payment information veceived fiom
56 Medicare olecuenically.
BILLED AMOUN!

CIREEK DATE
CHECICEFT TRACE MUMBER
elain datid

CLAIN MFORMATION FORWARDED 10
eles et

CLAIM TOTALS

o8

COING

e

ingort

TEREST

LATE ALMG CHAAGE
nt

2. Type a keyword to find.

~lalx
g o= & &
Conerts e | Somch| What is Medicare Remit Easy Print? |
Tyma in e baypeond fa find:

& Madicara famit Easy Print MREP Is an Elsctranic
Framit Acdvice [ERAL Search Tsplay ool [or
Windows 2000, Windows XP.

+ MREP allows healthcare praviders 1o view, search, and
Toport claii payment information veceived fiom
Wedicare clocnsnically,

TOTAL ALLIWED AMOUNT
TOTAL CLAIMS

TOTAL CAIKSLIRSHCE AMOUNT
TOTAL DECUCTIDLE AMOUNT
TOTAL PID 10 PROVIDES

TOTAL AEASDN COOE ADJUSTUENT A)_|
unwnital P |

le-l
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3. Select a keyword by double clicking on it or click the display.

Il x|
< & 0
Hide Back Frint  Options
Contents Indes I§earch| PROC: This |s_the H_CF'CS proped;l

- codes is available here:
Type in the keyward to [{edf hitt p:ffwnnnnr, o, hhs. gowT)
[prac MODS: These are all the modifiers
jpROc_ 4| BILLED: This is the amount the pra
PROY PD
PROVIDER # . o ;
PROVIDER NAME ALLOWED: This is the allowed amoun
PT RESP )
RARC DEDUCT: Thig the amount of any de
REND PROV claim. This is the amount
Rieports other insurer, if applicable)
resource 2 h 'der
resource files the provider.
Hesm}? COINS: This is the amount that the
Fearc 3 i i H y.
PRV DATE |nsu_r§r, if applicable) is res
starting provider.
SUMMArY GRP/RC: These are any Group Code
tals Reason Codes for the sen
taolbar o
TOTAL ALLOWED AMOUNT - AMT: This is the armount of any
TOTAL O AIMS .| the Group and Claims Adji
Display | PROV PD: This is the armount the p_mﬁl
4 | b

How to Use the Search Tab
1. Click the Search tab.

7 b e et sy P el SlmiE
o = 4
Hade: Back Pard Qe
: B
orderes | s | ‘What is Medicare Remit Easy Print?
Tyt i s e b el
j o Madicare Romit Easy Print (MREF) bx an Elecuonic
Mamitance Advice (EA Seach Display taol far
Windaws 7000, Windows XP.
Sk o o sl o, shrch, and
bved from
| 2
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2. Type a keyword to find, then click the List Topics button wl or type
Alt + L.

What is Medicare Remit E=Zy Print?

Berencian el Easy Piint MREF) Is an Electionic
Memitlance Advice [ERA) Search Diplay ool lo
Lt Topes Wiinilows 2000, Windows XP.

Salect Topi: o gl « MREP alloves healihcare providens to view. search, anil
e rapert clalin payment information recotved fram
Madicars slociionically.

_I' ¥l

3. Once the list of topics appears, double click the one you want.

-l
- -

Hide Back Frint  Options

onterts | Inder Seorch | Claim Detail Tab

Tupe in the keyward to find:

-

|beneficiary Making Sense of the Claim Detail
Tabh
List T_op& |
Select Topic to display: 8 lindicarn Romil EasyPrint v, 31
e gee froon Sewch loss tep
Llaim Detall Tab Prost | Preat = | Riwdee | R

Clairn List Tab Paper e Popeerime

AER IMGURANCE  ACME PHYSICIANG TC

ARER INSURANCE  ACME PHYFCIANS .
:

AETA INRIRSACT  ACVE PeIrSICAN T
ARER INSURSACE  ACME PrSICING TG,
ARER INSLSAMCE | ALME PSICIANS T
APER INTURANCE  ACHE PRPTICIAN T

s List Chire Dbl | P Sarw-t Data

Dizplay |

How to Close the Medicare Remit Easy Print Help Window
Click the close window button 2 or type Alt + F4.
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Importing HIPAA 835 files

The first time that you start Medicare Remit Easy Print, you must import an HIPAA 835
file.

For information about this procedure for the first import, see Step 1 on page 27.

Before You Import the HIPAA 835 File
Before you import an HIPAA 835 file, you must:

» Load the Medicare Remit Easy Print program (on a network, see page 13 —or —
on your PC, see page 22)

»  Know the location of the HIPAA 835 file (Step 4 of the Pre-Installation Checklist
— page 22).

Import File Name Format

When you import the HIPAA 835 file, Medicare Remit Easy Print makes a copy of it,
renames it, and stores it in the Import file folder.

The file-naming format is as follows:

PPPPPPPPPPPPPPPPPPPPPPPPPPPPP Payer Name — 30 bytes maximum
CCCCccceececceecece Check/EFT # — 15 bytes maximum

If a file has been imported successfully and you attempt to import the same file, an error
record is written to the Import Exception Summary window/report and the file is not
imported into the MREP application. Importing a file format other than HIPAA
835v4010A1 or 835v5010A1, or a non-compliant version of a HIPAA 835-formatted file
also writes a record to the Import Exception Summary window/report and the file is not
imported into the MREP application.

NOTE: With the release of MREP v2.9 (April 2011), the only acceptable versions of the
HIPAA 835 file that can be imported into MREP are 835v4010A1 and 835v5010AL1.
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How to Import the HIPAA 835 File

Hint:

For information
about the very
first time you
import, see
Step 1 on page
27.

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon m

The Medicare Remit Easy Print Claim List tab opens.

edicare Remit EasyPrint ¥2.40 MEEI
Ele Tab View Beport Search Iook Heln

et | P report -

S h| Prink List
SE —

M srchive | 7 Restors | ) Delete

native »12N835 remittance
1S THC, 1

| Claim Detail Remit Summary Data Yiew | Search | Glossary |
[ | | ACHT 1 [ Billed Amount | Paid Amount | FromDate | To Date -
[Coee, sl 7722337 118932404007201 230,53 010 44312005 4f3/2005
oo, sl 7722337 112932404007801 56.72 w05 3j16/z008 3/16/2005
oo, salt 7r2zIar 112932404007801 26.50 265 4}7iz005 4f7/2005
Oriaht, Safuel 7722337 118932404007801 397.50 18477 | 3j14/2008 3/14j2005
Oriatt, saruel 7722337 112932404007801 397.50 18477 | 3j24/2005 3/24j2005
Ooee, Sl 7722337 115932404007501 3264 18,90 efz1/2004 6/21j2004
Oright, Samkel 7722337 112932404007801 397.50 18477 | 2j18/2008 2/18j2005
Oright, samfe! 7r2zIar 112932404007801 397.50 18477 | 3jisfzoos 3/18/2005
oo, Sally 7722337 112932404007801 4878 slzz 3jzifeoos 3j21j2005
Ooee, sally 7722337 118932404007801 57.74 3635 12/4/2004 12/4j2004
[T 7722337 112932404007801 26.50 12.89 1/4j2005 144/2005
Oooe, Sally 7722337 115932404007501 26.50 1289 2}42005 2j4{2005 _
Ooee, Sally 7722337 112932404007801 26.50 266 342005 3/4/2005
Oowee, Sally 7r2zIar 112932404007801 26.50 265 4}4fz005 4j4{2005
Oooe, Sally 7722337 118932404007801 90.50 4568 zji9fz00s 2/19j2005
Ooee, sally 7722337 119932404007801 238.77 18020 3j18/2005 3/18/2005
Coee, Salty 7722337 112932404007801 26.50 2.66 41712005 4/7/2005
Ooee, Sally 7722337 112932404007801 397.50 19154 121572004 12152004
Oright, Samuel 7722337 112932404007801 5774 3396 1/5iz005 1{6/2005
Oright, Samuel 7r2zIar 112932404007801 26.50 12,39 zlefzo0s zj6/2005
Oright, Samuel 7722337 118932404007801 26.50 12,89 3lefz005 3j6/2005
Oriatt, samuel 7722337 112932404007801 26.50 2.66 4J6f2005 4j6/2005
Oowee, Sally 7722337 115932404007501 397.50 18477 3j15/2005 3/15(2005
Ooee, Sally 7722337 112932404007801 397.50 18477 3jz3/2008 3/23j2005
Oowee, Sally 7r2zIar 112932404007801 55,35 2756 4}7iz005 4f7/2005 .
R —— L P P oo _},J
L Pt Check &ll CJuncheckal @ Data
Segment count >>855 9/17/z008

2. Click the Import button or go to the File menu option and select Import.
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Medicare Remit Easy Print opens a window for you to select the HIPAA 835 file to

import:
Import ANSI x12 835 ERA 2| x|
Loak, in: Im Desktop j & I'j( =
G
& B
by Metwork. Acrobat Adobe QWwS3270 Snaglt B
Places Digtiler 6.0 FReader 7.0 PLUS
7 N
- =
ARt Ed 8 Ed
Snaglt Studio  Documents EasyPrint  FrameMaker Track T-Rex

-

D

WwebEx Player  Windows

hedia Plaper
File narne: I j Open I
Files of type: I j Cancel |
7

3. Select the HIPAA 835 file that you want to import by double-clicking it
Medicare Remit Easy Print starts the import and lets you know that it is importing:

Importing electronic remittance(s)...
ANNENEN

After the import finishes, the MREP Remittance Advice List window appears.

At this point, you can:
Work with the MREP Remittance Advices  See Working with MREP Remittance Advices on
page 53.
Work with Reports See Working with Reports on page 86.

Note: Medicare Remit Easy Print reformats and saves a copy of the HIPAA
835 file. This copy is the Import file. If you import the same HIPAA 835 file
more than once, Medicare Remit Easy Print bypasses the duplicate file and
displays the Import Exception Summary Report indicating duplicate remittances
were detected.

For information about making sense of the Import file name, see Import File Name
Format on page 46.
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How to Automatically Import the HIPAA 835 File
1. Close Medicare Remit Easy Print. Right click on the Easy Print icon and click

Properties. The EasyPrint.exe Properties window appears.

EasyPrint.exe Properties 2] x|

General Shortcut |Securit_l,l|
o
1A

E azyPrint. exe

T arget type: Application

T arget location: Easy Print

Target: we'' - 'CAMABEPYFiles to be imparted'no_phi et

[ Bunin separate memory space [ Fun az different uzer

Start in: I"I:'\Eas_l,l Frint"'

Shartcut ke INn:-ne

Bur: I Marrnal window j

Comment; I

Eind Target... | LChange |con... |

k. I Cancel | Apply |

Note: The values in the various fields vary for each MREP user.

The Target: value needs to be modified to indicate the location of the files that are to
be imported. The user must enter a space after the last double quote, the value of —I
or —i (not case sensitive), followed by another space and the pathname. The pathname
must be in double quotes. For example, "I:\Easy Print\EasyPrint.exe" —i
"C:\MREP\Files to be imported\no_phi.txt"

To save the changes you made to the Target: value, you must click the Apply button.

Once you click the Apply button, then you must click the OK button. The Properties
window then disappears.

You can restart the MREP software.
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Notes:

If the user updates the Target field with a file path that does not exist, a
message dialog appears stating the target file does not exist. Once the user
chooses to close this window by clicking the OK button, the MREP software
continues to run with the files that have already been imported.

EasyPrint x|

Auto import Function has been aborted.
File :C\MREPYFiles tono_phi.txt doss not exisk,

Each time that the MREP software is invoked, it always accesses the import
pathname to attempt to import the data that is contained in the specified file.

When a duplicate remit file or a file with an invalid data format (not
835v4010A1 or 835v5010) is encountered, the Import Exception Summary
window appears. The user can choose to Print or Close this window. Once
the user chooses to close this window, the MREP software continues to run
with files that have already been imported.
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What to Do with an Import Error Message
There are two error messages that you may see:

For this error message: You need to:

Invalid File Format Select the correct HIPAA 835 file to import.
You have either selected an ERA not in a HIPAA 835 format or an
ERA that is a HIPAA 835 with invalid delimiters. If you continue to
receive this error, contact your contractor.

Path / File Access Error Check with your network/PC administrator.

You need to have read/write access rights to the Medicare Remit
Easy Print directory.

Import Exception Summary Window/Report

The Import Exception Summary window/report helps to identify duplicate files,
file formats other than HIPAA 835v4010A1 or 835v5010, non-compliant HIPAA
835-formatted files, and prevents the posting of “junk” files to the import folder.
If any of the scenarios that are described above are encountered while attempting
to import files to the MREP application, an Import Exception Summary dialog
displays a list of invalid files by Payee and Check/EFT #, in addition to a brief
description of the issue encountered.

The following remits were not imported for the reason(s) indicated :
File: C:\Documents and SettingsiJen-K\Desktop\INVALID.TXT

Payee Check/EFT § Reason

Version Invalid : 004010X031A2
Version Invalid : 004010X031AZ
Hot an 835 transaction : 837

Version Invalid : 00401009142
Version Invalid : 004010X031A2
Version Invalid : 004010X031A2
Version Invalid : 004010X031AZ2
Version Invalid : 004010X091AZ
Version Invalid : 004010X051A2
Version Invalid : 004010X031A2
Version Invalid : 004010X031AZ
Version Invalid : 004010X031AZ2
Version Invalid : 004010X091AZ
Version Invalid : 004010X031A2
Version Invalid : 004010X031A2
Version Invalid : 004010X031AZ2
Version Invalid : 004010X091AZ
Version Invalid : 004010X051A2
Version Invalid : 004010X031A2
Version Invalid : 004010X051A2
Version Invalid : 004010X031A2

WALTER L FOX LSL113AE34618Y8 Duplicate remit
PROCARE PHAPRMACY INC 074000011112586 Duplicate remit
PROCARE PHARMACY INC 074000011112587 Duplicate remit
PROCARE PHARM DIRECT INC 074000011112588 Duplicate remit
PROCARE PHARM DIRECT INC 07400001111258% Duplicate remit
PROCARE PHARM DIRECT INC 0740000111125590 Duplicate remit
PROCARE PHARM DIRECT INC 0740000111125581 Duplicate remit
PROCARE PHARM DIRECT INC 0740000111125592 Duplicate remit
[INATNL REHAER EQUIP INC 074000011110246 Duplicate remit

fint
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You have the option of closing the window or printing the Import Exception Summary. If
you choose to print the Import Exception Summary report, the window does not close
automatically once the report prints. You need to close the window using the close button
or “X-ing” out (top right corner of the Import Exception Summary window). The printing
functionality for the Import Exception Summary report follows the existing printing
functionality within MREP. Please note that if the window is closed prior to printing the
report, the list of import error(s) is lost. To eliminate the need for file space management,
a decision was made to not save the MREP Import Exception errors. To recreate the
Import Exception Summary window, the files need to be imported again.

The Import Exception Summary window and report contains three columns of
information.

e The first column of information is entitled “Payee”. Depending on what type of
error is encountered during the import process, this field could contain data or
spaces. The maximum number of bytes of data that can appear is 40.

e The second column of information is entitled “Check/EFT #”. Depending on what
type of error is encountered during the import process, this field could contain
data or spaces. The maximum number of bytes of data that can appear is 15.

e The third column of information is entitled “Reason”. Depending on what type of
error that is encountered during the import process, there is the possibility of three
different messages appearing.

Prior to the three columns of data, the Import Exception Summary window and report
contains a heading with the title “File:”. The information following the “File:” heading is
the location and name of the file that the attempt is being made to import into the MREP
application.

When the Import Exception Summary report prints, the printed version contains an
additional heading prior the “File:” heading. It is the first heading on the report. On the
left side of the page, the heading displays “Import Exception Summary”. In the center of
the page, the heading displays the date and time stamp when the summary report was
printed. The format of the date is MM/DD/CCYYY. Please note that the leading zero in the
month and day do not appear — for example: 2/15/2006. The format of the time is
HH:MM:SS XX (XX represents AM or PM). On the right side of the page, the heading
displays the version of the MREP application that is being used (for example: Easy Print
v1.7).
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Working with MREP Remittance Advices

How to View a List of Claims for an MREP Remittance Advice

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon m
The Medicare Remit Easy Print Claim List tab opens.

2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the associated
claims below.

B rredeare Remit Evsyiriot v2A0
e Toh Yew Hepot Seach ook el

Wirgert || P oot || R echie

You clicked
Payee 1

— Dloon, say 11502HHO0TB0] 2983 i
Ooee, Saby 1ISAENHO0PA0] T2 BOE
Doee, saby 119A24HO0TA0] .80 96
J— Dlfight, Samued 1150244007601 37.50 1A TT
These are the Daughs, Samed 1IHHRHH007801 7.50 177
claims for Dlose, 5sty 1IFHITHA00700] W4 1850
Daigs, samusd NFFRAHOTI0] ] 77
Payee 1 DOasghs, samed A0 w150 177
Dloee, ssby TSRO0 070 nz
Doce, ssby NFERHHOOTI0L shT4 .55
DOooe, say 0,50 12

[]Coe, Saby 6.50 125 =
Clroe, saby 450 66
e, Sy .50 (X7
O, Saby .60 A5.E8
[Joe, saby 38,77 16020
[Jone, saby 119532 4HO0TR0] 26,50 BEE
[Jtwe, Saby 11552 HO0TA01 37.50 19154
Cheicht, Samuel 119324HO0TA01 5174 ned
Dok, Sameed .50 1245
Deits, Samued .50 1265
Dlsuge, Samed VTR A .50 (s
Doce, ssby IFEREHANT0] 50 1,77
L Doee, sab IR HHONTI] £ .77

Doee, saty NIFERSHOGI 5.2 2706 %

L. Pt Elcheckal | [luncheckl B Data
Segment count >898 W1Ti0E

Note: Some screen reading applications may not be able to read all of the values on the claim
list tab. Function key F1 displays an accessibility informational message allowing the screen
reading application to recite the field names and values displayed in the listview for the
highlighted claim. Please note the Patient’'s Name appears the Last Name first, followed by a
comma and then the First Name:

Patient Mame iz Doe, Sally
Account number is 7722337
ICN iz 113932404007501
Billed Amount = 239,83

Paid Amount = 010

Service From D ate is 4/3/2005
Service To Date iz 4/3/2005
Claim Assignment indicatar =Y

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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At this point, you can:

Find out more about this tab
Print the list

View claim details

View a Summary for the Remittance
Advice

View the data that feeds the Remittance
Advice

Search

View the CARCs and RARC:s for the
Remittance Advice

See page 76.

_ Print
Click Q or go to the Tab menu

option and select Print Claim List, or type Alt + B
+P.

For more info, see How to Print a List of Claims
on page 68.

Click i Dzl or go to the View

menu option and select Claim Detail

For more info, see How to View the Detail for a
Claim on page 55.

Click Remit Summaty or go to the View
menu option and select Remit Summary

For more info, see How to View the Total
Amounts for a Remittance Advice on page 57.

Click| Data Yiew or go to the View
menu option and select Data View

For more info, see Making Sense of the Data
View Tab on page 83.

Click | Search or go to the View
menu option and select Search

For more info, see How to Search Payment
Information on page 73.

Click Glossary or go to the View
menu option and select Glossary

For more info, see on page 62.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to View the Detail for a Claim
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .
The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims
below.

B Melic e Rt Eavsrind v2.48

Do Ts Yew Espot geach look beb
Wincet || Propet o Bacee [ Retore  Xowete O] sewch et Lt

You clicked

Payee 1
Clam st | Combetdl | et Summary Batam | Sewch | @mer |

Name I AHT I =] I [ Podsmcore]  eromoste | ToDate =
[ | Clooe, saby s TNEATEOL £ 1 [ELR. ] Arafzoos
[ s TLERHOTE 56,72 s Hefz00s L6005
Dltue, Saby bprce iy 1PACOTEN] 6.50 286 ApENe A0S
Deuge, sanmi TrE ST 750 (e 31afaes A1afzns
These are the — Dlewh, Samuel TI2anT 1158044007001 w50 T 30 A2ej2005
H Dloee, 5oty TRy 1PIH00TEO] 2 1850 SZLE0M BIZIR
claims for Dtape st iy imsesticonor %0 e ajues g
Payee 1 Oeigte, savuel Trenn TR0 s LN N A0S
Dlooe, sav Ty 1IP0I 07 LR T 3212005
Ovos, sy I TIRATOOTROT .M k) 12{4/2004 134004
Dleoe, saby Trzn AT .50 124 \Jafaos

Dooe, saty Ty 11993400701 26.50 1289 242005 -t
(m [ becess i) 11 HAMHOOTAN] 26.50 A8 Afaf2008
Dlioe, saby vezz AFETAHNTI0L .50 [ jaj0
Dowe, sy TN 11400001 0.00 55 219005
[J0ue, Sabr 1WA HTEN =877 (L] Aj18R0ns
Olioe, saly RO .50 96 2100
Dlte, sdy 1LFEAHT001 750 19154 12152004
Camight, Somuri TR 1LTIAAHOTAN] s 0 12008
DOlete, Samsi Ty IHOTEOT 26,850 1209 2jbj2008
e, Sameel Ty 1LSHI404007801 .50 1285 hf2005
Dlnighe, samuei TN 1L FA2AOOTENY 26.50 GEE ATR[2005
Coos, saty e TnwzamonTIN w150 e 180
Dltoe, 2ady 2N LS00 7.5 16477 22005

| Ooor, say Ty 1LFIAH00TED] 5% Ek 472008 o

o e S—— e i o l‘_l

- Echmbal | [Juecheckal O pata
Segmert. courk. 33855 HN7j2008

Hint: 3. Check the checkbox next to the claim that you want to see detail for. Detail

You can click

on a column .
h . Do Ty Wew Bapot faerch lock Meb
eadlng to Winoert || Prooot = | Bt | Fetere | Kosete | O serch || preist
Change the Tayer N | Payon Noern [ropoe® | ChockDote | ChoBFT . | Chock®FT . | Claes | ChooEFT tumsbr T erson [ Ferme |
AHEA INGURRACE  ACME PHTSICLANS B TrMsATE Lo ALVI#4 EFT ] fF DOAIDEWIAL  ARER INGLEAN ..
sort order.
Gamier | Gemootdl | Resumsry | Dwaew | Sewn | Gy |
T T i6fieos
You selected Dltoe, saty 22 1LFHIAH0T001 0,50 L frieoes 72005
1 Dlrigre, Samet 1192 H00TED] w50 177 H14/2008 A 142005
the fIrSt name DOnight, Sammd 1L SRRTM0O0TRO IS0 18T ¥ AT4008
i Dloos, saby TR0 Tt 10 211 i
on the IISt Dleighe, Samel 1FI00TE0L w80 LT 2200 18R008
Dnight, Sl FEAHOOTEN .50 7T 318/2008 318005
Dove, saby ANFIHOOTE0L .78 na fa Elralre
Dltoe, saby 1LFHAHHOT001 s ¥ 241 LEf4f00
Dooe, sy 1LP9EH00TEN] .50 1289 I’ 1f472005
Hint: DCewm, aly TR0 .50 um g #ans
- Dloos, saby AR % L N Aaj0ns
Dlves, sy 11T %50 985 i 4[5
You Can use Otoe, Saly 1L AZHOOTEN .80 £80 /) 5 apons
Dlooe, saby ARG zn.37 1030 101208 ALfs
the CheCk A” Dltoe, saby 1LEIHAOTE .50 L (2005 af7jz005
oo, say ™I 11 MEMHOOTEN nr.sn 19154 L2150
and Uncheck Dloge, sarmt rezren IS 514 w1 b
e, senmed birra ) AT .50 1265 oS 26
Dlnigte, samet LE i 1IFIIAHTEN %50 1289 B[2005
All buttons to = B eesmer am S e
Dline, saby ARG w80 A 3 LA
help yOU SeleCt DCltos, Saty JLFHARHH0N001 Ek 10477 2005
H [m 1LTEAHOOTEN] ) .85 ATR005 -
the claims. o e Bl LIJ
o P ]l 5
Seqment courk: 3055 o

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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4. Click the Detail tab.

The detail appears for the claim you selected:
il

Fie Tab View Fepoit Seach Tools Help

" rroport ‘ P repart v| M oarchive [ Restore J€ Delete ‘Q Search ‘ L Pk List

Payer Name [ Payee Name [Payee | checkDate | CheckiEFT ... | CheckiEFT ... | Clams | Check/EFT Number [ version, [ Filenz
AREA INSURANCE  ACME PHYSICIANS INC, 12345678 042305 1157.85 EFT 15 12345 005010%22141 AREA

Claim List Claim Detal Remit Summary | Data View Search 1 Glossary 1

IAREA INSURANCE MEDICARE I~
225 Main Streec REMITTANCE

Cencerville, PA L7111 ADVICE

DAYER'S UEB SITE: WUW.ACMEPHYSICIANS.COM

PAYER BUSINESS CONTACT INFORMATION:
Jane Do
(900 555-5555

DAYER TECHNICAL CONTACT INFORMATION:
JOHN TOHNSTON
CLATHPAYHENTSEACHEPHYSICIANS. COI
{555)686-8324 ext. 6288

|ACHE PHYSICIANS INC. HEI g: 1234567890

225 Main Streen DATE: 04/23/2008

Centervills, PA 17111 PAGE #: 1

CHECK/EFT #: 12348

EEND PROV SERV DATE P03 NOS PROC  MODS BILLED  ALLOWED DEDUCT  COINS GRE/RC---—-----, AT PROV FD -
IAME Do=, Sally HIC SIDL1111 ACNT 7722337 ICH 119932404007801 XSG ¥  MOR MR1S HAOL

1234567890 0407 040705 12 78.7 EL390 RR 34450 200.38  0.00 40,08 CO-42 14411 160,31

SUB NOS:  98.7

Prink. @ zoomIn 2 zoom Cut  Resst Zoom I Glossary

cHTL #: 54321

Click to print 7/15(2011
the detail

At this point, you can:

Find out more about this tab See page 77.

Print the detail —_—
Click the print button, =

or go to the Tab menu option and select Print
Claim Detall, or type Alt + B + P.

For more info, see How to Print the Detail for a
Claim on page 70.

Return to the Claim List

Click the claim list tab Claim List
or go to the View menu option and select Claim
List.

For more info, see How to View a List of Claims
for an MREP Remittance Advice on page 53.

View a Summary for the Remittance Advice

Click the summary tab Reit SUmmary
or go to the View menu option and select Remit
Summary.

For more info, see How to View the Total
Amounts for a Remittance Advice on page 57.

View the data that feeds the Remittance ) ) | Data View
Advice Click the Data View tab
or go to the View menu option and select Data
View.

For more info, see Making Sense of the Data
View Tab on page 83.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Search
Click the Search Tab | Search

or go to the View menu option and Search.

For more info, see How to Search Payment
Information on page 73.

View the CARCs and RARCSs for the

Remittance Advice Click the Glossary Tab Glossary
or go to the View menu option and select
Glossary.

For more info, see Making Sense of the
Glossary Tab on page 85.

Option to print or suppress the printing of A check box with the word Glossary appears in
the glossary of CARCs and RARCSs for the the lower right side of the Claim Detail tab.
Remittance Advice (not available for When this check box is checked, the glossary
Remittance Advices printed from the menu of CARCs and RARCs involved with a

bar or toolbar) particular MREP Remittance Advice prints on a

separate page. When the check box is not
checked, the glossary of CARCs and RARCs
involved with a particular MREP Remittance
Advice does not print.

The user also has the option via the Tab menu
option to show or not show the glossary of
CARCs and RARCSs involved with the MREP
Remittance Advice.

How to View the Total Amounts for a Remittance Advice
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon m
The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims
below.

3. Click the Remit Summary Tab Reemit Summary |or type Alt+V + S,
Medicare Remit Easy Print displays the totals, for example:

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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B 2o/

FasyPrint v3.1 FROVIDER PATNEWT SUISLLRY REFORT VER: 0050L0XEZLAL -]
FrovIngg Mank © ACME PIDVSICIANS ING,
et & 1 L23EETaS0
csECE DATE 0472308
ChEck 0Pt TEACH B © tenas
TOTAL CLATHE 118
BILLED AMOINT R
TOTAL REASON CODE ADJUSTMENT AMOUNT . 877.38
TOTAL ALLOVED AMOUNT L 1336
TOTAL COINSUPANCE AMOTNT 1 17,23
TOTAL DEDUCTIELE ANOUNT . -13.53
TUTAL PAID TO PROVIDER t T
TOTAL INTEREST AMOUNT . g.00
TOTAL CHECK/HFT AMOUNT t T
FROV ADT CODE: FCH/OTHER IDENTIFIER: AMT: =8.01
PROV ADT CODE: i $SLLIZZIFE  ANT: .56
pro and conk: ©ONMLLLZEANED  ANT: -1
#8111223333  ANT: 7.21
i SSLLIZZIFE  ANT: 6.21
FUNSUTUER IDENTIVEER: o Ant: v.es
FLM/OTHER TDENTIPIER: : AnT: vonh
FOH/OTHER IDENTIFIEN: ANT: 1243
FCH/ IDENT: AnT. Lz.34 =|

Click the print
button
or type Alt + B + P to
print the summary

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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At this point, you can:

Find out more about this tab

Print the summary

View claim details

Return to the Claim List

View the data that feeds the Remittance

Advice

Search

View the CARCs and RARCSs for the

Remittance Advice

See page 81.

Click the print button &

or go to the Tab menu option and select Print
Claim Detail or type Alt + B + P.

Click the Claim Detail Tab|  ClamDetai

or go to the View menu option and select Claim
Detail

For more info, see How to View the Detail for a
Claim on page 55.

Click the Claim List tab Claim List

or go to the View menu option and select Claim
List

For more info, see How to View a List of Claims
for an MREP Remittance Advice on page 53.

Click the Data View tab Data View

or go to the View menu option and select Data
View

For more info, see Making Sense of the Data
View Tab on page 83.

Click the Search tab Search
or go to the View menu option and select Search

For more info, see How to Search Payment
Information on page 73.

Click the Glossary tab Glossary

or go to the View menu option and select
Glossary

For more info, see on page 62.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to View the Data in the Import File
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon m
The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.
Medicare Remit Easy Print highlights the Remittance Advice and lists the claims

below.
3. Click the Data View Tab| Diata View or type Alt + VV.
Medicare Remit Easy Print displays the file format:
'Fi-l«.-rllnml EanyPrinl w240
He Yew Eeport faarch look Helo
Wingert || PRspert = Asrchte | FlRestore | Moskte | O Seoech || perneis
Paryer Moers | Py Morre: Irmmem [ chodiboe [ chodrr . [ owd®Fr. | Coen | ChociEFT hussber [ Fierome I
AHEA INSURARCE  ACME PrvsICERss INC. TIMEATE A ATV EFT 81 [F DOMOIEEIAL  AREA INGLRAN...
Gemist | Cempetdl | pemktuwmary [ DaAwew | sewh | Gomay |
[ [ Deserption T s I
Select a loop & . o ] 2
segment \
The contents of
the loop &
segment
appear here
avive o
Segment. count >3 B55 #17/2008

At this point, you can:

Find out more about this window See page 83.

View claim details Click the claim detail tab! Claim Dekail
Or, go to the View menu option and select Claim
Detail.

For more info, see How to View the Detail for a
Claim on page 55.

Return to the Claim List

Click the claim list tab Clali List
Or, go to the View menu option and select Claim
List.

For more info, see How to View a List of Claims
for an MREP Remittance Advice on page 53.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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View a Summary for the Remittance
Advice

Search

View the CARCs and RARCSs for the
Remittance Advice

Click the summary tab Remit Sunimary |

Or, go to the View menu option and select Remit
Summary.

For more info, see How to View the Total
Amounts for a Remittance Advice on page 57.

Select the search tab | Search

Or, go to the View menu option and select
Search.

For more info, see How to Search Payment
Information on page 73.

Select the glossary tab | Glossary

Or, go to the View menu option and select
Glossary.

For more info, see on page 62.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to View the CARC and RARC Codes
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .
The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.
Medicare Remit Easy Print highlights the Remittance Advice and lists the claims

below.
3. Click the Glossary Tab| Glossary ortype Alt +V + G,
Medicare Remit Easy Print shows the Reason and Remark codes for the Remittance
Advice:
B Mo are Bemit EasyPriol v2.A0
e T yew Beport Jearch Jock el
Wircert || Posort - | Macwe | Fl Ao | Woekte | O Sowch | el
[ [ Py P [PupmaiD | CluckDatw | Check¥FT .. | Chad¥T . | Cluem Iu-wu.nbv [ eruan | [
AREATNSURANCE  ACME PHYSICIANS INC. 12345678 DAfRAS 4231.69 EFT 5 DOAD BT AL AREA INSURAN. ..
Clam Lt | Clam Detad | Tiemit enmary | Distn Views | Sneerh [ Sy |

I*

42} « Clusrges matmend e e sckochbe or msimam slowabin moourd. (Lios CARC 45)

4 50 } « These are rrrcovered services because Uhis i rot deemed a “medcal necessty” by the payer,

[ BI7 } - Payment adisted because ths service mas ot & phrysician, not. to delbvery, b reomplete, or ok curent,

{ €0 } - Conbractur ol Ctigations.

s} of the o thes month when the equpmert & o nges nesded.

4 M7 } « No rental parments after the tem i purchased, o after the totel of s 1

ML | - Alert: If you do ot agree with what we agoroved for these sences, you may sppedl our decsn. To make sure that we are far U v o, Mlm!lulmlmillmmlﬂvmﬂsm
ket clomm b conchuct the scpedl. Homever, I crder to b ehable for an apgdl, v s writs b us weln 120 days of the dete wniess you haw b late.

({ MA07 | - Alert: The clam inf; has slso been formarded id for reviews.

({MAL3 - Alert: You mate be sublect bo penalties F you bill the patient for amounts not reperted with the %1 (patient responsblity] groun code.

| MALE | - lert: The claiem inf sy being the patiert's ook insurer. Send any

[{ MA27 | - Missinafincompletejirrvald entitement number or rame shown on the dam,

HNLIS | - This dectson o o Lecal Cover aoe O {LCDY An LMRAPALCD prerides & ouide o assist in determining whether 4 particulyr Bem or servce b5 ﬂ
B zomin )] ZoomOW | o RegetView “"Codes

»

/ o
Click the Codes button or

type Alt + B+ Cto see a
comprehensive list of
codes and descriptions.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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At this point, you can:

Find out more about this tab

View claim details

Return to the Claim List

View a Summary for the Remittance
Advice

View the data that feeds the Remittance
Advice

Search

View the CARCs and RARCSs for the
Remittance Advice

See page 85.

Click the claim detail tab| ~ imDetai
or go to the View menu option and select Claim
Detail.

For more info, see How to View the Detail for a
Claim on page 55.

Click the claim list tab lairn List

or go to the View menu option and select Claim
List.

For more info, see How to View a List of Claims
for an MREP Remittance Advice on page 53.

Click the summary tab Remit Sunimary

or go to the View menu option and select Remit
Summary.

For more info, see How to View the Total
Amounts for a Remittance Advice on page 57.

Select the data view tab | Data Yiew

or go to the View menu option and select Data
View.

For more info, see Making Sense of the Data
View Tab on page 83.

Select the search tab | Search
or go to the View menu option and select Search.

For more info, see How to Search Payment
Information on page 73.

Click the codes button E at the bottom of
the tab or type Alt + B + C.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Look up a CARC/RARC Code
1.

Type a specific /

code or click a
code to display
its description
and notes

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon m

The Medicare Remit Easy Print Claim List tab opens.
On the menu Select Tools > Code Descriptions.
The Code Descriptions window opens.

E Easy Print -- Reason/Remark/Group Codes (04,01 /2006)

100
101
02
103
104
105
106
107
108
109
11

110
111
112
113
114
115
116
17

118 LI

Code count »> 340

Description :

o e
|
10

Deductible Armount

Mote

=10l x|

Clase
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How to Update (Import) the CARC/RARC Codes

At a minimum, the ANSI Claim Adjustment Reason Code (CARC) and Remittance Advice
Remark Code (RARC) file requires an update three times a year. When the list of codes is
updated per Washington Publishing Company, VIPS provides an updated file on the VIPS
Assist website for the contractors and CMS provides a link to the updated file on the CMS
website for the provider/supplier community. When the user finds it necessary to import this
updated file into MREP, follow these instructions:

1. Access the list of the latest codes from the VIPS Assist or CMS website.
2. Save the list of latest codes so that they are easily accessible.

Note: The file name must be saved as Codes.ini in order for MREP to successfully find the
code file.

3. Select “Import Code Descriptions” from the Tools menu.

B8 Medicare Remit EasyPrint v2.40

File Tab View Report Search | Tooks Help

Archive

W import Report - & Delete: Search Print List

P P rep o 4 Q -

pa;er Hame PaEae Hame Restore: heck Date | CheckiEFT ... | CheckfEFT.. | Claims | Check/EFT Mumber Version | Filename

AREATNSURANCE ACME PHYSICI;  Code Descriptions 04j23/05 423169 EFT st 12345 O040104091A1  AREA INSURAN...
I ons
Path Name Editar

Claim List | Claim Dekail | Remit Summary | Data View | Search [ Eibssary |

[{ 42 } - Charges exceed our fee schedule or maximum allowable amount, (Use CARC 43)

{50} - These are non-covered services berause this is not deemed a *medical necessity’ by the payer

H B17 } - Payment adjusted because this service was nok preseribed by a physician, not prescribed prior ba delivery, the prescription is incomplete, or the preseription is nat current.
[{ 0O } - Contractural Obligations

[{ M8 } - Marnithly rental payments can continue until the earlier of the 15th mortth fram the First rental manth, or the manth when the equipment is no longer needed.

{17 } - No rertal payments after the item is purchased, or after the tatal of issued rental payments equals the purchase price.

{ MADL } - Alert: IF you do not agree with what we approved for these services, you may appeal our decision. To make sure that we are Fair ta you, e require ancther individual that did not process your
nital claim to conduct the sppeal. However, in arder to be elighle for an appeal, you must write ko us within 120 days of the date you received this notice, Umless you have  good reason for being late.

H MANT } - Alert: The claim information has also been Forwarded to Medicaid for review.

L{ MA13 } - Alert: You may be subject bo penalties i you bil the patient for amounts not reported with the PR (patiert responsibilty) oroup code,

[{ M18 } - Alert: The claim information Is also being Forwarded to the patient's supplemental insurer, Send any questions regarding supplemental benefits to them, —

[ MA27 } - Missingfincompletsfinvalid enttlement number or name shown on the dlaim.

4 111 } - This decision yras based on 2 locsl medical review oolicy (LMRPY or Local Coverage D {LCDY,An LMRPALCD orovides a auide to assist in dstermining whether a particular item or service is X1

zoomIn ) ZoomOut |-« ResstWiew 9 Codes

5/17f2008

4. A dialog window appears asking to confirm the code import.

Import New Code File ]

@ WARMING: Completing this operation will replace vour existing CARCIRARC information.

COMTIMUE ?

To replace the existing If you don’t want to replace
CARC/RARC:s, click Yes. the existing CARC/RARC:s,
click No.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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If you select the NO button, the dialog box disappears and no updates are made to
MREP. If you select the YES button, a file dialog box appears.

Import New Code Information 2] x]

E_-I Shortcut boRasyPrink_IMSTALL

File niarne: I \ j Opet I
Files of type: | Code File [Codes.ini] \ -] Canicel |
P

5. Navigate to the folder or area where you saved the file under step 2. Select the Codes.ini file,
then click the Open button.
Lack iri: | = MREP Data files | = ®EcFE
Codes.ini
b | rr||:|lutEer
7e
File name: I j Open
Files of type: | Code File [Codes.ini) =l Cancel /|
7

Click the Open button. /

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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6. After you press the Open button, a dialog displays confirming the code import was
successful. Click, or select the OK button to close the dialog.

EasyPrinkt ﬂ

Code import Successful

/

Click OK.

7. The latest list of CARC/RARCSs exists in the MREP application. To verify that the latest
version exists, select “Code Descriptions” from the Tools menu. The following dialogue box
appears. Please note that the dialogue box includes the date of the latest version of the code
list.

E Easy Print -- Reason/Remark/Group Codes (D4/01,/2006) _10] |

I Descripkion @

_g, 1}
10 Deductible Amount

100
101
102
103
104
105
106
107
103
109
11

110
111
112
113
114

115 Mote ;

116

117

-
Code count >3 940 A
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How to Print a List of Claims
1. View the list of claims.

For the steps to follow, see How to View a List of Claims for a Remittance Advice on
page 53.

e
2. Click the print button w at the bottom of the tab or type Alt + B + P.

The Print Options window opens.

Print remit listing x|

Cen [ rem [ oo |

3. Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.

The Print dialog opens.
o 2=
[~ Priter
Marme: Properties..
Status: Ready
Tyvpe: HP Laser)et 4200 PS
Where: TCE-020
Comment t [~ Piint to fils
~ Print 1ang Copi
& Al Murber of copies: 1 3:
€ Fages t'l
o ” '!] '! | Collste
€ Selection

If you need to ¢chxdnge the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. Click Preview to view a preview of the printed page before printing.
The Print Preview window opens.

o x|
SO- 0mBE @ | o :

Click printer button & at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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At this point, you can:

Find out more about this window

View claim details

Search

View a Summary for the Remittance
Advice

View the data that feeds the Remittance
Advice

View the CARCs and RARCSs for the
Remittance Advice

See page 76.

Click the Claim Detail tap| i Detai

or go to the View menu option and select Claim
Detail

For more info, see How to View the Detail for a
Claim on page 55.

Click the Search tab | Search
or go to the View menu option and select Search

For more info, see How to Search Payment
Information on page 73.

Click the Summary tab Remit Summary |

or go to the View menu option and select Remit
Summary

For more info, see How to View the Total
Amounts for a Remittance Advice on page 57.

Click the Data View tab | Data View

or go to the View menu option and select Data
View

For more info, see Making Sense of the Data
View Tab on page 83.

Click the Glossary tab | Glossary

or go to the View menu option and select
Glossary

For more info, see Making Sense of the
Glossary Tab on page 85.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Print the Detail for a Claim
1. View the detail for the claim.

For the steps to follow, see How to View the Detail for a Claim on page 55.

T Tlerine
2. Click the print button & at the bottom of the tab, or type Alt + B + P.

The Print Options window opens.

Print remit listing x|

[ em [ peer ][ oo |

3. Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.
The Print dialog opens.
print 2]

~ Prirter
Properties

Mame:
Status: Ready

Type: HP Laser)et 4200 PS
Wwhere:  TC-5-020

Camment: ™" Prink to file

1~ Print rangs

Copi

Mumberof sopiess |1 =

¥ | Collate
1 1
! Carenl

If you need to ¢hrdnge the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

@ A

€ Pages !loml_ ;o:l_

' Selection

B. Click Preview to view a preview of the printed page before printing.
The Print Preview window opens.

_m|
,O-|El'mﬂ| Close Page I =

Click printer button & at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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How to Print the Remittance Advice Summary

1. View the Remittance Advice Summary.

For the steps to follow, see How to View the Total Amounts for a Remittance Advice
on page 57.

e
2. Click the print button w at the bottom of the tab, or type Alt + B + P.

The Print Options window opens.

Print remit listing x|

Cen [ rem [ oo |

3. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.

The Print dialog opens.
proc 2=
[~ Priter
Marme: Properties..
Status: Ready
Tyvpe: HP Laser)et 4200 PS
Where: TCE-020
Commen t I~ Fiint to file
~ Print 1ang Copi
& 4l Mumber of cepiess |1 =
' Pages  fom tn'l
: ) | Call

If you need to change the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.
The Print Preview window opens.

g =
5L - B@BBB | o g

Click the printer button = at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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71



Medicare Remit Easy Print
Working with MREP Remittance Advices

Searching Payment Information

You can search by:

e HICN
e Bene Last Name
e ICN

* Bene Account Number
e Procedure code

» Service date (range of dates in the format MM/DD/YY, MM/DD, MM/YY,
DD/YY, MM, DD, or YY; forward slashes are not required when entering a
value in the “Value to Find’ field)

* Rendering Provider Number
e Adjusted Lines

* COB Claims

* Non-COB Claims

» Deductible/Coins Lines
» Coinsurance Lines

* Deductible Lines

e Other Adjustments

* Denied Lines

« NDC

* MSP Claims

*  Non-MSP Claims

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Search Payment Information
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon.
The Medicare Remit Easy Print Claim List tab opens.

emit EasyPrint v.40

Eio Tal Wiew Beport Search Took Hels =
Wingeet || Pasgert <| | Bactws | F rosore | Hoektn | Q Soweh | _prrte

Fager ame | Payee: Name
PRFATNSLRANCE  ACME PHYSICTANS INC.

Tl Cleim Detad | R Suimary | Dt Ve | Search | ahssary |
Hasne | ACHT | I [ Ededieout | Pedimowt |  FromDste | TaDate [ =«
[ noe, Saly TrEEAAT 1ISAEM0MN0TAN1 239.83 (8] Aj372005 AfH2005
[ TrIEET 199ETMD07R01 5577 WOE IIET00S N
[ Traar 119332404007801 2650 9.66 4/7/2005 472005
Druhe, Samrvasl T HIFFERAMHOUIL ] 477 AT WAl
[0 right, Samued TraEET 1IEMOO07801 750 18077 3fj2008 008
[ TrIET IFEEMDOTEN 3264 1890 AfyE00 AP0
IRt sl Traar 119932404007801 97.50 184.77 (182005 Z{182005
O rsght, Sanmel TrEE TIFEAA0TI0L ] AT s EQEL
Do, sy TraEET 1IEMOO07801 4878 322 31008 31008
oo, sy TrEEET 1IFEO07EN] 5774 .35 1242004 122004
[ Traar 119332404007801 2650 12.89 11472005 174{2005
Do, saiy T 1AL ] 12 240 2hafeors =
oo, sy TraEET 1IEMO07E01 e 964 342005 e
Do, by TrIEET 1IEMAO07E01 e 964 Aj4 2005 Aff00
[ Traar 119332404007801 90.80 45.69 2{19/2005 1942005
Do, saiy T 1AL T 16020 oS WS
[m[R TTEEAAT 1I9AEMIM0TAN 2650 AEA A7f2005 Aiens
Oooe, sy TraEET 1IEMOO07801 750 19154 12{15[004 121502004
IRt sl Traar 119932404007801 .4 3.8 11672005 176{2005
D rsghe, Samosl T HIFFERAMHOUIL ] 12 L EEL
O right, Samuel TTENT 130007801 %50 1289 30Ef2005 Helz00s
[0 right, Samued TraEET 1IEMOO07801 e 964 4jEf2005 Afefo0s
[ Traar 119932404007801 97.50 184.77 3(15/2005 11512005
Oooe, Saby TrEE TIFEAA0TI0L ] W4T s EraEl]
Oooe, sy T ST 5 A A REELE =
e T —— A v m— i _’I_I
L Print L)checkal | [Juncheckal T Data

AfTIA008
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2. Click the Search button or the Search tab.
The Search tab opens.

& Medicare Remiit EasyPrint v2.40 ME R
Ele Tsb Vew Report Search Tools Help
W port P report  + | B archive 7 Restore | 3 Delete Q Search L Print List
Payer Name: [ Payee Hame [Payeetn [ CheckDate [ CheckfFT .. [ ChedqEFT.. [  Clams | Check/EFT Mumber Version [ Filename
AREA INSURAMCE  ACME PHYSICIANS INC, 12345678 04/23{05 4231.69 EFT 51 12345 00401009141 AREA INSURAM. ..
Claim Lisk Claim Detai Remit Summar Data Yiew Search Glossar:
Search tab ' - | v |
Search Walue to find: Search Tupe
| =l € Epzctfatch € Begisiit € Cantaine ‘ Search
Use the drop- ——
down list to
select the field
you want to
search on.

When ——
applicable,
enter the value
to find.

If available,
select the radio
button that

corresponds Bl ez [flJemoe
with your entry 9/17/2008
in the Value to

find: field. 3. Use the drop-down list to select a search field.

Hint: If applicable, enter the value to find. The Search tab includes three radio buttons for
You cannot use how the field should be searched (Exact Match, Begins With, or Contains). To
a wild card display the “searched” data, you must select one of these radio buttons before
f::;f;f&:“ clicking the Search button. The Exact Match, Begins With, and Contains radio

buttons are only available for the HICN, ICN, Bene Account Number, Bene Last
Name, NDC, Procedure Code, and Rendering Provider fields. If the Search: field is
not one of these fields, the Exact Match, Begins With, and Contains radio buttons are
not available.

If you select one of the Service Date formats from the drop-down menu, you can
. enter the date in the Value to find field

. use the drop-down list only to access the Calendar picker for the
MM/DD/YY format only. Use the left and right arrows to select the
month, and then click on the date you want.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

74



Medicare Remit Easy Print

Working with MREP Remittance Advices

Hint:

You can use a
calendar date
picker to select
a service date.

Hint:

If you cannot
see all the
columns, use
the horizontal

i iedicore Remit LasyPrint 240

Be T Yew Bt sewdh lock ten
Picet | Prast -

Boetre  Fometon  Joskte | D Sewch it
FaperHane | Paves hiane [Pssem | chochiute [ checktrt.. [CheotFt. | Clms [ Chacytrt umber T varsion [ Fesrarma 1
SAEA DOLRAACE  ACME PYSICIOG NG, 1ZME8TH AN T i 12308 OMOURINIAL  AREA INSLRAN,,
Gemlit | Qeebetal | RemtSessy | Databen Searth Gy |
i abham bo s each e
[service Date (MTIYT) | | [ =] i e r
I A v
S P Tue e T Fro_ ot
1
23466 70
9 10 B2 13 M 05
1 17 10 19 M n &
R
»
o Teday: /177000
177008

Click the Search type to start the search.

Medicare Remit Easy Print returns all of the claim lines/info that match the search.
For example, if you search for claims that begin with EO in the Procedure Code field.

If the remit contains any claim lines with Procedure codes beginning with EO, the
Search Tab listview is updated with those claim lines matching the criteria.

B redicare memit LasyPrint v.40
scroll bar. B T Y Bort Sowch Tk b _ o

Winpeet || [P aepert «| | Boarchwe | T Rostore | I oeletn | 13 Sooreh T
Payper bama | Payres hamn |Payne ity | Checkfate | CheEFT .. | ChockfBFT... | Clums | CheckieFT humber | ¥ersinn | Fename ]
BAER TNSLRANCE  ACME PR SICTANS INC. 12345678 Hj23Ins 423188 EFT 51 12345 DEHANCNAL AREA TNELRAN. ..

The search was | (T Rar Ay | i swch | ey |

for a procedure .,m : Soachlice

pcode that Frocedurs Cude | € Esackbiaich | l
begins with EO i DS N3 "“5

Hint:

You can change
the sort order
by clicking a
column
heading.

e

_/

Click the print
button or type
Alt+B + P to
print this list of
claims

afi7fe00

Click the claim
detail button or
type Alt+B + C
to display the
details for these
claims
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Making Sense of the Claim List Tab

Claim List tab

Hint:

Key F1 displays a
dialog containing
the listview field
names and
values. This
enables screen
reading programs
to read all the
listview fields for
a highlighted

claim.
Hint:

Click on a
column
heading to
change the

sort order.

For the procedure to view the claim list, see How to View a List of Claims for an MREP
Remittance Advice on page 53.

The claim list tab displays a summary of all of the claims found within the selected
remittance:

dicare Remit EasyPrint v2.40

Tah Wiew Report Search Togls Hslp

Buttons

W troport | P report  ~| B archive 7 Restore | 3 Delete ‘ Q Search ‘ o Print List
Payer Name | Payes Name [Payest [ checkDate [ CheckfEFT ... [ Check/EFT... [  Claims | CheckEFT Humber [ version | Filename |
AREA INSURAMCE  ACME PHYSICIANS INC, 12345878 04/23f05 4231.89 EFT 51 12345 004010%091A1 AREA INSURAN. ..
Caim List Claim Detail Remit Summary Data View | Search | Glossary |
Hame | ACHT | IcH [ Biled Amount [ Paid Amount | FromDate | To Date [ N
Oooe, sally 7722337 118932404007601 239.63 0.0 4/3j2005 4[3[2005
Ooce, sally 7722337 119932404007801 56.72 38.06 3/16/2008 3/16/2005
Oooe, sally 7722337 119932404007801 26.50 966 4{7j2005 417 12005
Oright, Samusl 7722337 119932404007801 397.50 164,77 3 14/2005 3i14j2005
Oright, samuel 7722337 119932404007801 397.50 184.77 3/24/2008 3/24j2005
Oooe, sally 7722337 119932404007801 32.64 16,90 6212004 621j2004
Oright, samuel 7722337 119932404007801 397.50 184.77 2/18/2008 2/18j2005
Oright, samuel 7722337 119932404007801 397.50 184.77 3182005 3j18/2005
Oooe, sally 7722337 119932404007801 48.76 31.22 af21[2005 3212005
Ooce, sally 7722337 119932404007801 57.74 36.35 1242004 12j4/2004
Oooe, sally 7722337 119932404007801 26.50 12,689 1j4/2005 1/4}2005
Ooce, sally 7722337 119932404007801 26.50 12.89 2/4j2005 2/4)2008 | |
Ooce, sally 7722337 119932404007801 26.50 9.66 3/4j2005 34/2008
Oooe, sally 7722337 119932404007801 26.50 966 4/4j2005 4[4/2005
Ooce, sally 7722337 119932404007801 90.80 45.69 2/19/2008 2/19j2005
Oooe, sally 7722337 119932404007801 238.77 160,20 A 162005 311Bj2005
Oooe, sally 7722337 119932404007801 26.50 9.66 4{7j2005 472005
Ooce, sally 7722337 119932404007801 397.50 191.54 12§15/2004 12/15/2004
Oright, Samusl 7722337 119932404007801 57.74 33.86 182005 162005
Oright, samuel 7722337 119932404007801 26.50 12.89 2/6i2005 2/6)2008
Oright, Samusl 7722337 119932404007801 26.50 12,689 3i6iz005 Af6/2005
Oright, Samusl 7722337 119932404007801 26.50 966 4/6i2005 462005
Ooce, sally 7722337 119932404007801 397.50 184.77 3/15/2008 3/15/2005
Oooe, sally 7722337 119932404007801 397.50 164,77 A 232005 3f23j2005
Ooce, sally 7722337 119932404007801 55.36 27.86 4/7j2005 4/7}2008 =
e — P —— i _'I_I
L Print A check all [Juncheck &l @ Dats
9i17j2008
Name This is the name of the beneficiary that the claim was processed for.
The name field is defined as Last Name followed by the First Name.
A comma separates the two names.
ACNT This is any internal number assigned to the claim by the provider.
ICN This is the Internal Control Number (ICN), the unique number
assigned to the claim when it is received by the contractor.
Billed Amount This is the total claim dollar billed amount.
Paid Amount This is the total claim provider billed amount.
From Date This is the earliest From Date of service on the claim.
To Date This is the latest To Date of service on the claim.
ASG This indicates whether or not the provider has accepted assignment
for the claim.
. Print the list. (type Alt + B + P
Prink (typ )

9 Check &l Select all of the claims. (type Alt + B + C)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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[ [ Uncheck Al Unselect all of the claims. (type Alt + B + U)

Display Claim(s)

Fromthe Select claims in the claim list by enabling the checkbox for the corresponding claim. To

Tab display the selected claims, from the Tab menu option select Display Claim.

menu

option Mame ACNT TN Biled Amount Faid Amount From Diske Ta Date -

select [Boce b mmar | lswevoro i

Display Ooce, saly TI22EIT 119932404 007801 56.72 .06 aj16{2005 31612005

g Ooce, saly 7722337 119932404007501 26.50 9,66 4J7/2005 4J7/2005

Claim D rught, Sarmed FI22ET 119932404 007501 397.50 184,77 3H14/2005 3142005
Dright, Samuel ferrecr) 119932404 007801 357.50 184.77 I24{2008 3f24/2005
Foce, saly TIEHIT 113932404 007801 3264 18.90 61212004 612112004
A right, Sl 7722337 119932404007501 397.50 184.77 2{18/z005 2/13/2005
Dright, Samued TrEzaaT 119932404 007301 397.50 164.77 318120 3f1afz00s
Ocice, aky Tramr 119532404 007801 48.78 .z A0S 21 fans
Boce, saly TIZ2FIT 119932404 007801 57.74 .35 12f4/004 12j4/2004
Ooee, saly 7IZ2EIT 119932404007501 26.50 1283 1J4/2005 142005 i
[Erice, saly 7722337 119932404 007801 26.50 12.89 2J4f2005 242005
Oee, Saly Treaar 1198240007801 26.50 9.66 3412005 342005
Orce, saly 77227 119932404007801 26.50 L 4J42005 4)4f2005
[Floce, saly 7722337 119932404007301 20,50 45.69 2{19/z005 2{19/z005
Ooos, saly TrazEaT 119932404 00730] 238.77 160,20 3181m0s 3 Laizo0s
Otice, Saky 12T 119932404 007801 26.50 9,66 4f7j2005 4[712005
Ooee, ssly TIE2FIT 119932404 007801 397.50 191.54 12f15/2004 12/15/2004
O right, Sarmed 7722337 119932404007501 57.74 33.85 1J&f2005 1)Ef2005
Oright, Samue 7722337 119932404007801 26.50 12.69 2Jf2005 2lei2005
Dright, Samuel Traamr 119832404 007801 26.50 12.69 3e/2005 32005
DOright, Sermed FI22FIT 119932404 007801 26.50 966 4J6/2005 4J62005
Ooce, saly 7722337 119932404007301 397.50 184.77 3f15/z008 3152008
l:inoe. saly 7722337 119932404 007501 397.50 184.77 3jz3j2008 3.'23.'|2c|ns
“

EasyPrint displays the claim(s) information in a vertical line by line format:

119932404007601
-
CLATH |
ICN: 1188932404007201
Patient Name : Zally Doe
hssigned : ¥
HICH : 8JD11111
LCCHT # : FPEEIIT
Claim Remark Code 1 @ Man?
Claim Pemark Code Z : Maol
Claim Remark Code 3 H
Claim Remark Code 4
Claim Remark Code § H
Claim Level From Date : Z0os50407 o
Claim Lewvel To Date : E00E0407
Patient Responsibility Amount : 0.0z
Total Eilled Amount D E33.83
Total Allowed Amount : 0.1Z
Total Deductible Amount > o
Total Co-Insurance Amount : o.oz
Total Group Code Amount D E3R.T71
Total Provider Paid Amount : ol
Total Interest Amount > o
Total Late Filing Amount -0
Met Amount 0.1
Forwarded To H
Claim Status D18
Group & Reason codes & amouncs
Service Line # 1
Rendering Provider : 1125210001
From Date : 20050403
To Date : Z00E0403 LI

This format provides the claim data at a glance and allows screen reading software to
interpret the data more easily.
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Making Sense of the Claim Detail Tab

For the procedure to view claim detail, see How to View the Detail for a Claim on page

Claim Detall tab

Information for
the claim

55.

The claim detail tab displays all the claim information for each claim(s) that has been

checked on the Claim List tab.

& Medicare Remit EasyPrint v3.1 o [=] S|
File Tab “iew Repot Seach Tools Help

W mmport | P report ~ B archive | T Restore  JDelete | O search o Prin List

Payer Name [ Payee Name [Payeeld | CheckDate | Check/EFT . | Chedk/EFT .. |  Claims CheckEFT Number Version Filenz
AREA INSURANCE  ACHE PHYSICIANS INC, 12345673 4iz3/0s 1157.85 EFT 15 12345 0SDIONZZLAL  AREA

Claim List > Claim Detail Remit Summary

Data Yiew Search Glossary

AREA INSURANCE
275 Main Street
Centerville, PA 17111

PAYER'S WEB SITE: WWW.ACHEPHVSICIANS.COM

DAYER BUSINESE CONTACT INFORMATION:
Tane Doe
{300) E55-5555

TAYER TECHNICAL CONTACT INFORMATION:
JOHM JOHNSTON
CLATHPAVMENTS@ACHEPHYSICIANS . COH
(5551 686-8324 exn. 6288

ACHME PHYSICIANS INC.
225 Main Street
Centerville, PA 17111

CHECK/EFT §: 12345

DEND PROV SERV DATE  POS  NOS PROC  MODS BILLED

HMEDICARE
REMITTANCE
ADVICE

NPI #: 1234567690
DATE: 04/23/2008
PAGE §: 1

GOINS GRP/RC-----=--. AMT PROV ED /

Service line
headers

—

ALLOWED DEDUCT

MAME Doe, Sally HIC §JDLLL1L ACHT 7722337

ICH 119932404007501 ASG Y  MOA MALE MADL

1234567830 0407 040708 12 78.7 EL330 RR 344 50 Z00. 3% o0.00 40.08 CO-42 14d .11 160,31 ————— — 1 1
Me e e Service lines
CNTL #: 54321 j
Print ® zoomIn ) zoomOut -+ Reset Zoom ™ Glossary
71152011

Information for the claim:
NAME

HIC

ACNT
ICN

ASG

MOA

Service line headers
REND PROV

SERV DATE

This is the name of the beneficiary for whom the claim was
processed.

This is the Health Insurance Claim (HIC) number of the beneficiary
for whom the claim was processed.

This is any internal number assigned to the claim by the provider.

This is the Internal Control Number (ICN), the unique number
assigned to the claim when it is received by the contractor.

This indicates whether or not the provider has accepted assignment
for the claim.

This contains remark codes at the claim level.

This is the performing provider ID number.

This is the date(s) of service.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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POS

NOS
PROC

MODS

BILLED

ALLOWED

DEDUCT

COINS

GRP/RC

AMT

PROV PD

This is the two-digit Place of Service (POS) code.

A list of POS codes is available here:
www.cms.hhs.gov/states/poshome.asp

This is the number of services rendered.

This is the HCPCS procedure code.
A list of these codes is available here:
www.cms.hhs.gov/hipaa/hipaa2/regulations/transactions/default.asp

These are all the modifiers billed with the procedure.
This is the amount the provider billed for the service.
This is the allowed amount for the service.

This the amount of any deductible applied to the claim. This is the
amount that the beneficiary (or other insurer, if applicable) is
responsible for paying the provider.

This is the amount that the beneficiary (or other insurer, if
applicable) is responsible for paying the provider.

These are any Group Codes and Claim Adjustment Reason Codes
for the service line.

This is the amount of any adjustment made based on the Group and
Claims Adjustment Reason Code.

This is the amount the provider was paid for the service.

Second Line of Claim Line

NPI (if present)
SUBNOS
SUBMITTED PROC
REM

Totals

PT RESP

CLAIM TOTALS

ADJ TO TOTALS:
PREV PD
INTEREST

LATE FILING
CHARGE

NET

CLAIM
INFORMATION
FORWARDED TO:

This is the National Provider Identifier.
This is the submitted number of services.
This is the submitted HCPCS procedure code.

These are the Remark Codes at the line level.

This is the total amount that the beneficiary owes the provider for this
claim.

This includes the totals for all service-line level amounts:

BILLED

ALLOWED

DEDUCT

COINS

AMT

PROV PD

This field is blank in Medicare Remit Easy Print.
This is the interest amount paid for claims processing time.

This is the late filing charge.

This is the amount that Medicare owes the provider for this claim.

This appears when the claim is being forwarded to a beneficiary’s
supplemental insurer.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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GLOSSARY These are the Reason and Remark codes that are also shown on the
Glossary tab.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Buttons

Print the claim detail. (type Alt + B + P
Prink (typ )

@ Zoarm In

Q Zoorn Dk

'

Zoom in to make the size of the type larger. (type Alt + B + 1)

Zoom out to make the size of the type smaller. (type Alt + B + O)

Reset the type to the original size. (type Alt + B + R
—&= Reset £oom yP 9 (typ )

i

Appears CARCs/RARCSs and descriptions for the selected claims

[~ Glossary
when checked. (type Alt + B + S)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Remit Summary Tab

For the procedure to view the Remittance Advice detail, see How to View the Total
Amounts for a Remittance Advice on page 57.

The Remit Summary Tab displays total dollar amounts, claim counts, and provider
adjustment information if present in the selected remittance.

&5 Medicare Remit EasyPrint v3.1 =] 59
File Tab View Repot Seach Toolz Help
W ot | P report +| M archive | 7 Restore | 3 Delete ‘Q Search | __ Print List
Payer Nams | Payee Mame [Paves10 | checkDate [ Check/EFT... [ CheckiEFT... |  claims | CheckiEFT Mumber [ version [ Filene
AREA INSURANCE  ACME PHYSICLANS INC, 12345678 04/23j05 115785 EFT 15 12345 0S010X221A1  AREA
4] | |
Claim List Claim Dt Remit Summary Data View Search Glossary

EasyPrint w31 PROVIDER PATYMENT SUMMARY REPORT VER: 005010XZZ1A1 =
PROVIDER MNAME : ACHME PHVSICIANS INC.
NPT £ : 1234567830
CHECK DATE : D4/23/08
CHECKE/EFT TRACE # 1 12345
TOTAL CLATMS 1 15

BILLED AMOUNT H 2z37.65

TOTAL REASON CODE ADJUSTHMEMT AMOUNT - 377.38

TOTAL ALLOWED AMOUNT 133634

TOTAL COINSURANCE AMOUNT 274.23

TOTAL DEDUCTIELE AMOUMT -13_5%

TOTAL PAID TO PROVIDER 1157.85

TOTAL INTEREST AMOUNT 8.01

TOTAL CHECK/EFT AMOUNT 1l57.85
PROV ADJ CODE: LE FCHN/OTHER IDEMTIFIER: HIC: AMT -8.01
PROV ADJ CODE: FB FCN/OTHER IDENTIFIER: 10211548734455663 HIC: 89111223333 AMT: 34_56
PROV ADJ CODE: FB FCN/OTHER IDEMTIFIER: 10Z11548794455661 HIC: 859111223333 AMT: -1.22
PROV ADJ CODE: WO FCN/OTHER IDENTIFIER: 10211548754455664 HIC: 83111223333 AMT: 7.21
PROV ADJ CODE: WO FCN/OTHER IDEMTIFIER: 102115487344E5662 HIC: 83111223333 AMT: 621
PROV ADJ CODE: IR FCN/OTHER IDENTIFIER: HIC: AMT: 765 -
PROV ADJ CODE: IR FCN/OTHER IDENTIFIER: HIC: AMT: 7.65
PROV ADJ CODE: AP FCN/OTHER IDENTIFIER: HIC: AMT: 1z.43
PROV ADJ CODE: AP FCN/OTHER IDENTIFIER: HIC: AMT: 1234 LI
L Prink @ zoomIn  Q ZoomOut |« ZoomResst

7/15/2011

PROVIDER NAME
PROVIDER #
CHECK DATE

CHECK /EFT TRACE
NUMBER

TOTAL CLAIMS
BILLED AMOUNT

TOTAL REASON
CODE ADJUSTMENT
AMOUNT

TOTAL ALLOWED
AMOUNT

TOTAL
COINSURANCE
AMOUNT

TOTAL DEDUCTIBLE
AMOUNT

TOTAL PAID TO
PROVIDER

This is the provider's name.
This is the provider’'s ID number.
This Is the date of the check.

This is the tracking number for the check or EFT.

This is the total number of claims.
This is the total billed amount.
This is the total adjustment amount.

This is the total allowed amount.

This is the total amount of coinsurance applied.

This is the total deductible amount.

This is the total amount paid to provider.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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TOTAL INTEREST This is the total amount of interest applied.

AMOUNT

TOTAL CHECK /EFT  This is the total amount of the check.

AMOUNT

PROV ADJ CODE This is the remittance-level adjustment. This field only appears if a

remittance-level adjustment is present.

Buttons

Prit Print the summary. (type Alt + B + P)
o]

Zoom in to make the size of the type larger. (type Alt + B + 1)
Q\ Zoam In ‘

Q Zoorn Dk

Reset the type to the original size. (type Alt + B + R
—&= Reset Zoom yp g (typ )

Zoom out to make the size of the type smaller. (type Alt + B + O)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Data View Tab

For the procedure to view the data, see: How to View the Data in the Import File on page
60.

The Data View Tab displays the remittance fields as they are stored internally in MREP.

The data are stored in what are referred to as Segments. Each segment contains a varying
number of elements or fields.

BB Medicare Remit EasyPrint v2.40

Fle Ta0 Yiew Report Search Iools Help

o 1port | P report v| M srchive | [ Restore | JE Delete ‘Q Search ‘;Prmtust

Payer Nams [ Payee Name [Payeed [ CheckDate [ Check/EFT... | Check/EFT... |  Claims | Check/EFT Mumber [ wersion [ Filename |
AREA INSURANCE  ACME PHYSICIANS INC. 12345678 04f23{0s 4231.59 EFT B 12345 0401009141 AREA INSURAN, ..

Claim List | Claim Detail | Remit Summary ! Diata iew Search | Glossary
Loop & Segment »|[Fiedm | Description [ valus |

HORE : 5T o Transaction Set Identifier Cade 835

HORE : BPR 0z Transaction Set Control Mumber 0001
HORE : TRM

HORE : REF
HORE : REF
HORE : DTM
10004 : W1

10004 : N3
10004 : N4
10004 ; REF
10004 ; PER
10008 : N1
10008 : N3
10008 : N4
10006 : REF
2000 : L%
2100 CLP
2100 : NML
2100 : MOA
2100: DTM
2110 SC
2110: DTM
2110 CAS
2110 CAS
2110 REF
2110 REF
2110 AMT
21101 LQ
2110 5WC
2110: DTM
2110 CAS
2110 REF

2110 : REF .
e _’I_I

Seqment count > 855

5/17j2008

The HIPAA 835v4010A1 and 835v5010 formats separate data into segments and loops.

To understand how to read segments and loops, refer to the X12 835 Implementation
Guides.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Search Tab
For the procedure to view the data, see How to Search Payment Information on page 73.

The Search Tab displays a summarized list of claim information that matches the criteria
of the user’s search. The Name field’s format is the beneficiary’s Last Name, followed by
a comma and then the First Name.

Ele Tab Wiew Beport Search Took Help

A nrchive | [ Restore | 3 Delete

Import Report - ( Search| Print List
[ gi P rep Q =

Payer Mame | Payee Name | Payee [D | Check Date | CheckiEFT ... | CheckiEFT ... | Claims | Check/EFT Number | ‘Wersion | Filename |
AREA INSURANCE  ACME PHYSICIANS INC. 12345678 04f23/05 423160 EFT 51 12345 004010X091A1 AREA INSURAN. ..

Claim List | Claim Detail Remit Summary | Data View Glossary |
Search : walue ko Find: Search Type
Frocedure Code ~lE ( " Esact Match & Begins With € Contains ‘ Search
Name | ACNT | HICH | ] | Productiservice o | Service Date(s) |_pos | Billed | Allc
Doe, Sally 7722337 2011111 119932404007301 E0SE2 20050403 - 20050403 12 3843
Doe, Salky 7722337 SIDi1111 119932404007801 EO601 20050403 - 20050403 12 201.40
Doe, Salky F722337 BEEEEEEEEA 119932404007801 EO10S 20050316 - 20050316 12 56,72 4
Doe, Sally 7722337 SIDii11l 119332404007801 E0S70 20050407 - 20050407 12 26,50 1]
Right, Samuel F722337 sJDi1111 119932404007801 E1390 20050314 - 20050314 12 344.50 20
Right, Samuel FTE233T 2011111 119932404007501 E0431 20050314 - 20050314 12 93.00 3
Right, Samuel 7722337 SIDi1111 119932404007801 E1390 20050324 - 20050324 12 344.50 20
Right, Samuel 7722337 2011111 119932404007301 E0431 20050324 - 20050324 12 53.00 3
Right, Samuel 7722337 SIDi1111 119932404007801 E1390 20050218 - 20050218 12 344,50 20
Right, Samuel 7722337 2011111 119932404007801 E0431 20050215 - 20050218 12 £3.00 3
Right, Samuel 7722337 SIDii11l 119332404007801 E1390 20050318 - 20050315 12 344,50 e
Right, Samuel F722337 sJDi1111 119932404007801 E0431 20050318 - 20050318 12 53.00 3
Doe, Salky 7722337 SIDtiil 119332404007801 E0S70 20041204 - 20041204 12 26,50 1
Doe, Salky 7722337 SIDi1111 119932404007801 EOS70 20050104 - 20050104 12 26,50 1
Doe, Sally FT22337 2011111 119932404007801 E0S70 20050204 - 20050204 12 26,50 1
Coe, Salky 7722337 SIDi1111 119932404007501 EOS70 20050304 - Z00S0304 12 26,50 1
Doe, Salky 7722337 2011111 119932404007801 E0S70 20050404 - 20050404 12 26,50 1
Dog, Salky 7722337 SIDii11l 119332404007801 E0143 20050318 - 20050315 12 126,50 10
Doe, Salky F722337 sJDi1111 119932404007801 EO163 20050318 - 20050318 12 112,27 el
Doe, Salky 7722337 SIDtiil 119332404007801 E0S70 20050407 - 20050407 12 26,50 1
Doe, Salky F722337 sJDi1111 119932404007801 E1390 20041215 - 20041215 33 344.50 20
Doe, Sally FT22337 2011111 119932404007801 E0431 20041215 - 20041215 33 593.00 3
Right, Samuel 7722337 SIDi1111 119932404007501 EOS70 20050106 - Z00S0106 12 26,50 1
Right, Samuel 7722337 2011111 119932404007301 E0S70 20050206 - 20050206 12 26,50 1
Right, Samuel 7722337 SIDi1111 119932404007801 EOS70 20050306 - 20050306 12 26,50 1
Right, Samuel F722337 sJDi1111 119932404007801 EOS70 20050406 - 20050406 12 26,50 1
Doe, Sally 7722337 SIDii11l 119332404007801 E1390 20050315 - 20050315 13 344,50 204
= oL e — = 13 450 _»]‘I
— Print Results Clairn Detail
9/17/2008
; Print the list of claims from the search. (type Alt + B + P)
Print Resulks
T— View details for all of the claims from the search. (type Alt + B + C)
airn Dekai

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Glossary Tab

For the procedure to view the data, see How to View the CARC and RARC Codes
on page 62.

The Glossary tab displays the CARC/RARC codes and descriptions for the selected
remittance.

BB Medicare Remit EasyPrint v2.40 [_T5]
Fie Tsb View Report Search Iock Help

W Import | P repart +| M Archive | 7 Restore | 3 Delete ‘ Q) search | o, Prik List

Payer Name [ Payee Name [Payeetn [ checkDate | ChedqEFT . [ChedqEFT.. | Claims | CheckfEFT Humber [ wersion [ Filename:

ARES NSURANCE  ACHE PHYSICIANS INC, 12345678 04/23/05 423168 EFT 51 12345 O040L0FD9LAL  AREA INSURAN. .,
Claim List Claim Detail Remit Summary | Data View Search [ Glossary

{42} - Charges exceed our fee schedule or maximum allowable amount, (Use CARC 45} I
{50} - These are non-covered services because this s nok deemed a *medical necessity’ by the payer,

{B17 } - Payment adjusted becauss this service was not prescribed by a physician, not prescribed prior to delivery, the prescription is Incomplsts, or the prescription is nok current.
{ €O } - Contractural Obligations

[{ M& } - Manthly rental payments can continue until the earlier of the 15th month from the first rental month, or the month when the equipment: is no longer needed.

{ M7 } - No rental payments after the item is purchased, or after the botal of issued rental payments equals the purchase price.

{MAO1 } - Alert: TF you do ot agree with what we approved for these services, you may appeal our decision. To make sure that we are Fair to you, we require another individual that did not process your
Initial claim to conduct the appeal. However, in order to be eligble for an appeal, you must write to Us within 120 days of the date you received this notice, Unless you have a good reason for being late.

{ MAD7 } - Alert: The claim information has also been forwarded to Medicaid Far review.

{MAL3 } - Alert: Vou may be subject to penalties i you bil the patient Far amounts nok reported with the PR, (patient responsibiity) group code.

{MALS } - Alert: The claim information is also being Forwarded to the patient's supplsmental insurer. Send any questions regarding supplemental bensfits to them.

{ M27 | - Missing/incompleteinvalid entitlement number or name shown on the dlaim.

1 115 | - This decision was based on a local medical review policy (LMRF) or Local Coverage Determination (LD}, An LMRPILCD oravides 3 auide to assistin determining whether a particular tem or service s |
@ zoomIn @) zoom Our 4 ResetView U Codes

9/17(2008

Buttons
Zoom in to make the size of the type larger. (type Alt + B + 1)

Q\ Zoorm In ‘

Zoom out to make the size of the type smaller. (type Alt + B + O)
Q Zoom Cuk

Reset the type to the original size. (type Alt+ B + R
+ Reset Zoam yp g (typ )

Displays CARCs/RARCs and descriptions for the selected claims
“UEH Codes when checked. (type Alt + B + S)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Working with Reports
Medicare Remit Easy Print has 11 different reports:
» Denied Service Lines
* Adjusted Service Lines
» Deductible Service Lines
» Coinsurance Service Lines
» Deductible/Coinsurance Service Lines
» COB Claims Report
* Non-COB Claims Report
e MSP Claims Report
¢ Non-MSP Claims Report
e Other Adjustment Report

* Entire Remittance

Making Sense of the Denied Service Lines Report

This report displays claim service lines that have an allowed amount equal to zero and
are associated with a claim that does NOT have a claim status 22 (reversed claim). The
report includes only the lines on the claim that meet these criteria.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Carsi ex: AREA INSURNCE
[Payes #: 203980001

[Payec Hame:  ACHE PHESICIANE DNC.
Chk Date o4& 2208

crk /BT #: 12248

seq # ProvisHPT BONT # / Yame
0000l ozoszsonnl Treeeat

Bight Famuel

Le#  Serwwice Dakte(s) Prod/Terw ID  Billed Bllowed  Dedust Coins P4 o Prav
119922404007601 0L l2/22/03-12/22/0% 25261 40.00 0.00 000 0.00 o.00
a1 Reason Code; C0-18 Bemark Codes: N1l
40,00 0,00 000 000 000

Denied Service Line(s) Report
Generated: 9/22/2009 9:26:34 AM

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Adjusted Service Lines Report
This report displays claims that have a status of 22 (reversed claim).

This report does NOT show the adjustment claim that reflects the corrected dollar
amounts.

Adjusted Service Line(s) Report
Generated: 9/21/2009 12:24:21 PM

Carrier: AREA INSURANCE

Payee #: 0208960001

Payee Hame: ACHME PHYSICIANS INC.

Chk Date: 04723705

ChK/EFT #: 12345

Seq # Erov#/NFI ACNT # / Name ICN/HICN La# Service Date(s)  Frod/Serv ID  Billed Allowed  Deduct Coins ra to Prov

00001 0Z08980001 722337 119932404007601 01 02/10/04-02/10/04 A4450 -18.00 -13.20 0.00 -2.64 -10.56
Doe Sally 5ID11111 v Reason Code: CR-42 CR-2 Remark Codes:

00002 0208980001 722337 119932404007801 02 02/10/04-02/10/04 A6196 -238.50 0.00 0.00 0.00 0.00
Doe Sally SID11111 a1 Reason Code: CR-50 Remark Codes: M25 H102

00003 0208980001 7722337 119932404007601 03 02/10/04-02/10/04 A6Z53 -411.00 -380.40 0.00 -76.08 -304.32
Doe Sally 5ID11111 a2 Reason Code: CR-42 CR-2 Remark Codes:

00004 0208980001 722337 119932404007801 04 02/10/04-02/10/04 A6402 -13.05 0.00 0.00 0.00 0.00
Doe Sally SID11111 a1 Reason Code: CR-57 Remark Codes: M25 H115

00005 0208980001 7722337 119932404007601 05 02/10/04-02/10/04 A6446 -216.00 -98.40 0.00 -19.68 -78.72
Doe Sally SID11111 Az Reason Code: (R-42 CR-2 Remark Codes:

00006 0Z08980001 722337 1199324040076801 06 02/10/04-02/10/04 A6402 -13.95 -11.16 0.00 -2.23 -8.93
Doe Sally 5ID11111 a1 Reason Code: CR-42 CR-2 Remark Codes:

-910. 50 -503.16 0.00 -100.63 -402.53

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Deductible Service Lines Report

This report shows claim service lines that have deductible amounts greater than zero, as
well as those service lines with only deductible amounts greater than zero. It includes
only the lines on the claim that meet these criteria.

Deductible Service Line(s) Report
Generated: 9/21/2009 12:36:43 PM
Carrier: AFEL TNSURANCE
Payee #: 0208930001
Payee Hame: ACME PHYSICIANS INC.

Chk Date: 04723705

Chk/EFT #: 12345

Seq # DProv#/NPI ACNT # / Name ICH/EICH Ln# Service Date(s) Prod/Serv ID  Billed Allowsd  Deduct P to Prov

00001 0208980001 7722357 119932404007801 01 02/11/05-02/11/05 A44310 15.40 13.12 13.12 0.00
Doe Hally FID11111 KX Reason Code: PR-1 CO-42 Remark Codes:

00002 0208980001 722357 119932404007801 02 02/11/05-02/11/05 A44338 22.60 22.80 7.11 12.50
Doe Hally FID11111 KX Reason Code: PR-1 PR-2 Remark Codes:

00003 0208980001 722357 119932404007801 01 02/10/05-02/10/05 &44450 6.00 4.40 4.40 0.00
Doe Sally SIDL1111 AW Reason Code: PR-23 PR-1 Remark Codes:

C0-42 0R-23

00004 0208980001 7722337 119932404007801 02 02/10/05-02/10/05 &6021 375.00 315.30 30. 84 31.53

Doe Sally SID11111 il Reason Code: PR-23 PR-1 Remark Codes:

PR-2 CO-42 0A-23

419. 20 355.62 55.53 44.03

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Coinsurance Service Lines Report

This report shows claim service lines that have coinsurance amounts greater than zero, as
well as those service lines with only coinsurance amounts greater than zero. It includes
only the lines on the claim that meet these criteria.

Coinsurance Service Line(s) Report
Generated: 9/21/2009 12:33:21 PM

Carrier: AREA INSURANCE

Payee #: 0208950001

Payee Hame: ACHE PHYSICIANS INC.

Chk Date: 04/23/08

Chk/EFT #: 12345

Seq # Prov#/NPI ACNT # / Name ICN/RICH Ln# Service Date(s) Frod/Sezv ID Billed Allowed Coins Pd to Prov

00001 0208960001 7722337 119932404007801 01 02/10/04-02/10/04 A4450 18.00 13.20 z.64 10.56
Doe Sally SIDL1LLL Ay Reason Code: PR-2 C0-42 Remark Codes:

00002 0208960001 7722337 119932404007801 02 02/l0/04-02/10/04 A6L96 238. 50 220.50 44.10 176. 40
Doe Sally SIDL1LLL Al Reason Code: PR-2 C0-42 Remark Codes:

00003 0208950001 7722337 119932404007801 03 02/l0/04-02/10/04 A6253 41l.00 380.40 76.08 04,32
Doe Sally 5JD11111 Az Reason Code: PR-2 C0-42 Remark Codes:

00004 0208950001 7722337 119952404007601 04 02/10/04-02/10/04 A6402 13.08 10.44 z.00 8.35
Doe Sally 5JD11111 AL Reason Code: PR-2 C0-42 Remark Codes:

00005 0208950001 7722337 119952404007601 05 02/10/04-02/10/04 A6446 Z16.00 95.40 19.88 78.72
Doe Sally 5JD11111 Az Reason Code: PR-2 C0-42 Remark Codes:

0000E 0208950001 7722337 119932404007801 06 0Z/10/04-02/10/04 A640z 13.95 11.16 Z.23 .93
Doe Sally 5JD11111 Alcc Reason Code: PR-2 C0-42 Remark Codes:

00007 0208980001 7722337 119932404007801 02 02/11/05-02/11/05 Ad338 22.80 22.680 3.13 1z.50
Doe Fally STD11111 KX Reason Code: PR-1 PR-2 Remark Codes:

00008 0208960001 7722337 119932404007801 01 03/28/05-03/28/05 A6209 134.40 179.52 35.90 143,62
Right Samuel STD11111 A2 Reason Code: PR-2 C0-42 Remark Codes: N88

00008 0208950001 7722337 119932404007801 02 03/26/05-03/28/05 A6446 43.20 19.68 3.94 15.14
Right Samuel STD11111 A2 Reason Code: PR-2 C0-42 Remark Codes: N88

00010 0208980001 7722337 119932404007801 02 02/l0/05-02/10/05 A6021 375.00 315.30 7.85 31.53
Doe Sally SIDL1L1L AL Reason Code: PR-23 PR-1 Remark Codes:

PR-2 CO-42 OR-23

0001l 0208980001 7722337 119932404007801 03 02/10/05-02/10/05 A6446 25.20 11.48 0.32 114

Doe Sally 5JD11111 AL Reason Code: PR-23 PR-2 Remark Codes:
€0-42 0R-23

00012 0208980001 7722337 119932404007801 01 03/08/05-03/09/05 AE446 28.80 13.12 2.62 10. 50
Doe Fally SIDL1111 It Reason Code: PR-2 C0-42 Remark Codes:

00013 0208950001 7722337 119932404007801 02 03/09/05-03/09/05 A6456 120,00 10z.40 20,45 B1.92
Doe Fally SIDL1111 AL Reason Code: PR-2 C0-42 Remark Codes:

1719.90 1398 .40 221.06 884.23

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Deductible/Coinsurance Service Lines
Report

This report shows claim service lines that have both deductible and coinsurance amounts
greater than zero, as well as those service lines with only coinsurance and deductible
amounts greater than zero. It includes only the lines on the claim that meet these criteria.

Deductible/Coinsurance Service Line(s) Report
Genersted: 9/11/2009 11:46:15 &AM
Caveiex: AREA INSURANCE
Papee H: 0203930001
Payee Wame: &CHE PHYSICIANS INC.
Chk Date: nasza/05
CHE/EFT #: 12048
Seq # ProvANRT ACNT S Hame zem/NICH Lo Service Dabe(s)  Prad/Secv IB Billed Allowed  Dedust Coins  Pa ta Frav
00001 020F9F000L TrzEn 119922404007501 01 02/ 10/04-02/10/04 22450 15.00 1z. 20 0. 00 Z.64 Lo.56
Doe Bally 5011111 an Eeason Code: FR-2 CO-42 Remark Codes
00002 020F9E000L TrzEn 119922404007501 02 02/ 10/04-02/10/04 RA5195 2RE.50 zz0. 50 0. 00 22.10 178.40
Doe Sally EJD11111 a1 Reason Code: PR-2 CO-42 Remark Codes
00002 0208980001 wr2z32% 119902404007801 D2 02/ 10/ 04-02/10/04 86253 a11.00 280. 20 .00 .08 204,22
Doe Sally EJD11111 Bz Reason Code: PR-2 CO-42 Remark Codes
00004 0208980001 wr2z32% 119922404007801 04 02/ 10/ 04-02/10/04 26402 12.05 0. as .00 209 .28
Dee Jally 59D11111 a1 Beszon Code: PR-2 CO-42 Remaxk Godes
00005 0Z0FIF000L rEzEa 119922404007501 05 02/ 10/04-02/10/09 RE44E ZlE.00 9%. 40 0. 00 19.65 7E.72
Do Tally 59D11111 a2 Beszon Code: PR-2 CO-42 Remaxk Godes
00006 0Z0FIF000L rEzEa 119922404007501 06 02/ 10/ 04-02/10/09 RE40Z 1z.95 11.18 0. 00 Z.z2 593
Dee Sally SJ011111 alce EBensen Code: PR-2 C0-42 Remark Codes
00007 0Z0FFF000L rezza 119932404007501 01 02/ 1L/ 05-02/1L/058 A4210 15.40 lz. 12 1312 0.00 o.00
Doe Bally BJD11111 X Beason Code: PR-1 C0-42 Remark Codes
00008 0zosgenonl wr2zann 119972404007801 02 02/ 11/ 05-08/11/05  A4eTE zz.50 zz.80 717 3.1 12,50
Doe Bally BJD11111 X Eeason Code: FR-1 PR-2 Remark Codes
00003 0zZosgenonl wr2zann 119972404007501 0L 03/26/05-0%/25/05  A6E0F 192.40 179,52 .00 25.90 142,62
Right Bamuel BJD11111 az Eeason Code: FR-2 C0-42 Remark Codes: H5S
00010 ozosgenonl wr2eann 119972404007801 02 03/26/05-0%/25/05  A6446 az.z0 19.68 .00 3.92 15,78
Right Samusl SJ011111 AL Bessen Code: PE-2 CO-42 Remark Codes: NE8
00011 0205950001 LLFECEY] 119922404007301 01 02/ 10/ 05-02/10/05 22450 .00 a.a0 440 5.0 000
Dee Sally SJ011111 an Bessen Code: PR-23 PR-1 Remark Codes
co-42 O0m-23
00012 0Z0FIF000L rEzEa 119922404007501 02 02/ 10/05-02/10/05 RE0ZL s.0n 31520 30. 84 7.85 31.52
Doe Sally EJD11111 a1 Reason Code: PR-23 FE-1 Remark Codes
PR-2 CO-42 OR-23
00013 ozosgenonl T7z2a27 119902204007501 07 02/10/05-08/10/05 A6446 es.zo 11.a8 0.0 0.ez l1a
Doe Sally SJ011111 aL Eeason Code: FR-23 PR-2Z Remark Codas
co-42 0B 23
0001% 0Z0FFE000L rezza 119932404007501 01 03/ 09/ 05-03/09/05 AE44E EE.ED lz. 12 0. 00 Z.62 1o.50
Des ally 59D11111 a1 Beszon Code: PR-2 CO-42 Remaxk Godes
00015 0Z0FFE000L rezza 119932404007501 02 03/ 09/ 05-03/09/05 RAEISE lzo.0o0 L0Z. 40 0. 00 20. %5 Fl.92
Dee Sally 5UB11111 a1 Eeason Code: PR-Z CO-42 Remark Codes
1741 30 1415, 92 55.53 221.06 BE4. 23
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Making Sense of the COB Claims Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that were
crossed over. The requirement for crossover claims to print on the report is that the 2100
loop, CLPO2 data field must contain one of the following values:

19 Processed as Primary, Forwarded to Additional Payer(s)
20 Processed as Secondary, Forwarded to Additional Payer(s)
21 Processed as Tertiary, Forward to Additional Payer(s)

COB Claims Report
Generated: 9/11/2009 12:04:58 FM

[Pescyen ARCA INSURANCE

Payes #: 0znsgs0n0L

Payee Wame: ACHE PHYSICIANS INC.

Chk Date: 04/23/05

CRK/EFT # 12235

Seqt  RONTH Hame HICH 1o Billed Allowed Deductible  COINS Paid
Qoo 77ZEITT Dee, Sally 20011111 1199924904007601 210.50 73%.10 .00 1e5.52 ser.z8

Frocessed as primary, forwarded to SUPFLEMENTAL INSURER

ooooz  79z2aat Right, Banmel 2011111 119932404007501 227,60 199 .z0 o.o0 29 .54 15928
Processed as primacy, forwacded to UNERNOWI

0go0r 1722327 Dae, Bally 5011111 119922404007501 149%. 80 115,52 0.00 zz.10 9z.42
Frocessed as primazy, fomwazded to BUBS OF SOVTH CAROLINA (FEF)

1298, 90 1048.52 0.00 203,76 533,08

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the Non-COB Claims Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that did not
cross over. The requirement for claims to print on the report is that the 2100.CLP02 data
field does not contain one of the following values:

19
20
22

Processed as Primary, Forwarded to Additional Payer(s)
Processed as Secondary, Forwarded to Additional Payer(s)
Processed as Tertiary, Forward to Additional Payer(s)

Cavedew:

[Payes #:

Chk Date:

Cri/EET #

[Payee Name

Seqh  RmCHTH
boooy 7722387
oonoz 7r2zamT

oonoz 7TIZEET

NON COB Claims Report
Generated: 9/11/2009 12:08:31 FM

AREA INSURAHCE
0e069E0001

HCME PHYSICIANS INC.
0422/ 05

12345

Hame HICH Iow Billed Bllowed  Deduekible  COINS Paid
Doe, Zally 2ID11111 119932404007801 2. z0 2592 z0.29 a1z 12 50
Doe, Sally SJDL1111 119922204007601 406. 20 3zl.18 2524 8.17 3z 67
Right, Sanmel SIDL1111 119932404007801 40,00 0.00 0.00 o.00 o.00

454, 20 367,10 55.53 1130 45,17

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Making Sense of the MSP Claims Report

This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or

835v5010 file that were processed by Medicare as secondary. The claims have a value of

2 (Processed as Secondary) or 20 (Processed as Secondary, Forwarded to Additional

Payer(s)) in the 2100 loop, CLP02 data field.

(Carriar: PAYER INC.
Payuee ff; SETEE43210
Paywe Nams:  JOHNZDN DHATMACY INC

Chk Bate: 04/24/10

(ChIJEET #: O00500d 5578

Seqgil  RCNTH Mo

00001 ZASTET GARY, FMATTHEW

MSP Claims Report
Generated: 11/232010 9:37.07 AM

MICH Icw Billed Bl emmet
ESELEEEE5A 0123466783000 109212 &TE. 29
1082, 13 w1629

Deductible  COLNS

0.00

135. 26

135, 26

Padd

£41.02

4103
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Making Sense of the Non-MSP Claims Report

This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or
835v5010 file that were processed by Medicare as primary. The claims have a value of 1
(Processed as Primary) or 19 (Processed as Primary, Forwarded to Additional Payer(s))

in the 2100.CLPO2 data field.
NON MSP Claims Report
Generated: 11J23{2010 9:17:19 AM
Carwier: PAVER INC.
Payue #: SBTEEAIZL0
Payee Name:  JOHNSON PEAMMACY INC
Chk Date: 04/24/10
Chi/EFT §: DODS003I4EET
Seqif  RCHTH Hare HECH TN Billed Miowed Dedutible COINS Paid
00001 1AZB2C THOMAS, CHARLES 999995999R LOL2 34 EE7E9000 L8 13 E7E. 29 .00 135,26 S41.02

imiz i3 [0 [N i35, 26 Sdi. 0%
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96



Medicare Remit Easy Print

Working with Reports

Making Sense of the Other Adjustments Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that had
some type of adjustment. Claims that have Late Filing and Interest and remittances that
have Withholding and a Forwarding Balance print on the report.

Other Adjustments Report
Generated: 7/15/2011 12:08:00 PM

Carriex: ARE3 IHSURANCE
Payee #: 1234567890
Payes Wame:  ACME PHYSICIANS INC.
Chk Tate: 04l 22/05
ChE /EFT # 12345
Seqt Hame RENTH# Hron Tow Bdjustment Deseription
00001 Do, Sally 22327 EM11111 119932404007301 2,81 1
00002 Right. Samusl 122227 SJ011111 119922404007501 1.23 1
00003 Do, Sally 7722327 E11111 119932404007301 1.75 1
00004 Do, Sally 22327 EM11111 119932404007301 2,22

Withhelding/Capitation (PLE=E3] : 13.91
Wi thholding/hesel. Pmé (PLE=RE] 2477
Wi thhelding/IRS FLE=IR) : 15.30
Overpayment Recovery (PLE=D) : 13,42
Forvarding Balance (PLE=FE) : 33.33
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How to Print the Denied Service Lines Report
3. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

2N

icon.

The Medicare Remit Easy Print Claim List tab opens.

i e are Remit EssyPrint v2.A0
e Teh wew Bepot Sesch Jook peh
Wincert || [P orecot pe || B ecive | [ Restern W ookt | O Sach

Payee N | Papen [pwmen [ clmckbote [ ctmh®FT . [ w7 | Cliem | B ¥FT brnbme I
AREABGLURANE  ACME ™. 1235678 s 423,60 EFT 1295 COADICOIIIAL  AREA INSLRAN.
| i Detad | Fiem Summary | Tt View Sncech | ossory |

bame. I ACNT [ i pad Amoure | From Date To Dare ==
Dlie, ssiy e UFFR A0 mm 010 A0S A

Doee, ssty TN NIFFHHONT0] 56.72 £ T T Ao

Doce, ssly crai) VTR EHONTI .50 LIy Af7fzors A3

Dleughe, Samed PR A .50 (R afrafas W14f2005

et Sammd i 1N HAO0TE0 .50 (R 2| e[S

[CJoue, Saby b 11993THH00TEO 364 1850 f21/2004 2172004

[lright, Sammd 11T AMONTRA] 97.50 14T IR0 218r008

[Jright, Samui Tz 119 HONTAN T 18477 31E00s Az

[Jooe, saty ety 1172 4HON7A0] 4878 Lz 2N 2005 AR1f2005

[Je, Saby prresin) 115502 404007R01 5774 e 12ME0m B0

Dltee, sy 722897 1IPHI2HH00T0) .80 128 Lf200E b4f2005

Doce, saty TN 1IFHIIHHO0TI0N 2650 (F) E 242005 =
Doee, ssty TR NIFFHHOT0] .50 98 IS Narzos

Doce, ssty e VFTREHINTI .50 L A4z Afafs

Dvee, ssby TREIER MIERHHONTIO . ALY fraos Z19f205

Dove, saby TrEEt 1N HAO0TE0 .77 18020 3jusfzos Hiafaws

[]ove, Saby TTanT 11993THH007EON 26,50 966 4{7f7008 {72005

] oie, sy TNy 15304H007E0N 750 19154 12/15{3004 12/15/2004

[Jright, Samund I FRECHONTAN] s A 1 [0S 00

[lnighe, Samusi ety 11N\ HHON7AO] 26,50 (B 2js 2008 262008

[ ighe, Sarmund e HHO07A01 26.50 [E2-] Aele 2005

[Cliicht, Samuel oot VIR EHOOTE0] 26,50 EE A0S Apf2008

Dltxe, sy 722897 007801 27,50 1477 HISRNE H1sf2005

Dlexe, Saby TN ] w50 WY NS Neayors

Dlese, ssby e 701 5. % E R T A7 =

SR e = rer e VR o LJ'J

L PR Elchecka | [lincheckal D pate \

W70

4, Select Denied Service Lines.
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The Print and Export options appear:

Fin Tsb View Fieot Seach Todh e
Wigot | Prpa « | Mwstve  CRmten  Jowets O sewh Pt Lt

e Achuriearts 0
L il
it | e Dt | | Dot e | o | sy |

Foama. 1 [ T weibocort] Padbmord| veombuts |

Cloee, et i A flom ]

Qeee, sab T wprRE R o LT

Doee, 4y Liee P .2 1288 amaes
e Fr) [
wRRERRREEEY w0620 a7 v
R 1 [
55 T T

5. Select Print.

The Print Options window opens.

Print denied line report |

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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5. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.
The Print dialog opens, for example:
Print 2| x|

— Printer
Properties. .. |

Mame: \woapprushTCG

Status: Ready
Type: HF Lagzerlet 4200 PS5
“Where:  TC-E-020

Comment: ™ Print to file

— Print range Copies

& Al Muriber of copies: |1 3:
I I I

Fages o for @  Calate
) Selection

! 0K I Cancel |

If you need to chan € properties, click Properties and make changes as

necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.

The Print Preview window opens.

I TTLI I

Click the printer button = at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Export the Denied Service Lines Report

You export the report in .csv (comma separated values) format.

6.

8.

Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .

The Medicare Remit Easy Print Claim List tab opens.

BErMedicare Remit LasyPrint w240

Wingort || P aepert < || Boarchie | B Rostore | K oeletn | Q) snaech o Pt Lt

Payper blamn |l’~w& | Payne iy | chedibae | ChockfEFT ... | ChocklFFT ... | Clums | CheckieFT Number | Version | Flename ]

BAEATNSLRANCE  ACME A0 TN 12345678 042305 42316 EFT 1 12345 OMOICKAIAL  AREA TNSURAN. .
Clian Lk | Clam | e Summary | Deka e | Search | dossary |

Hame T | 1N [ Eledfowunt]|  PadAmowi | FromDate | TaDale [ -

O o, Saby TraEEAT 1IEMDA007801 23083 010 4j32005 432005

[ 199ETMD07R01 5577 WOE IIET00S N

[ 119332404007801 2650 9.66 4/7/2005 472005

O rsght, Sanmel TIFEAA0TI0L ] W4T s WAt

[0 right, Samued 1IEMOO07801 750 18077 3fj2008 008

[ IFEEMDOTEN 3264 1890 AfyE00 12100

IRt sl 119932404007801 97.50 184.77 (182005 ZiLE2005

O rsght, Sanmel TIFEAA0TI0L ] AT s EQEL

Do, sy TraES 1IEMOO07801 4878 322 31008 31008

oo, sy TrEEET 1IFEO07EN] 5774 .35 1242004 1242004

[ Traar 119332404007801 2650 12.89 1/4/2005 174{2005

Do, saiy T 1AL ] 12 240 2hafeors =

oo, sy TraEET 1IEMO07E01 e 964 342005 e

Do, by TrIEET 1IEMAO07E01 e 964 Aj4 2005 Aff00

[ Traar 119332404007801 90.80 45.69 2{19/2005 Zj19{2005

Do, saiy T 1AL T 16020 oS WS

[m[R TTEEAAT 1I9AEMIM0TAN 2650 AEA A7f2005 Aiens

Oooe, sy TraEET 1IEMO07E01 750 19154 12{15[004 121502004

IRt sl Traar 19932404007801 .4 3.8 11672005 162005

D rsghe, Samosl T AL ] 12 L EEL

O right, Samuel TTENT 1INEO007801 %50 1289 30Ef2005 Helz00s

[0 right, Samued TraEET 13NDO07801 e 964 4jEf2005 Afefo0s

[ Traar 04007801 97.50 184.77 3(15/2005 11512005

Oooe, Saby TrEE FEECER T ] W4T s EraEl]

Oooe, sy T TN 5 A A REELE =

L Pt Edcheckdl | [Junchechal | foes \

\ aji7[e008

Click the down arrow on the Report button.
The Report List appears.
Select Denied Service Lines.

The Print and Export options appear:

[
T Ta ves e bean fmd ook

|
Select Export.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

5. Enter the file name.
6. Click the Save button.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Print the Adjusted Service Lines Report

9. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .

The Medicare Remit Easy Print Claim List tab opens.

B e e Rl EarsyPris w240

o Toh few [eport Search ok ek
Wingert || Pt oo | Baecwm | [iestorn | Deketn | O Sewen || e

|

i [\ _awt I 10 [ eded [ it Fromoms | tobse | ase | -
v, Saby bpeee 11932404001 FET] 010 4nps 4 v

Do, =y Tr223%7 1952404007801 .2 38,06 1612005 1672008 ¥

Doce, saby i VIS0 .50 L 471200 A1 ¥

[ m [ ] 11HEOAOTROL WrE 1877 AR 14200 ¥

DIk, Samael LISHI240807008 ) W77 RS Y00 ¥

Do, saby LIPEIIA0M00TB0L k-2 3 18,90 621 f2004 B/21/2004 ¥

Drsgre, Somuel e 115532408007 801 wrsn 18477 2182006 2/18[2006 ¥

Drigre, samesl rezan L1480 00 s 177 Ao AfLufrs ¥

[ [N TN 119RT40A00R0 ARTR nne W2H0R Y2006 W

Deee, sobr man 1195032404007 801 5. x¥ 12004 1214[2004 ¥

Dloee, sty Trazan IFEIMOSOTI0E .50 (FY] 14f2e 1j8j20irs ¥

DO, say I 119930A00TEOL 2650 2.8 S 2afn0s ¥

Do, Sty bt LIFHIZH0M0T00L .50 9.4 £ Ajz0s ¥ b |
Dlooe, saby Frazyst ST w0 0,60 42005 ajafs ¥

Dree, sy TR 19924040070 060 4569 20192006 2192005 ¥

Do, sty T 1S40 oy 160.20 RULIE S rufaoms ¥

[ m [N T 1199T40A007ROY 80 0.6 4T[0 472005 ¥

Do, sty T LIFHI0M00780 w150 1915 1200 V215200 ¥

Dlrsgt, sammanl Trmm 1FEAOHITI0N M E bt 1if00s L

DOnsg, Samel T INWIEMOADOTROY .50 1289 2J6f2005 2Jhf00s ¥

Drighs, Samel b LINGIZH0H00T00 .50 1209 ojz0s T ¥

Drse, Samel o N4 900TE01 % .68 6[2005 4bfnes ¥

Do, saty RN 1155RICA0TEOY w7 1T ISR LS00 ¥

[ m [ TR i s WATT A A [

[ [N TR b 5.3 7.8 A[7[2008 A[7{3005 ¥

[m [ Tz w01 220 1280 3197008 L2005 ¥ #
o K Flcheckal | [luncheckAl ™ pats

Segnt Court > \ EET

2. Click the down arrow on the Report button.
The Report List appears.

a5

]

F o — ¥

[m ererErEvereves EE 1280 ¥
[ [ ] ¥
Dt 1ah ‘rerereverereres o2 sy ¥
Civos, 2y ettty ¥
= [ e wm o ¥

Pt Elcwk  Clucheddl O pes

10. Select Adjusted Service Lines.\

The Print and Export options appear:
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Sedbnont|  Padimcrs|  fembats | Tngute

w0 PSRRI -0 -5y

Do, sab vreressERTEE, wins o

Dloee, 5o ERRRRRRRE, By 125

Dloee, se T gyl 199.%

Dlcee, Saby rrrERSTREETERY Wi 2,

Dlowe, sah R idessicccdd 18 =

[ [ SRR wm

;!m £y [Tt

11. Select Print. The Print Options window appears.

Print remit listing x|

5. Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.
The Print dialog opens, for example:

print 21
r— Printer
Properties. .. |

Mame; Yhpapyrush TCG

Status: Ready
Type: HF Lazerlet 4200 FS
Where:  TC-E-020

Comment: ™ Prirk ta file
— Print range Copies
@ a Murnber of copies: |1 3:
 Pages from:l to:l
E : ¥ Callate
| £ Selection
! oK I Cancel |

If you need to change the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. Click Preview to view a preview of the printed page before printing.
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The Print Preview window opens.

Click printer button & atthe top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Adjusted Service Lines Report

12. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .

The Medicare Remit Easy Print Claim List tab opens.

B Heslin e Bl Fasylirind w240

De T8 Yew Bepot sewch look beb
Winoeet || Pt = Bdchin [ Restern M odete O Soach

o Lint | e Detad | Dt Verns 1 semch | sty I
e T\ __aow I [ [ deddmerd | Posliwart] Froem Datn [ To Dikn | |
Dltoe, Ssky TN 10040070 uzer X 1672004 14004
toe, Saly Tz 1HECOTEN] nzer = 04277200 U]
D, sl ez NGRIRAH0T000 s R 00 Lojfzuot
Dltoe, sady 1LFEAHOTE0L =04 »¥ 1242004 LEf4fz004
Dt Saby 1LFAHOOTEN 7.5 1 12{A52004 LEAISEH
DCloce, Sy NIRRT .50 1209 LA 14f0s
Dlawte, samel 1LSHI404007801 2N N 1jefe00s 1J6f2005
Ctoe, Saly e 1PEM00TEN] EITE ) ma LIS 10
Dlauge, sarmad 2, AIHH0TI0N .50 o sfatas Wzt
Dltwe, Sabr e 1LFHI00TO01 ] i S0 13005
DOlvoe, saly T WEM00TEN] .80 1289 2HpE0E 2[4f208
Dleite, samsl gl AT .50 2 it 200G
Dhegts, Sameld T FIHHOT0L W Ll Hhajznes a1eroos
Ctoe, Saly Tz 11MEMCOTEN] 14z 8 23z 140
Dleucte, saruel nar AFHRHHOOTI e T 1o 1
Dltoe, 3oy e 1LFHIAH00T00) 0,60 Lt sl 19005
DCltoe, Saly Ty 11PEHHoOTEN] ®m o 21942005 210
Dlos, saby o2 id LFERAHETL 1.4 -1 Flrele ez
Dltwe. sy e 11334007301 %80 kL H4iz008 3005
Rt Samued eI PPIMMO0TE 2650 128 HELO0E 005
Dloes, say Tz TR0 ELE 1 N Ifao
Dleigh, Samel Ty 1INFIMH00TE0 w180 00 Huarao0e A1f008
Do, Saly bpces =iy 1NEtAcOTED] 9.6 o 3132008 EEE
Dlruste, sanmel vezan 7003 .50 V7T Haafans AL
Cltos, Sabv rpes il 7808 s (ke HIsl008 I5R00s i
Samce e s foseizemy e e e Gy Ll_l
s P omd il [Judhed sl O Oats \
Segnert count >3855 \ Sa7jzo0m

2. Click the down arrow on the Report button.

The Report List appears.

88 8t o et E iyt »2.4

e | o [+ Atatne |t Koowr | Qi

T At Senvce Lines

Vb, B
o it
]
Clow, e ]
Dltee, S nnu B hiisisiied noso W v
Olitee, Saie 111111 sl bl 125 [
Elto, 22, ni s v
Eias, 3o i wonrsssssorerrs wm B4 v
DOlitee, S8 mae R, Lo ez v
Doe, sats T v, < am
e 0 Dot Dudedd B ods
Sopart card 2200 =]

13. Select Adjusted Service Lines.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Print and Export options appear:

o int

i
mun
mun
mnn
T

Prereval]
SEEEER

. Closms  Owceas

Secret ourt 33306

14. Select Export.

The Export folder window opens.

Choose folder for export

Save in: I 3 ReportE spart

[ O s o =

File name: ||

Save as type: I

[
=

Save I
Cancel /L

5. Enter the file name.
6. Click the Save button.
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How to Print the Deductible Service Lines Report
15. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon.

The Medicare Remit Easy Print Claim List tab opens.

B Mk e Rt ErnyPried w740

i \ HL I 10 [ et [ o st | From bate I Tobwe | =]
[m I 119937404007 ROY 123 ™Y B/ LA{I004 BI1ATI004

Dloes, saby Tra 1532408007801 ez %33 102712004 10/27 2004
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2. Click the down arrow on the Report button.
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16. Select Deductible/COINS Service Lines.\
The Deductive/COINS Service Lines report options appear.
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17.

18.

Select Deductible Lines:
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Select Print. The Print Options window appears.
Prexvigw LCancel

Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.
The Print dialog opens, for example:
Print 21 x|

— Printer
Properties. .. |

Mame: \woapprush TCG

Status: Ready
Type: HP Lazerlet 4200 PS5
where:  TC-B-020

Comment: I~ Printto fils
— Frint rahge Copies
= Al Mumber of copies: |1 3:
" Pages [rom:l Lo:l
!! ¥ | Callate
| £ Selection
! oK I Cancel |

If you need to change the properties, click Properties and make changes as

necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. Click Preview to view a preview of the printed page before printing.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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The Print Preview window opens.

10 ODBEE [cow | poe

Click printer button & at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Export the Deductible Service Lines Report

19. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.
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20. Select Deductible/COINS Service Lines.\
The Deductible/COIN Service Lines report options appear.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

21. Select Deductible Lines:

22.

Select Export.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

Enter the file name.
Click the Save button.
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How to Print the Coinsurance Service Lines Report

23. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.

The Report List appears.
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24. Select Deductible/COINS Service Lines.
The Deductible/COINS Service Lines report options appear.
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25. Select Coinsurance Lines:

26. Select Print. The Print Options window appears.
Prexvigw LCancel

6. Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.
The Print dialog opens.

print 21
r— Printer
Mame; \oapyrush TCG Properties. .. |
Status: Ready
Type: HF Lazerlet 4200 FS
Where:  TC-E-020
Comment: ™ Prirk ta file
— Print range Copies
@ a Murnber of copies: |1 3:
€ Pages  fom: I b I
E : ¥ Callate
£ Selection

! l oK I Cancel |

If you need to chan e properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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The Print Preview window opens.

10 ODBEE [cow | poe

Click printer button & at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Coinsurance Service Lines Report

27. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.
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28. Select Deductible/COINS Service Lines.
The Deductible/COIN report options appear.
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29. Select Coinsurance Lines:

8 i

e [EESRERT RCE

Seguert st 208 7

30. Select Export.

The Export folder window opens.

Choose folder for export d |
Save jn: Ia FieportE sport j = |‘j‘ Ea-

Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

File name: || j Save

Save as type: I j Cancel

i

6. Enter the file name.
7. Click the Save button.
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How to Print the Deductible/Coinsurance Service Lines Report

31. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.

The Report List appears.
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32. Select Deductible/COINS Service Lines.
The Deductible/COIN report options appear.
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33. Select Deductible & Coinsurance Lines:

| tem ] e |
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34. Select Print. The Print Options window appears.
Previgw LCancel

6. Print the detail listing in one of the following ways:

=

A. Click Print to print the detail without previewing it.
The Print dialog opens, for example:
Prnt 2| x|

— Printer
Mame: Broperties. .. |
Status: Ready

Type: HF Lagzerlet 4200 PS5
“Where:  TC-E-020

Comment: ™ Print to file
— Print range Copies
& Al Muriber of copies: |1 3:

" Pages [rom:l ;.;,;l_
 Selection @ ¥ | Collate

! 0K I Cancel |

If you need to chan e properties, click Properties and make changes as

necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. Click Preview to view a preview of the printed page before printing.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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The Print Preview window opens.

10 ODBEE [cow | poe

Click printer button & at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Deductible/Coinsurance Service Lines
Report

35. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.
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36. Select Deductible/COINS Service Line.\
The Deductible/COINS report options appear.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

37. Select the Deductible & Coinsurance Lines:

38.

Select Export.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

Enter the file name.
Click the Save button.
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How to Print the COB Claims Report

39. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.

The Report List appears.
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40. Select COB/Non-COB Claims. Select COB Claims.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

123



Medicare Remit Easy Print

Working with Reports

The Print and Export options appear:
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41. Select Print.

The Print Options window opens.

Print denied line repork

LCancel
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5. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.
The Print dialog opens.

pint 21|

— Printer
Properties. .. |

Mame: \woapprushTCG

Status: Ready

Type: HF Lagzerlet 4200 PS5
“Where:  TC-E-020

Comment:

I Frint ta file
— Print range Copies
& Al Murnber of copies: |1 3:
" Fages [rom:l ;o:l
!E ¥ Callate
) Selection
! QK. I Cancel |

If you need to change the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.
The Print Preview window opens.
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Click printer button & at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Export the COB Claims Report
You export the report in .csv (comma separated values) format.

42. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon .

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.

43. Select COB/Non-COB Claims. Select COB Claims.
The Print and Export options appear.
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44. Select Export.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

5. Enter the file name.
6. Click the Save button.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Print the Non-COB Claims Report

45. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.
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46. Select COB/Non-COB Claims. Select Non-COB Claims.

The Print and Export options appear:
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47. Select Print.

The Print Options window opens.

Print denied line report |
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5. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.
The Print dialog opens, for example:
Print 2| x|

— Printer
Properties. .. |

Mame: \woapprushTCG

Status: Ready

Type: HF Lagzerlet 4200 PS5
“Where:  TC-E-020

Comment:

I Frint ta file
— Print range Copies
& Al Murnber of copies: |1 3:
" Fages [rom:l ;o:l
!E ¥ Callate
) Selection
! QK. I Cancel |

If you need to change the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.
The Print Preview window opens.
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Click printer button & at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

130



Medicare Remit Easy Print
Working with Reports

How to Export the Non-COB Claims Report
You export the report in .csv (comma separated values) format.

48. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.

49. Select COB/Non-COB Claims. Select Non-COB Claims.
The Print and Export options appear.
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50. Select Export.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

5. Enter the file name.
6. Click the Save button.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Print the MSP Claims Report

51. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.

The Report List appears.
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52. Select MSP/Non-MSP Claims. Select MSP Claims.
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The Print and Export options appear.
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53. Select Print.

The Print Options window opens.

Print denied line repork

LCancel
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5. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.
The Print dialog opens.

pint 21|

— Printer
Properties. .. |

Mame: \woapprushTCG

Status: Ready

Type: HF Lagzerlet 4200 PS5
“Where:  TC-E-020

Comment:

I Frint ta file
— Print range Copies
& Al Murnber of copies: |1 3:
" Fages [rom:l ;o:l
!E ¥ Callate
) Selection
! QK. I Cancel |

If you need to change the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.
The Print Preview window opens.
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Click printer button & at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the MSP Claims Report
You export the report in .csv (comma separated values) format.

54. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.

55. Select MSP/Non-MSP Claims. Select MSP Claims.
The Print and Export options appear.
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56. Select Export.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

5. Enter the file name.
6. Click the Save button.
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How to Print the Non-MSP Claims Report

57. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.
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2. Click the down arrow on the Report button.
The Report List appears.
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58. Select MSP/Non-MSP Claims. Select Non-MSP Claims.
The Print and Export options appear.
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59. Select Print.
The Print Options window opens.

Print denied line reporkt

LCancel
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5. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.
The Print dialog opens, for example:
Print 2| x|

— Printer
Properties. .. |

Mame: \woapprushTCG

Status: Ready

Type: HF Lagzerlet 4200 PS5
“Where:  TC-E-020

Comment:

I Frint ta file
— Print range Copies
& Al Murnber of copies: |1 3:
" Fages [rom:l ;o:l
!E ¥ Callate
) Selection
! QK. I Cancel |

If you need to change the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.
The Print Preview window opens.
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Click printer button & at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Non-MSP Claims Report
You export the report in .csv (comma separated values) format.

60. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.

Gamist | comos\ | messwewy | owavew | sewn | Gomey |

Hawne [\ aow I N | ededamere]  roscsmeurs | From Date | ToDate |
Dloes, Saby el LA uzar £t GLEI2000 LA
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D, Serrast rzoa 1199340M0TRY M 2007 L] 10287000

Do, Sty b ek L15332404007001 ST w35 Lef4jz0oe 12lafa00n

Do, Sady 119RIMOMCTRY om0 191.54 12/152004 12/157004

Dloce, saby ™. LIFHI0M007801 80 1269 V{2005 I

Dlrsgt, sl T ISRAOSTI0N S .0 = e

Doe, saty ey 11FIT0ADOTEON a7 = 1/9/2005 1afaoes

Drighs, Samel =i LIFR2404007001 WS 0.00 Hiafzo0s e

Dlooe, sty TrIESR IR0 nw m 1uefenos 119fs

Dloee, sat¢ T LISHA20M0TE0L x50 1289 2412005 2jaja0e

Dlrsgre, el T LIFEA0STION 2650 124m EE o0

Dt sorrard TRy 117Ia0AETRY Et) 0.0 2f12fa008 212pE00s.

Dltee, 5oty Iy LIFHIZH0M0T000 43142 EeT) 252005 14[2005

Dles, sl T IVERAOMTEOR s 184,77 L8RS 2j18/2005

Do, 59 T LIFHIH0M0TE0N 20,80 4559 21172005 271972005

Dlocs, sy TR VIO £ i Pt 2J19fs

[N TRz 11993240M00TRY 5T .86 2fz2panes 222005

Dlooe, Sty T | FHIZH0R00T001 %5 964 AM4G2005 ANz00%

DIkt samael Trass AT .50 120 atas Hntzs

D, saty T 112408070} W 17808 AN Irz00s

Dlrsgte, sl TR L1ENGHOSTI0L EE) .00 Az A12f

Dree, saty TRz oAETEDY o 107 R 137005

DIk, Samael e 001 W15 10477 af1aj2005 WIS

Dloes, saby frazyst R T s 18477 38} A18[0005 =
o POE Efcheckm | [luncheckal | B pwa \\

gt court 34155 \ W10

2. Click the down arrow on the Report button.

The Report List appears.
61. Select MSP/Non-MSP Claims. Select Non-MSP Claims.
The Print and Export options appear.

uuuuul..LlTr

[EEEd |
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62. Select Export.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

5. Enter the file name.
6. Click the Save button.
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How to Print the Other Adjustments Report

63. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon.

The Medicare Remit Easy Print Claim List tab opens.

B e e Rl EarsyPris w240

o Toh Yow Deport Search Tooh Help :
Winport | Pormout g0 Biecws | [ Restore | Wodkets | T Seweh | | Preeie

Clam st | comosst\ | ek | vataview | sean | Gomary |
Faene: [\ son I N I esedamoore | oo somcure | From Date | ToDate | -
[m[CE e H19632404000001 uzar ] 62004 AR
Dloes, saby 7T LISRIHOHITI00 nzar %3 UTEee ] 1027
Dngpt, S friiil 119930A00TEOL .4 2007 10j2A/200 10RO
Dloee, sty LISRI240807000 5.4 %35 1242004 12f8f2
D, ey 11SRIOADOTRO L s 19154 12{15/2004 127157004
Do, sty L155a2404007801 ®E80 1269 114}2005 14j2005
Drighe, sammsl e, MIPFRMHTI0L e e 1ol e,
DOres, sy T 11IEMOANOTROL AT = 1192005 12008
Drighs, Samel =i LIS3I2408007001 B 0.00 Hiafzo0s s
Dlooe, sty TrIESR IR0 nw m 1uefenos 119fs
Dloee, sat¢ T LISHA20M0TE0L x50 1289 2412005 2jaja0e
Dlrsgre, el T LIFEA0STION 2650 120w EE o0
DOnsgpt, S IR 119HEMOADOTROY WrE om0 212005 2f12fE.
Dloee, 5oty TN LIFHIZH0M0T000 43142 EeT) 252005 14[2005
Dles, sl T LIPHAOMTEON s 184,77 FITE L18f2S
Do, sty Iy 1195324040070 1 9080 5,69 22005 21972005
Dloes, ssby T IFEIHOHTI0N £ . 2fvefoes 19f2006
Dres, saly I 119340A007R0 L ST .86 Hlele 2fz2r0s
Dlooe, Sty T | FHI404007001 %5 964 AMiE005 A0
DIkt samael Trass AT .50 120 ataes Hntzs
Dloes, say TN 11INGZH0M0TRO L T 178.05 ArH2005 A5
Dlrsgte, sl TR HOTTU0L EE) 0.0 Az anzfans
Do, sy biros- i) OADITRL "o &r.07 LR 31372008
Dright, samel TN 001 w1 104,77 Arajzn0s A0
Do, saby Frasst L EiiE) .77 Bt Y e ¥
o POE Efcheckm | [luncheckal | B pwa \
Segment counk >S5 \ W17l

2. Click the down arrow on the Report button.
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64. Select Other Adjustments.
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PrTTTe RN

EEERELE

65. Select Print.
The Print Options window opens.

Print denied line report |

5. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.
The Print dialog opens.
print 21 x|

— Printer
Mame: \woapprushTCG Broperties. .. |
Status: Ready

Type: HF Lagzerlet 4200 PS5
“Where:  TC-E-020

Comment: ™ Print to file
— Print range Copies
& Al Muriber of copies: |1 3:
" Fages [rom:l ;o:l
!I [V Callate
| ) Selection
1 ,TI Cancel |

If you need to change the properties, click Properties and make changes as
necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
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B. Click Preview to view a preview of the printed page before printing.

The Print Preview window opens.

_ioix
-IEIUEIBI [ =]

Click printer button & at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.
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How to Export the Other Adjustments Report
You export the report in .csv (comma separated values) format.
66. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon.

The Medicare Remit Easy Print Claim List tab opens.

B e e Rl ForsyPrie 3.
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2. Click the down arrow on the Report button.

The Report List appears.
67. Select Other Adjustments.
The Print and Export options appear.

|
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68. Select Export.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export g |
Save jn; I 3 RepartE spart j = % ER-
File name: || j Save I
Save as type: I ﬂ Cancel |
%

5. Enter the file name.
6. Click the Save button.
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How to Print the Entire Remittance Report

69. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print
icon.

The Medicare Remit Easy Print Claim List tab opens.

B e e Rl EarsyPris w240

o Toh Yow Deport Search Tooh Help :
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Dt sorrard TRy 117Ia0AETRY Et) 0.0 2f12fa008 212pE00s.
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2. Click the down arrow on the Report button.
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70. Select Entire Remittance.
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The Print Options window appears.

4. Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.
The Print dialog opens.

Prne 21 x|

r— Printer
Properties. .. |

Mame; Yhpapyrush TCG

Status: Ready
Type: HF Lazerlet 4200 FS
Where:  TC-E-020

Comment: ™ Prirk ta file

— Print range Copies

Nurnber of copies: |1 3:

 Pages [rom:l go:l B ol
allate
£ Selection ﬂ Iﬁ

i oK I Cancel |

Al

If you need to change the properties, click Properties and make changes as

necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.
B. Click Preview to view a preview of the printed page before printing.

The Print Preview window opens.

_iix
§D'|E.BE| Page I 1:1

Click printer button & atthe top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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Housekeeping for the Import files

Housekeeping includes:
* Archiving files
» Restoring files
* Deleting files

Archiving Import files

Medicare Remit Easy Print does NOT automatically archive any Import file, and Import
files can slow down the processing time of the PC.

Therefore, Medicare Remit Easy Print lets you archive Import files. The location you
choose for the archive must have adequate security to protect PHI.

How to Archive Import files
71. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon m

The Medicare Remit Easy Print Claim List tab opens.
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2. On the top of the window, select the file that you want to archive and click the
Archive button.
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The Archive Imported Files window opens.

E Archive Imported Files =] E3
Pathname for Fal -AProgram Files\Medicare Remit EasyPrintsarchivel | Erowse |
the Archive Paver Mame | Payes Mame | Date | Check/EFT ... | Check/EFT ... | Claims | = [ iEheck &
folder CIAREA TNSUR... | ACME PHYSICIANS TNC. 04/22/05 4231.69 | EFT 51
I AREA TNSUR... | ACME PHYSICIANS INC. 04j22{05 2835.60 | EFT 34
Lo CIAREA TNSUR... | ACME PHYSICIANS INC, 04j22/05 2603.06 | EFT 34
Hint: I AREA TNSUR... | ACME PHYSICIANS INC. 04j22{05 934,67 | EFT 17 |
You can use CIAREA TNSUR... | ACME PHYSICIANS TNC. 04j22{05 703,86 | EFT 15
the Browse I AREA INSUR... | ACME PHYSICIANS TNC, 04j22{05 1302.43 | EFT 22
I AREA TNSUR... | ACME PHYSICIANS INC. 04j22{05 695,01 | EFT 3
button to D aREA INSUR.... | ACME PHYSICIANS INC. 04/22/05 763.28 | EFT 7
specify another I AREA TNSUR... | ACME PHYSICIANS INC. 04j22{05 1483.68 | EFT 15
: CIAREA TNSUR... | ACME PHYSICIANS TNC. 04j22{05 1382.08 | EFT 19
Iocat.lon fqr the I AREA TNSUR... | ACME PHYSICIANS INC. 04j22{05 1649.44 | EFT 12 2
arChlved flle- '1 ARFA TMSLIR. .. | ACPE PHY ST TARMS TR, N4 172 Mns 277 FFT 19 o
A
File count :23 4
Hint: . .
You can use 72. Select the file(s) you want to archive by ¢ Ing the box(es).
”r‘]e i*;)ethA” This activates the Archive button,
checknox to
select all the 73. Click the Archive button.
claims.

Medicare Remit Easy Print moves the file to the Archive folder.

Restoring Import files
You can restore an Import file after you have archived it.
For information about archiving Import files, see page 149.

How to Restore Import files
74. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon m

The Medicare Remit Easy Print Claim List tab opens.

Wi rtedicare Renat CasyPrint vz.40

Bl Toh Yew Feport Jearch fock tieh
Wiecot | Pt - A Bestwe | M Ookle | C Seerch | mrkis

Fapes R Vayen e, R ChodJEFT - | CheckEFT ., | Gl | CheckjEFT husmbes veraon Henas 1
EFE L THELEANCE | ACHE PHISICUSE T LZHEETS AT 423169 [EFT &) LEHE GOAOIEIRAL | AR TN

GIES IUELE,

| Eham brtd
I |
1o
1199340400760
A7
w157 -
e af
check 2 [JunChecksd B Data \
Segrent cart > 055 ifens

2. On the top of the window, click the Restore button.
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The Restore Imported Files window opens.

Restore Imported Files =] E
Pathname for Folder - [C:\Program Files\Medicare Remit EaspPrintArchive’ | Browse |
the Archive | e | check/EFT Amount | CheckieFT Tvpe | " Check Al
folder O ICIANS TN, 05 4231,69 | EFT
D ARES IMNSLR. ACME PHYSICIAMNS INC, 04/22f05 2835.60 | EFT
D AREA IMSUR... | ACME PHYSICIAMNS INC, 0422105 2603.06 | EFT
D AREA IMSUR... | ACME PHYSICIAMNS INC, 04/22f05 934.67  EFT
H | nt: D AREA IMSUR... | ACME PHYSICIAMNS INC, 04/22f05 703.86  EFT 15
D AREA IMSUR... | ACME PHYSICIAMNS INC, 04/22f05 1302.43  EFT 22
You can use
the Check All
checkbox to
select all the
claims.
4« | i
E file[s] listed. 4

75. Select the file(s) you want to restore by checking the box(es).
This activates the Restore button.
76. Click the Restore button.

Medicare Remit Easy Print moves the file from the Archive folder to the Import
folder. The file is now available for viewing.
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152



Medicare Remit Easy Print
Housekeeping for the Import files

Deleting Import files
If you delete an Import file by mistake, you must re-import the HIPAA 835 file. You
cannot restore the Import file.

How to Delete a Import file
77. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print

icon. |;

The Medicare Remit Easy Print Claim List tab opens.

B Medicare Remit EasyPrint v2.40 =]
File Tab Wiew Report Search Tools Help

W foport P Repot - B archive | [ Restore elete | Q| Search |EFrlntLlst

Payer Name Filename:

Claim Lisk Claim Detail Remit Summary | Data iew | Search | Glossary |
Hame [ ACHT [ \ [ siled Amount [ Faid Amount | From Date [ To Date [ |
[mE 7722357 119K32404007501 112,27 7533 9j16/z004 9j16/2004
O oo, Sally 7722357 119952404007801 112,27 75,33 10/27/2004 1027/2004
O right, samusl 7722357 119932404007501 3124 2097 10/28/2004 10/28/2004
O, Sally 7722337 11993%404007501 774 %35 1242004 12/4/2004
Oooe, sally 7722357 119932§04007501 397.50 191.54 12/15/2004 12{15/2004
O ooe, Sally 7722357 119932494007801 26,50 12,89 1/4{2005 144/2005
O right, samusl 7722357 1199324)\p007501 57,74 3386 1/sf2005 1f6f2005
O, Sally 7722337 11993240\007501 344,37 22937 1/3f2005 132005
DO right, Samuel 7722357 1199324007501 397.50 0.00 1/12/2005 1/12/2005
Oooe, sally 7722337 119932404007801 35,90 24.09 1/19/2005 1/19/2005
Oooe, sally 7722357 1199324040501 26,50 12,89 2/4{2005 2j4iz005
D right, Samuel 7722337 1199324040001 26,50 1289 2j6i2005 2i6i2005
DO right, Samuel 7722357 1199324040001 397.50 0.00 2j12{2005 2j12{2005
Oooe, sally 7722337 1199324040071 491,42 272,16 2J9j2005 2}14/2005
O right, samusl 7722357 1199324040078\1 397,50 184,77 2i18{2005 2i18{2005
O, Sally 7722337 1993240400750 a0.60 4569 2/19/2005 2/19/2005
Oooe, sally 7722357 11993240400750 35.90 24.09 2}13/2005 2j13/2005
Oooe, sally 7722337 119932404007801 57,74 33,86 2j22/2005 2j22/2005
Oooe, sally 7722357 119932404007501 26,50 966 3/4{2005 3i4iz005
D right, Samuel 7722337 119932404007501 26,50 1289 36iz00s 3i6i2005
Oooe, sally 7722357 119932404007501 34457 178.05 3/9/2005 3j9j2005
O right, samuel 7722337 119932404007801 397,50 0.00 3/12/2005 3/12/2005
Oooe, sally 7722357 119932404007501 99,96 67,07 3i13{2005 3i13{2005
D right, Samuel 7722337 119932404007501 397.50 18477 3i14/2005 3i14/2005
Oooe, sally 7722357 119932404007501 397.50 184.77 3}15/2005 3}15/2005 L
- A Check all [JunCheckal @ Data \
Segment count »>655 9/17/2008

2. On the top of the window, click the Delete button.
The Delete Imported Files window opens.

E Delete selected import file[s] 9 =]
Payer Mame | Payee Name | Date | “heck/EFT Amounk | CheckjEFT Tvpe | Claims | Check/EFT ™ Check Al
[m CME PHYSICIANS TNC. | 04/22j05 £95.01 | EFT i B
D AREA INSUR... | ACME PHYSICIAMS INC. 04/22j05 7B3.28 | EFT
D AREA INSUR... | ACME PHYSICIAMS INC. 04/22 )05 148365  EFT
[ AREA NSUR... | ACME PHYSICIANS INC. 04/22j05 138208  EFT
D AREA INSUR... | ACME PHYSICIAMS INC. 042205 1649.44  EFT
[ 4REA NSUR... | ACME PHYSICIANS INC. 04/2205 279.82  EFT
D AREA TNSLR... | ACME PHYSICTAMS TNC. 0422105 9.66 | EFT
[ 4REA NSUR... | ACME PHYSICIANS INC. 04/2205 74396  EFT
D AREA TNSUR... | ACME PHYSICTAMS INC. 0422(05 1584.10 | EFT
[ 4REA NSUR... | ACME PHYSICIANS INC. 04/2205 280,77  EFT
D AREA INSUR...  ACME PHYSICIAMS INC, 04j22105 2509.60 | EFT
[ 4REA NSUR... | ACME PHYSICIANS INC. 04/22)05 1364.87  EFT
':r ARFA TRISIIR ACIF PHYSTCTARS TRIC N4{221005 1292 97 | FFT I
Oitem selected for deletion. 7

78. Select the file(s) you want to delete by checking the box(es).
This activates the Delete button.

79. Click the Delete button.
Medicare Remit Easy Print deletes the file(s).
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Using Keystroke Shortcuts

You can use a series of keystrokes to complete a number of tasks.

To do this Use this combination
Import a HIPAA 835 file Alt+F+ 1
View a list of claims Alt+V +L
View claim detail Alt+V+D
View totals Alt+V +S
View the way the data is stored in the file Alt+V+V
Search the Remittance Advice Alt+V +E

Or

Alt+S+S
View the CARC and RARC codes for the Alt+V+G
Remittance Advice
Look up the meaning of a CARC/RARC code Alt+T+C
Print the Denied Service Lines Report Alt+R+D+P
Export the Denied Service Lines Report Alt+R+D+E
Print the Adjusted Service Lines Report Alt+R+A+P
Export Adjusted Service Lines Report Alt+R+A+E
Print the Deductible Service Lines Report At+R+E+P
Export the Deductible Service Lines Report At+R+E+E
Print the Entire Remittance Report Alt+R+ R+ P
Archive Import files Alt+T+A
Restore archived Import files Alt+T+R
Delete Import files Alt+T+D

With the Claim List Tab Selected:

Print Claim List At+B+P
Check all claims in the list Alt+B+C
Uncheck all claims in the list Alt+B+ U
Claim display (single line format) Alt+B+D

* Claim must be highlighted

With the Claim Detail Tab Selected:

Print Claim Detail Alt+B+ P
Zoom In Alt+B+ 1
Zoom Out Alt+B+0O
Reset Zoom At+B+R
Show Glossary ( check box ) Alt+B+S
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To do this (continued) Use this combination

With the Remit Summary Tab Selected:

Print Summary Alt+ B+ P
Zoom In Alt+B+ 1
Zoom Out Alt+B+0O
Reset Zoom At+B+R

With the Search Tab Selected:

Print Results Alt+B+P

Results Claim Detail Alt+B+C

With the Glossary Tab Selected :

Zoom In Alt+B+ 1
Zoom Out Alt+B+0O
Reset Zoom At+B+R
Codes Alt+B+C
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Appendix A: MREP RA/HIPAA 835v4010A1 Segment Field
Crosswalk

This information can help you if you need to troubleshoot the Import file.

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
Payer (Contractor) Name 1000A N102 N101 ='PR’
Payer (Contractor) 1000A
Address N301 N101 = ‘PR’, ADDR1
N302 N101 = ‘PR’, ADDR2
Payer (Contractor) City 1000A N401 N101 ='PR’
Payer (Contractor) State 1000A N402 N101 = ‘PR’
Payer (Contractor) Zip 1000A N403 N101 = ‘PR’
Payee (Provider) Name 1000B N102 N101 = ‘PE’
1000B N301 N101 = ‘PE’, ADDR1
Payee (Provider) Address N302 N101 = ‘PE’, ADDR2
Payee (Provider) City 1000B N401 N101 ='PE’
Payee (Provider) State 1000B N402 N101 = ‘PE’
Payee (Provider) Zip 1000B N403 N101 = ‘PE’
PROVIDER # 1000B N104 N101 = ‘PE’ & N103 = ‘XX’
or or
NPI # REFO02 Payee level REFO1 = ‘1C’
Date BPR16
BPRO04 = ‘CHK’ or ‘EFT’ or
CHECK/EFT # TRNO2 ‘NON’
Assigned claims LX01 = ‘1", pertains only to
Medicare
NAME 2100
(Patient Last Name) NM103 NM101 = ‘QC’
NAME 2100
(Patient First Name) NM104 NM101 = ‘QC’/ NM102 =1’
NAME 2100
(Patient Middle Name) NM105 NM101 = ‘QC’'/ NM102 =1’
HIC 2100
(Patient ID) NM109 NM108 = ‘HN’
ACNT 2100
(Patient Account Number) CLPO1
ICN
(Claim Control Number) CLPO7
ASG 2000 Hard-coded ‘Y’ for Medicare
(Claim Assignment) when LX01 =1’
MOA 2100 MOAO03, MOA04,
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
(Claim Level Remark MOAO05, MOAOSG,
Codes) MOAOQ7
REND PROV 2110 REF02 REFO1 = HPI or
(Rendering Provider) REF01 =‘1C’
2100 NM109 or NM108 = ‘XX’ or
REF02 REFO1 = ‘1C’
1000B N104 or N103 = ‘XX’ or

REFO02 or REF01 = ‘XX’

spaces
SERV DATE 2110 DTMO02 Line level DTMO1 = ‘150’ or
(From Service Date) ‘472’ else Claim level DTMO1 =

‘232
SERV DATE 2110 DTMO02 Line level DTMO1 = ‘151" or
(To Service Date) ‘472’ else Claim level DTMO1 =
‘233

POS 2110
(Place of Service) REF02 REFO1 = ‘LU’
NOS 2110 SVCO05
(Number of Services)
PROC 2110 SVCO01-2 SVCO01-1 = ‘HC’ or ‘N4’

(Procedure code — paid
and if down-coded then
down-code procedure

appears.)

MODS 2110 SVCO01-3, SVCO01-4, SVCO01-1 ='HC’ or ‘N4’

(Procedure Code SVCO01-5, SVCO01-6

Modifiers)

BILLED 2110

(Billed Amount) SVC02

ALLOWED 2110

(Allowed Amount) AMTO02 AMTO1 = ‘B6’

DEDUCT 2110 CASO03 or CASO06 or CASO1 = ‘PR’ & (CAS02 =1’

(Deductible Amount) CASQ9 or CAS12 or or CAS05 =1’ or CAS08 = ‘1’
CAS15 or CAS18 or CAS11 ='1" or CAS14 =1’

or CAS17 ='1)

COINS 2110 CASO03 or CASO06 or CASO01 = ‘PR’ & (CAS02 = ‘2’

(Coinsurance Amount) CASQ9 or CAS12 or or CASO05 = ‘2" or CAS08 = 2’
CAS15 or CAS18 or CAS11 ='2' or CAS14 =2

or CAS17 ='2))

GRP/RC-AMT 2110 CAS01-CASO02, Do not print CAS01 = ‘PR’ and

(Group/Reason Code) CASO05, CASO08, ((CAS02 =1’ or ‘2") or (CAS05
CAS11, CAS14, =‘1"or ‘2") or (CAS08 ‘1’ or ‘2"
CAS17 or (CAS11="1"or‘2") or

(CAS14 ='1" or '2") or (CAS17
‘1’ or ‘2')); hard-code dash
between group code and
reason code
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
GRP/RC-AMT 2110 CASO03 or CASO06 or Do not print CAS01 = ‘PR’ and
(Reason Code Amount) CASO09 or CAS12 or ((CAS02 =1’ or ‘2) or (CAS05

CAS15 or CAS18 ='1"or ‘2") or (CASO08 ‘1’ or ‘2’)
or (CAS11="1"or ‘2" or
(CAS14 ='1"or '2") or (CAS17
‘1" or ‘27))
PROV PD 2110
(Provider Paid Amount) SVCO03
SUBNOS : 2110 SvVCo7 If paid units of service (SVCO05)
(Submitted Number of do not equal submitted units of
Services) service
Submitted procedure code | 2110 SVC06-2, SVC06-3, Value appears in parentheses
SVCO06-4, SVCO06-5,
SVCO06-6
REM: 2110
(Line Level Remark
Codes) LQO02 LQO1 = ‘HE’
PT RESP 2100
(Patient Responsibility) CLPO5
CLAIM TOTAL 2100
(Billed Amount) CLPO3
CLAIM TOTAL Sum of all lines AMTO02, when
(Allowed Amount) AMTO1 = ‘B6’
CLAIM TOTAL Sum of all lines CAS monetary
(Deductible Amount) amounts, when CASO1 = ‘PR’
and the corresponding
adjustment reason code equals
“q
CLAIM TOTAL Sum of all lines CAS monetary
(Coinsurance Amount) amounts, when CASO1 = ‘PR’
and the corresponding
adjustment reason code equals
o
CLAIM TOTAL Sum of all lines CAS monetary
(Reason Code Amounts) amounts, except those
associated with adjustment
reason codes ‘1’ and ‘2’ (Group
code PR)
CLAIM TOTAL 2100 CLPO4
(Provider Paid Amount)
ADJ TO TOTALS: PREV Not available
PD
(Adjustment to Totals:
Previous Paid Amount)
ADJ TO TOTALS: 2100
INTEREST
(Adjustment to Totals:
Interest Amount) AMTO2 Claim level AMTO1 ='I
ADJ TO TOTALS: LATE 2110 Sum of all line level AMTO02,
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
FILINE CHARGE when AMTO1 = ‘KH’
(Adjustment to Totals: Late
Filing Charge)

NET Sum of all the line level
provider paid amts plus adj to
totals: interest minus adj to
totals: late filing charge

CLAIM INFORMATION 2100 NM103 (Carrier NM101 = ‘TT' or NM102 =2’

FORWARDED TO: name)

TOTALS: # OF CLAIMS Number of CLP segments
within a LX

TOTALS: BILLED AMT

(Total — Billed Amount) Sum of CLPO3

TOTALS: ALLOWED AMT Sum of AMT02 when AMTO1 =

(Total — Allowed Amount) ‘B6’

TOTALS: DEDUCT AMT Sum of CAS monetary amts,

(Total — Deductible when CASO1 = ‘PR’ and the

Amount) corresponding adjustment
reason code equals ‘1’

TOTALS: COINS AMT Sum of CAS monetary amts,

(Total — Coinsurance when CASO1 = ‘PR’ and the

Amount) corresponding adjustment
reason code equals ‘2’

TOTALS: RC-AMT Sum of CAS monetary

(Total — Reason Code amounts, excepting those

Amount) associated with adjustment
reason codes ‘1’ and ‘2’

TOTALS: PROV PD AMT

(Total — Provider Paid

Amount) Sum of CLP04
Sum of AMT02 when AMTO1 =
‘B6’ and ‘KH’

TOTALS: PROV ADJ AMT (The sum of the details

(Total — Provider (amount) in the PROVIDER

Adjustment Amount) ADJ DETAILS section.)

CHECK AMT

(Check Amount) BPR02

Provider Adjustment Details

PLB REASON CODE

PLBO03-1, PLB05-1,
PLBO7-1, PLB09-1,
PLB11-1, PLB13-1

FCN/OTHER IDENTIFIER

Positions 3 — 19 of
PLB03-2, PLB05-2,
PLB07-2, PLB09-2,
PLB11-2, PLB13-2

HIC

Positions 20 — 30 of
PLB03-2, PLB05-2,
PLB07-2, PLB09-2,
PLB11-2, PLB13-2
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
PLBO04, PLBO6,
PLBO08, PLB10,
AMOUNT PLB12, PLB14
LX01 = ‘0, pertains only to
Summary of non-assigned claims Medicare
NAME 2100
(Patient Last Name) NM103 NM101 =‘QC’
NAME 2100
(Patient First Name) NM104 NM101 = ‘QC’'/ NM102 =1’
NAME 2100
(Patient Middle Name) NM105 NM101 = ‘QC’ / NM102 =1’
HIC 2100
(Patient ID) NM109 NM108 = ‘HN’
ACNT 2100
(Patient Account Number) CLPO1
ICN
(Claim Control Number) CLPO7
ASG 2000 Hard-coded ‘N’ for Medicare
(Claim Assignment) when LX01 =0’
MOA 2100 MOAO03, MOAO4,
(Claim Level Remark MOAO05, MOAOG,
Codes) MOAQ7
REND PROV 2110 REFO02 REFO1 = HPI or
(Rendering Provider) REF01 =‘1C’
2100 NM109 or NM108 = ‘XX’ or
REF02 REF01 =‘1C’
1000B N104 or N103 = ‘XX’ or
REFO02 or REFO01 = ‘XX’
spaces
SERV DATE 2110 DTM02 Line level DTMO1 = ‘150’ or
(From Service Date) ‘472’ else Claim level DTMO1 =
‘232’
SERV DATE 2110 DTM02 Line level DTMO1 = ‘151’ or
(To Service Date) ‘472’ else Claim level DTMO1 =
‘233’
POS 2110
(Place of Service) REF02 REFO1 = ‘LU’
NOS 2110 SVCO05
(Number of Services)
PROC 2110 SVCO01-2 SVCO01-1 = ‘HC’ or ‘N4’
(Procedure code — paid
and if down-coded then
down-code procedure
appears.)

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

160



Medicare Remit Easy Print

Appendix A: MREP RA/HIPAA 835v4010A1 Segment Field Crosswalk

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
MODS 2110 SVCO01-3, SVC01-4, SVCO01-1 = ‘HC’ or ‘N4’
(Procedure code SVCO01-5, SVC01-6
modifiers)

BILLED 2110
(Billed Amount) SVC02
ALLOWED 2110
(Allowed Amount) AMTO2 AMTO1 = ‘B6’
DEDUCT 2110 CASO03 or CASO06 or CAS01 = ‘PR’ & (CAS02 = ‘1’
(Deductible Amount) CASO09 or CAS12 or or CASO5 ='1" or CAS08 =1’
CAS15 or CAS18 or CAS11 ='1"or CAS14 ="
or CAS17 =1")
COINS 2110 CASO03 or CASO06 or CASO01 = ‘PR’ & (CAS02 =2’
(Coinsurance Amount) CASO09 or CAS12 or or CASO5 = 2" or CAS08 =2’
CAS15 or CAS18 or CAS11 =2 or CAS14 =2
or CAS17 =‘2))
GRP/RC-AMT 2110 CAS01-CAS02, Do not print CASO1 = ‘PR’ and
(Group/Reason Code) CASO05, CASO08, ((CAS02 =1" or ‘2") or (CAS05
CAS11, CAS14, ='1"or ‘2") or (CAS08 ‘1’ or ‘2)
CAS17 or (CAS11="1"or ‘2") or
(CAS14 ='1"or '2") or (CAS17
‘1’ or ‘2")); hard-code dash
between group code and
reason code
GRP/RC-AMT 2110 CASO03 or CASO06 or Do not print CAS01 = ‘PR’ and
(Reason Code Amount) CASO09 or CAS12 or ((CAS02 =1’ or ‘2) or (CAS05
CAS15 or CAS18 ='1" or '2") or (CASO08 ‘1’ or ‘2’)
or (CAS11="1"or ‘2" or
(CAS14 ='1"or '2") or (CAS17
‘1" or ‘27))
PROV PD 2110
(Provider Paid Amount) SVCO03
SUBNOS : 2110 SvCo7 If paid units of service (SVCO05)
(Submitted Number of do not equal submitted units of
Services) service
Submitted procedure code | 2110 SVC06-2, SVC06-3, Value appears in parentheses
SVCO06-4, SVCO06-5,
SVCO06-6
REM: 2110
(Line Level Remark
Codes) LQO02 LQO1 = ‘HE’
PT RESP 2100
(Patient Responsibility) CLPO5
CLAIM TOTAL 2100
(Billed Amount) CLPO3
CLAIM TOTAL Sum of all lines AMT02, when

(Allowed Amount)

AMTO1 = B6.

Use or disclosure of the information contained on this page is subject to the restrictions on the title page of this document.

161




Medicare Remit Easy Print
Appendix A: MREP RA/HIPAA 835v4010A1 Segment Field Crosswalk

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
CLAIM TOTAL Sum of all lines CAS monetary
(Deductible Amount) amounts, when CASO1 = ‘PR’
and the corresponding
adjustment reason code equals
0

CLAIM TOTAL Sum of all lines CAS monetary

(Coinsurance Amount) amounts, when CASO1 = ‘PR’
and the corresponding
adjustment reason code equals
o

CLAIM TOTAL Sum of all lines CAS monetary

(Reason Code Amounts) amounts, excepting those
associated with adjustment
reason codes ‘1’ and ‘2’

CLAIM TOTAL 2100 CLPO4

(Provider Paid Amount)

ADJ TO TOTALS: PREV Not available

PD

(Adjustment to Totals:

Previous Paid Amount)

ADJ TO TOTALS: 2100

INTEREST

(Adjustment to Totals:

Interest Amount) AMTO02 Claim level AMTOL1 = I’

ADJ TO TOTALS: LATE 2110
FILINE CHARGE
(Adjustment to Totals: Late
Filing Charge)

Sum of all line level AMTO02,
when AMTO1 = ‘KH’

NET Sum of all the line level
provider paid amts plus adj to
totals: interest minus adj to
totals: late filing charge

CLAIM INFORMATION 2100 NM103 (Carrier NM101 = ‘TT or NM102 = ‘2’

FORWARDED TO: name)

GLOSSARY MOAO03, MOAO4, If there are duplicates, only

MOAO05, MOAOG,
MOAO7, CASO01,
CASO02, CASO05,
CASO08, CAS11,
CAS14, CAS17

print once
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Appendix B: MREP RA/HIPAA 835v5010 Segment Field

Crosswalk

This information can help you if you need to troubleshoot the Import file.

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
Payer (Contractor) Name 1000A N102 N101 ='PR’
Payer (Contractor) 1000A
Address N301 N101 = ‘PR’, ADDR1
N302 N101 = ‘PR’, ADDR2
Payer (Contractor) City 1000A N401 N101 ='PR’
Payer (Contractor) State 1000A N402 N101 = ‘PR’
Payer (Contractor) Zip 1000A N403 N101 = ‘PR’
PAYER'S WEB SITE: 1000A PERO4 PERO1 =‘IC’
PAYER BUSINESS 1000A
CONTACT
INFORMATION: PERO1=‘CX’
Name PERO02
Email Address (up to 50 PERO3 or PERO5 = ‘EM’
positions) PERO4 or PERO6 (respectively)
PERO3 = ‘TE’ and PERO5 =
EX'
PERO04 and PERO6 PEROS5 = ‘TE’ and PERO7 =
Telephone Number PERO06 and PERO8 ‘EX’
PAYER TECHNICAL 1000A
CONTACT
INFORMATION: PERO1=‘BL’
Name PERO02
Email Address (up to 50 PERO3 or PERO5 = ‘EM’
positions) PERO4 or PERO6 (respectively)
PERO3 = ‘TE’ and PERO5 =
EX'
PERO04 and PERO6 PEROS5 = ‘TE’ and PERO7 =
Telephone Number PERO06 and PERO8 ‘EX’
Payee (Provider) Name 1000B N102 N101 ='PE’
1000B N301 N101 = ‘PE’, ADDR1
Payee (Provider) Address N302 N101 = ‘PE’, ADDR2
Payee (Provider) City 1000B N401 N101 ='PE’
Payee (Provider) State 1000B N402 N101 = ‘PE’
Payee (Provider) Zip 1000B N403 N101 = ‘PE’
PROVIDER # 1000B N104 N101 = ‘PE’ & N103 = ‘XX’
or or
NPI # REFO02 Payee level REFO1 = ‘1C’
Date BPR16
CHECK/EFT # TRNO2 BPRO0O4 = ‘CHK’ or ‘EFT’ or
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
‘NON’
Assigned claims LX01 = ‘1", pertains only to
Medicare
NAME 2100
(Patient Last Name) NM103 NM101 = ‘QC’
NAME 2100
(Patient First Name) NM104 NM101 = ‘QC’'/ NM102 = ‘1’
NAME 2100
(Patient Middle Name) NM105 NM101 = ‘QC’'/ NM102 = ‘1’
HIC 2100
(Patient ID) NM109 NM108 = ‘HN’
ACNT 2100
(Patient Account Number) CLPO1
ICN
(Claim Control Number) CLPO7
ASG 2000 Hard-coded 'Y’ for Medicare
(Claim Assignment) when LX01 = ‘1’
MOA 2100 MOAO03, MOAO4,
(Claim Level Remark MOAO05, MOAOG,
Codes) MOAOQ7
REND PROV 2110 REFO02 REFO1 = HPI or
(Rendering Provider) REF01 =‘1C’
2100 NM109 or NM108 = ‘XX’ or
REF02 REFO01 =‘1C’
1000B N104 or N103 = ‘XX’ or
REFO02 or REFO01 = ‘XX’
spaces
SERV DATE 2110 DTM02 Line level DTMOL1 = ‘150’ or
(From Service Date) ‘472" else Claim level DTMO1 =
‘232’
SERV DATE 2110 DTMO02 Line level DTMOL1 = ‘151" or
(To Service Date) ‘472" else Claim level DTMO1 =
‘233’
POS 2110
(Place of Service) REF02 REF01 = ‘LU’
NOS 2110 SVCO05
(Number of Services)
PROC 2110 SVCO01-2 SVCO01-1 = ‘HC’ or ‘N4’
(Procedure code — paid
and if down-coded then
down-code procedure
appears.)
MODS 2110 SVCO01-3, SVC01-4, SVCO01-1 = ‘HC’ or ‘N4’
(Procedure Code SVCO01-5, SVvC01-6
Modifiers)
BILLED 2110
(Billed Amount) SVC02
ALLOWED 2110 AMTO02 AMTO1 = ‘B6’
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
(Allowed Amount)
DEDUCT 2110 CASO03 or CASO06 or CASO01 = ‘PR’ & (CAS02 =1’
(Deductible Amount) CASO09 or CAS12 or or CASO5 = ‘1’ or CAS08 =1
CAS15 or CAS18 or CAS11 ='1"or CAS14 ="'’
or CAS17 ='1")
COINS 2110 CASO03 or CASO06 or CASO01 = ‘PR’ & (CAS02 =2
(Coinsurance Amount) CASO09 or CAS12 or or CASO5 = ‘2" or CAS08 = ‘2’
CAS15 or CAS18 or CAS11 ='2"or CAS14 =2’
or CAS17 =27
GRP/RC-AMT 2110 CAS01-CASO02, Do not print CASO1 = ‘PR’ and
(Group/Reason Code) CASO05, CASO08, ((CAS02 = 1" or ‘2") or (CAS05
CAS11, CAS14, ='1" or ‘2") or (CASO08 ‘1’ or ‘2’)
CAS17 or (CAS11="1"or ‘2") or
(CAS14 ='1"or '2") or (CAS17
‘1’ or ‘2")); hard-code dash
between group code and
reason code
GRP/RC-AMT 2110 CASO03 or CASO06 or Do not print CASO1 = ‘PR’ and
(Reason Code Amount) CASO09 or CAS12 or ((CAS02 = 1" or ‘2) or (CAS05
CAS15 or CAS18 ='1" or '2") or (CASO08 ‘1’ or ‘2’)
or (CAS11="1"or ‘2" or
(CAS14 ='1"or '2") or (CAS17
‘1" or ‘27))
PROV PD 2110
(Provider Paid Amount) SVCO03
SUBNOS : 2110 SvCo7 If paid units of service (SVCO05)
(Submitted Number of do not equal submitted units of
Services) service

Submitted procedure code | 2110

SVCO06-2, SVCO06-3,
SVC06-4, SVCO06-5,
SVC06-6

Value appears in parentheses

REM: 2110
(Line Level Remark
Codes)

LQO02

LQO1 = ‘HE’

CNTL #: 2110

(Line Item Control
Number)

REF02

REFO1 = ‘6R’

HCPI: 2110
(HealthCare Policy
Information)

REF02

REFO1 = ‘0K’ (zero K)

PT RESP 2100
(Patient Responsibility)

CLPO5

CLAIM TOTAL 2100
(Billed Amount)

CLPO3

CLAIM TOTAL
(Allowed Amount)

Sum of all lines AMTO02, when
AMTO1 = ‘B6’

CLAIM TOTAL
(Deductible Amount)

Sum of all lines CAS monetary
amounts, when CAS0O1 = ‘PR’
and the corresponding
adjustment reason code equals
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
T

CLAIM TOTAL Sum of all lines CAS monetary

(Coinsurance Amount) amounts, when CASO1 = ‘PR’
and the corresponding
adjustment reason code equals
o

CLAIM TOTAL Sum of all lines CAS monetary

(Reason Code Amounts) amounts, except those
associated with adjustment
reason codes ‘1’ and ‘2’ (Group
code PR)

CLAIM TOTAL 2100 CLPO4

(Provider Paid Amount)

ADJ TO TOTALS: PREV Not available

PD

(Adjustment to Totals:

Previous Paid Amount)

ADJ TO TOTALS: 2100

INTEREST

(Adjustment to Totals:

Interest Amount) AMTO02 Claim level AMTOL1 ='I’

ADJ TO TOTALS: LATE 2110

FILINE CHARGE

(Adjustment to Totals: Late

Filing Charge) Sum of all line level AMTO02,
when AMTO1 = ‘KH’

NET Sum of all the line level
provider paid amts plus adj to
totals: interest minus adj to
totals: late filing charge

CLAIM INFORMATION 2100 NM101 =TT

FORWARDED TO:

(Crossover Carrier Name) NM103 NM102 = 2’

(Crossover Carrier

Identifier) NM109 NM108 = ‘PI' or ‘XV’

CORRECTED PRIORITY | 2100

PAYER INFO : NM101 = ‘PR’

(Corrected Priority Payer NM102 = 2’

Name) NM103

(Corrected Priority Payer

Identification Number) NM109 NM108 = ‘PI' or ‘XV’

TOTALS: # OF CLAIMS Number of CLP segments
within a LX

TOTALS: BILLED AMT

(Total — Billed Amount) Sum of CLP03

TOTALS: ALLOWED AMT Sum of AMT02 when AMTO1 =

(Total — Allowed Amount) ‘B6’

TOTALS: DEDUCT AMT Sum of CAS monetary amts,

(Total — Deductible when CASO01 = ‘PR’ and the
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Remittance Advice Field

835 Loop ID

835 Segment Field

Identification/Comments

Amount)

corresponding adjustment
reason code equals ‘1’

TOTALS: COINS AMT
(Total — Coinsurance
Amount)

Sum of CAS monetary amts,
when CASO1 = ‘PR’ and the
corresponding adjustment
reason code equals ‘2’

TOTALS: RC-AMT
(Total — Reason Code
Amount)

Sum of CAS monetary
amounts, excepting those
associated with adjustment
reason codes ‘1’ and ‘2’

TOTALS: PROV PD AMT
(Total — Provider Paid
Amount)

Sum of CLP04

TOTALS: PROV ADJ AMT
(Total — Provider
Adjustment Amount)

Sum of AMT02 when AMTO1 =
‘B6’ and ‘KH’

(The sum of the details
(amount) in the PROVIDER
ADJ DETAILS section.)

CHECK AMT
(Check Amount)

BPRO02

Provider Adjustment Details

PLB REASON CODE

PLBO3-1, PLB05-1,
PLBO7-1, PLB09-1,
PLB11-1, PLB13-1

FCN/OTHER IDENTIFIER

Positions 1 - 17 of

PLB03-2, PLB05-2,
PLB07-2, PLB09-2,
PLB11-2, PLB13-2

Positions 18 - 28 of
PLB03-2, PLB05-2,
PLBO07-2, PLB09-2,

HIC PLB11-2, PLB13-2

PLBO04, PLBO6,

PLBO08, PLB10,
AMOUNT PLB12, PLB14

LX01 = ‘0, pertains only to
Summary of non-assigned claims Medicare

NAME 2100
(Patient Last Name) NM103 NM101 = ‘QC’
NAME 2100
(Patient First Name) NM104 NM101 = ‘QC’/ NM102 = ‘1’
NAME 2100
(Patient Middle Name) NM105 NM101 = ‘QC’/ NM102 = ‘1’
HIC 2100
(Patient ID) NM109 NM108 = ‘HN’
ACNT 2100
(Patient Account Number) CLPO1
ICN
(Claim Control Number) CLPO7
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
ASG 2000 Hard-coded ‘N’ for Medicare
(Claim Assignment) when LX01 = ‘0’

MOA 2100 MOAO03, MOAO4,
(Claim Level Remark MOAO05, MOAO6G,
Codes) MOAOQ7
REND PROV 2110 REF02 REFO01 = HPI or
(Rendering Provider) REF01 =‘1C’
2100 NM109 or NM108 = ‘XX’ or
REF02 REFO1 = ‘1C’
1000B N104 or N103 = ‘XX or
REF02 or REFO01 = ‘XX’
spaces
SERV DATE 2110 DTMO02 Line level DTMO1 = ‘150’ or
(From Service Date) ‘472’ else Claim level DTMO1 =
‘232’
SERV DATE 2110 DTMO02 Line level DTMO1 = ‘151’ or
(To Service Date) ‘472’ else Claim level DTMO1 =
‘233
POS 2110
(Place of Service) REF02 REFO1 = ‘LU’
NOS 2110 SVCO05
(Number of Services)
PROC 2110 SVCO01-2 SVCO01-1 = ‘HC’ or ‘N4’
(Procedure code — paid
and if down-coded then
down-code procedure
appears.)
MODS 2110 SVCO01-3, SVCO01-4, SVCO01-1 ='HC’ or ‘N4’
(Procedure code SVCO01-5, SVC01-6
modifiers)
BILLED 2110
(Billed Amount) SVC02
ALLOWED 2110
(Allowed Amount) AMTO2 AMTO1 = ‘B6’
DEDUCT 2110 CASO03 or CASO06 or CASO1 = ‘PR’ & (CAS02 =1’
(Deductible Amount) CASO09 or CAS12 or or CASO5 =1" or CAS08 =1’
CAS15 or CAS18 or CAS11 ='1"or CAS14 ="'
or CAS17 ='1)
COINS 2110 CASO03 or CASO06 or CASO1 = ‘PR’ & (CAS02 =2’

(Coinsurance Amount)

CASQ9 or CAS12 or
CAS15 or CAS18

or CASO5 = ‘2" or CAS08 = ‘2’
or CAS11 =2 or CAS14 =2
or CAS17 ='2))
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
GRP/RC-AMT 2110 CAS01-CAS02, Do not print CASO1 = ‘PR’ and
(Group/Reason Code) CASO05, CASO08, ((CAS02 =1’ or ‘2") or (CAS05

CAS11, CAS14, ='1" or '2") or (CASO08 ‘1’ or ‘2’)
CAS17 or (CAS11="1"or ‘2") or
(CAS14 ='1"or '2") or (CAS17
‘1’ or ‘2')); hard-code dash
between group code and
reason code
GRP/RC-AMT 2110 CASO03 or CASO06 or Do not print CASO1 = ‘PR’ and
(Reason Code Amount) CASQ9 or CAS12 or ((CAS02 ='1"or '2") or (CAS05
CAS15 or CAS18 ='1"or ‘2") or (CAS08 ‘1’ or ‘27
or (CAS11 ="1"or ‘2") or
(CAS14 ='1" or '2") or (CAS17
‘1" or ‘27))
PROV PD 2110
(Provider Paid Amount) SVCO03
SUBNOS : 2110 SVCo7 If paid units of service (SVCO05)
(Submitted Number of do not equal submitted units of
Services) service
Submitted procedure code | 2110 SVC06-2, SVC06-3, Value appears in parentheses
SVCO06-4, SVCO06-5,
SVCO06-6
REM: 2110
(Line Level Remark
Codes) LQO02 LQO1 = ‘HE’
PT RESP 2100
(Patient Responsibility) CLPO5
CLAIM TOTAL 2100
(Billed Amount) CLPO3
CLAIM TOTAL Sum of all lines AMT02, when
(Allowed Amount) AMTO1 = B6.
CLAIM TOTAL Sum of all lines CAS monetary
(Deductible Amount) amounts, when CASO1 = ‘PR’
and the corresponding
adjustment reason code equals
£1)
CLAIM TOTAL Sum of all lines CAS monetary
(Coinsurance Amount) amounts, when CASO1 = ‘PR’
and the corresponding
adjustment reason code equals
£2)
CLAIM TOTAL Sum of all lines CAS monetary
(Reason Code Amounts) amounts, excepting those
associated with adjustment
reason codes ‘1’ and ‘2’
CLAIM TOTAL 2100 CLPO4

(Provider Paid Amount)

ADJ TO TOTALS: PREV
PD
(Adjustment to Totals:

Not available
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments

Previous Paid Amount)

ADJ TO TOTALS: 2100

INTEREST

(Adjustment to Totals:

Interest Amount) AMTO2 Claim level AMTO1 = I’

ADJ TO TOTALS: LATE 2110

FILINE CHARGE

(Adjustment to Totals: Late

Filing Charge) Sum of all line level AMTO02,
when AMTO1 = ‘KH’

NET Sum of all the line level
provider paid amts plus adj to
totals: interest minus adj to
totals: late filing charge

CLAIM INFORMATION 2100 NM101 =TT

FORWARDED TO:

(Crossover Carrier Name) NM103 NM102 = 2’

(Crossover Carrier

Identifier) NM109 NM108 = ‘PI’ or ‘XV’

CORRECTED PRIORITY | 2100

PAYER INFO : NM101 = ‘PR’

(Corrected Priority Payer NM102 = 2’

Name) NM103

(Corrected Priority Payer

Identification Number) NM109 NM108 = ‘PI’ or ‘XV’

GLOSSARY

MOAO03, MOAO4,
MOAO05, MOAOG,
MOAO7, CASO01,
CASO02, CASO05,
CASO08, CAS11,
CAS14, CAS17

If there are duplicates, only
print once
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Appendix C: Abbreviation and Acronym Glossary

The following two column table provides the abbreviations or acronym values in the first
column, and the second column contains the descriptions.

Abbreviation or Acronym value Description
ACNT Account
ADJ Adjustment
Adjst Adjustment
AMT Amount
ASG Assignment of claim
Bene Beneficiary
CARC Claim Adjustment Reason Code
COB Coordination of Benefits
COIN Coinsurance
Coins Coinsurance
Deduct Deductible
DMERC Durable Medical Equipment Resource Center
ERA Electronic Remittance Advice
EFT Electronic Funds Transfer
GRP/RC Group and Claim Adjustment Reason Codes
HCPCS Health Care Procedure Codes
HIC Health Insurance Claim Number
HICN Health Insurance Claim Number
HIPAA Health Insurance Portability and Accountability
Act
ID Identifier
ICN Internal Control Number
MOA Medicare Outpatient Adjudication
MODS Modifiers
MREP Medicare Remit Easy Print
MSP Medicare Secondary Payer
NDC National Drug Code
NPI National Provider ldentifier
NOS Number of Services
Orig Original
PHI Personal Health Information
POS Place of Service
PREV PD Previous Paid
PROC Procedure Code
PROV Provider
PROV PD Provider Paid
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Abbreviation or Acronym value Description
PT RESP Patient Responsibility
RARC Remittance Advice Remark Code
REM Remark Code
Remit Remittance Advice
REND PROV Rendering Provider
SERV DATE Service Dates
SPR Standard Paper Remittance advice
Zip ZIP Code
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